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Chapter 1

PREFACE

1.1 PREFACE

Preface from Ray at RBF Software

The contents of this OctaMED Tutorial are copyright 1993-96 RBF Software.
We have decided to place it onto the net in this .Guide format and as
such it may now be considered Freeware, (Copyright Retained), however,
It may not be reproduced in printed format, sold etc, for *any* amount!

Please also read Copyright information on the OctaMED V5 *$^1$* disk itself
and if you would like to contact the copyright owners then write to:
RBF Software. 169, Dale Valley Road, Southampton SO16 6QX. England.
(Allways enclose an SAE or IRC if you require a reply)

*$^1$* For those of you that *still* have’nt got a copy of V5, note that
the actual OctaMED V5 program will become Freeware *late* 1996 and
it will appear on the Aminet and other sites.

AUTHOR/
Ed Wiles. 9, Kirkland Wynd, Lochvale, Dumfries, Scotland DG1 4ES.

RBF Software would like to thank the members of the OctaMED User Group,
(MUG), for donating the songs and samples used throughout this tutorial.

In particular we send out our gratefull thanks to:

Richard Bannister & Chris Wright of MUG, Alistair Brimble,
Andy Baxter,Dave Sullivan, Tom Cozzolino, Bjørn A. Lynne
Kevan Craft, Dean Murray, Danny Amor, etc, etc.,

(We apolagise to all those we have left out but three pages is too much!)

VERY special thanks go to the following for advice and or help:

Tony Horgan, Matt Broomfield Karl Foster & Maff at Future Music
Cliff Ramshaw & Tim at AMIGA SHOPPER Paul, AMIGA COMPUTING
Richard "NOT PD" Baguley & Marcus* at AMIGA FORMAT *( now at team 17 )
Ralf Kottcke at AMIGA MAGAZIN in Germany - Sajad Majid & Dave Pocock at
CBM (UK), not forgetting Lew Eggebrecht, Vice President at CBM (USA).
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Last but not least ED Wiles, (of course), and all the others that
helped Teijo and I present to you the best budget music utility available!

Very special thanks go to Teijo for putting up with all my badgering
and for sticking with it through the years. ( Well done mate )

RBF Software. Ray ;-)

This *is* Important, so please re-read......

Please note that this V5 companion is now released as Freeware,
( copyright retained ), in this .Guide format and may be passed around
the internet and from person to person, the only restrictions being
that it must not be sold, for *any* amount and the making of a printed
copy is only allowed for the use of the actual person doing so, it may
not be reproduced in hardcopy (printed manual) format and re-sold.

We hope that this tutorial will be of help in introducing you to the
amazing world of Paula. (Who is Paula? she is the Amiga Music Chip).

When you are feeling confident enough to move up to using OctaMED with
MIDI, please refer to the OctaMED Companion Disk three. (see below)

The disk contains MIDI.Med songs, (playable through MIDI), and a host
of information on using OctaMED in MIDI mode, plus a selection of
suggested reading material on the subject of MIDI itself.
There is also an animated display showing how to set up OctaMED for
use via a MIDI keyboard, however, if you find that the animation is
to fast for you to follow, you can, using Dpaint’s anim section,
load in the animation and then study these pictures at your leisure.

There are three "Companion" disks (one detailed above), mentioned
throughout this tutorial and these are also now available on the net
and are labeled: OcV5Tut_2 - OcV5Tut_3 - OcV5Tut_4, which contain the
Samples, Songs & MIDI, that are mentioned throughout the documentation.

Finaly, you may be interested to know that a new version of OctaMED
titled OctaMED SoundStudio is due for release in June 96 and it will
blow your socks of with all the new additions.

For more info on this new version, see the inevitable reviews in
the magazines, ( CU Amiga etc ), or if you are on the internet,
call the OctaMED World Wide Web Site on:

http://www.compulink.co.uk/~octamed

This site will give up to the minute details of it’s release, price etc.

CONTENTS

INTRODUCTION

CREDITS
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1.2 CONTENTS

TABLE OF CONTENTS
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Reference - WINDOWS

Player commands
Player commands

Player commands: quick reference
Commands Quick reference

Keyboard shortcuts
Keyboard shortcuts

Hexadecimal values
Hexadecimal values

Synthetic Sound Programming Language Commands
Synthetic Language Commands
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The settings file
The settings file

8-channel mode limitations
8-channel limitations

The numeric keypad settings
The numeric keypad

Song file formats
Song file formats

WELCOME To those upgrading from version 4
THOSE UPGRADING FROM V4

INTRODUCTION

1.3 INTRODUCTION

Welcome and a brief history of OctaMED

Welcome to OctaMED Professional V5 ! The MED in OctaMED stands for Music
EDitor, and that’s exactly what OctaMED is: a versatile music composer and
editor. Although capable and sophisticated, OctaMED is also easy and
interesting to learn. With the program you may compose music for games,
demos, animations and presentations, or simply use the program as a
stand-alone editor. OctaMED offers a multitude of features unseen on any
other Amiga music package.

In the early days of the Amiga, programmers needed a fast, convenient way
to write music for games and demonstrations. A music program called
SoundTracker was written in response to this need. It provided a perfect
way to incorporate sound tracks into programs, and as a result, most Amiga
games and virtually all demo programs had their music written with
SoundTracker (or one of its many imitation programs, known as trackers).

Unfortunately, like many programmer’s utilities, trackers required great
patience. Although composing music was not especially difficult, they often
crashed, seldom came with instructions, and refused to multi-task (one of
the Amiga’s major attributes). In spite of these problems, trackers became
increasingly popular, a testament to their usefulness.

Recognizing the value of SoundTracker, Teijo Kinnunen began designing an
improved program. The first version, MED 1.12, appeared in autumn 1989.
Teijo improved this version with new program code and, in April of 1990, he
release MED 2.00. Perhaps the most important new feature was MIDI support.
MED gained a reputation as an excellent piece of music software; virtually
every Amiga publication of both sides of the Atlantic has praised MED.

In 1991, after being persuaded by Ray of RBF Software, Teijo released
OctaMED, a great improvement on MED with its main new feature being the
ability to play eight sounds at the same time, breaking out of the Amiga’s
four-sound limitation. With the release of OctaMED Professional V5, the
user interface has been completely redesigned to give the program a much
more "friendly" appearance, and many new features have been added and
previous ones refined to make OctaMED an even more flexible and
comprehensive sound and music system.
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being majorly cool

COPYRIGHT

1.5 COPYRIGHT

OctaMED is copyright (c) 1991-1993 Teijo Kinnunen and Ray Burt- ←↩
Frost.

Worldwide distribution copyrights owned by R. Burt-Frost (RBF Software).

OctaMED V5 is NOT public domain or freely distributable. It is a
copyrighted program, available only directly from RBF Software or from
officially registered / contracted companies licenced with RBF Software.
You are not allowed to distribute/pass on OctaMED in any way. However as a
registered purchaser you may make two backup copies for retention in case
of corruption. These must be retained for your own, private use.

If you intend to use OctaMED V5 (or V2, 3 or 4) within commercial software
or hardware, please note that as it is a fully copyrighted program, you are
required by law to contact RBF Software for a licence. Any person or
company found to be using this program for such a purpose without first
having obtained a licence will be deemed to have broken the copyrighted
usage of the program and solicitors will be instructed. The exception to
this is the program titled OctaMEDPlayer, which may be treated as Public
Domain. This will allow enthusiasts to pass out any songs they’ve composed
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to others, without breaking any copyright laws.

The OctaMEDPlayer and the player library may be freely used or distributed
with non-commercial programs (PD or shareware etc.). You do not need
permission from the owners to distribute them with your PD program(s). If
you wish to make use of the source or library routines that are on the
Programmers disk then please read the Programmers file in the docs drawer of di
k 1. (The Programmers disk is available via selected suppliers.

OctaMED is provided "as is". Every effort has been made to keep OctaMED as
bug free as possible, but if there are bugs that may cause you to lose
something, it is important that you note by loading and launching this
program, you are agreeing to absolve the author or RBF Software from any
liability and you are agreeing not to pursue any claim for such losses be
they deemed civil or criminal.

Anyone wishing to sell or reproduce the OctaMED tutorial must contact the
copyright holder, R. Burt-Frost, for a licence before doing so.

Powerpacker.library is copyright (c) 1991-1992 Nico FrançgÀois.
Lh.library is copyright (c) Olaf Barthel.

The WB and files, such as AmigaGuide, AmigaGuide.info and the amigaguide
library are copyright (c) 1992 Commodore-Amiga, Inc. All Rights Reserved.
Reproduced and distributed by RBF Software under license from Commodore.

AMIGAGUIDE SOFTWARE IS PROVIDED "AS-IS" AND SUBJECT TO CHANGE; NO
WARRANTIES ARE MADE. ALL USE IS AT YOUR OWN RISK. NO LIABILITY OR
RESPONSIBILITY IS ASSUMED.

INSTALLATION

1.6 INSTALLATION

===> Before you start, please carefully read the following pages ←↩
. <===

Floppy disk: make a copy of the program disks and store the originals in
a safe place. (See your Amiga’s manual if you’re unsure). This is a

precaution in case your OctaMED program disks become corrupt.

Hard disk: open the Utilities drawer on disk 1, then double-click the
Copy_To_Hard_Drive icon. Type in your hard disk’s name (e.g. DH0:) when
asked. There is also an install WB2.1 script and v2 users can use this.
( If you are using the WB3 then DO NOT use this )

For more information on installation, press the Help key while in OctaMED
and click on Installation.

THE TUTORIAL
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1.7 THE TUTORIAL

The major part of this tutorial consists of eight tutorials, ←↩
intended to

make you a proficient OctaMED user.
The features explained generally become progressively more advanced as
you work your way through the tutorials.

Please read these notes:

The tutorials give precise, step-by-step instructions. Please take care
that you follow the instructions exactly, being especially cautious when
typing in notes given in table form

Although it may be tempting, please don’t experiment during the
tutorials unless you’re sure you know what you’re doing: you may
unintentionally mess things up!

By all means experiment between tutorials, however. In fact, after
completing the introductory tutorials (1 - 4), you can stop if you like.
Just experiment, and if you find anything you’re not sure about, simply
press the Help key.

Alternatively, stick with the tutorials, and you’ll probably learn an
awful lot more quickly!

At roughly half-way through each tutorial, a half-way mark will be
announced. At this point, you can leave OctaMED for the time being and
switch off your Amiga. Instructions on how to stop and restart the
tutorial are given.

At one sitting, you should really do at least half a tutorial and at the
most a full tutorial (your brain can only take so much at once!). You
may wish to repeat tutorials to reinforce the ideas explained in them.

Even if you’re not particularly interested in the main tutorial subject
(given in the heading), you should still complete it because of the
smaller features it documents. For example, Tutorial 6 is called 5 - 8-
channel mode, but it also explains chord-entering mode and the
programmable keys (among other functions).

You should already have the songs and samples accessory disks. During
these tutorials, the disks will be referred to as OctaMED_Songs and
OctaMED_Samples. Hard disk owners should ignore any reference made to
the OctaMED boot disk.

Due to space and time restrictions, I haven’t been able to include every
single OctaMED feature, However, if you find a gadget or menu item that
you’re not sure how to use, just press the Help key whilst running the
program for a complete on-line reference document!

BEFORE YOU START



PREFACE 9 / 175

1.8 BEFORE YOU START

You should know the following conventions:

(Note that xxx and yyy mean any word or phrase)

Click on xxx = Move the mouse pointer to xxx and press and release the
left mouse button quickly

Double-click on xxx = As click, but press the button twice quickly

Shift-click on xxx = As click, but hold a Shift key down while
pressing the button

Drag xxx = Move the mouse pointer to xxx, and hold down the left mouse
button while moving the mouse in the direction specified

Select the xxx menu item from the yyy menu =

* Hold down the right mouse button to reveal a set of menu names on
the title bar

* Keeping the right mouse button held down, move the mouse to yyy
on the title bar; yyy will become highlighted and a menu will appear

* Still holding the mouse button down, move the mouse down to xxx in
the menu; xxx will become highlighted

* Release the right mouse button

Keyboard shortcuts notation:

* For example, Shift-A = Hold down a Shift key and press the A key

* <up>, <down>, <left> and <right> refer to the respective arrow key

Also remember that holding down any key for more than about half a
second repeats the keypress automatically (this is called key-repeat).

You should also know the following terms applying to windows; if you are
unsure of any of these, please consult your Amiga’s manual.

Title bar, close gadget, depth gadget, zoom gadget

It’s necessary also that you know (roughly) your way around your keyboard;
in particular, you should know the locations of the Tab, Backspace, Shift,
Amiga and Return keys (which are unlabeled).

Important note for users of non-U.S. and non-British keyboards: the
keyboard operations described in this manual apply to the standard U.S.
keymap (and, by coincidence, to the British keymap). Users of other
keyboards, therefore, have slight changes to make.

And lastly, please note which processor your Amiga uses. The A1200 contains
a 68020 processor, and the A3000 and A4000 either a 68030 or 68040. Other
Amigas, at the time of writing and without accelerator boards fitted, use
the 68000 processors.

======> NOW PLEASE DO THE FOLLOWING: <======
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Format a disk and name it OctaMED_Tutorials (or something similar). If
you are unsure how to do this, please refer to your Amiga’s manual.

Throughout the tutorials, the disk will be referred to as the
tutorial disk ( please remember this )

Now please load OctaMED Professional V5.xx

TUTORIAL ONE

1.9 TUTORIAL ONE

TUTORIAL 1 - OctaMED in action: examining a song

This tutorial will cover:

The main screen

Loading a song

Playing a song

The instruments

Playing the instrument

The blocks

The playing sequence

Clearing a song

TUTORIAL TWO

1.10 The main screen

Have a look at the screen. It currently shows OctaMED’s main screen, which
is divided into the following sections:

+--------------------+
| Title bar | <= Black rectangle: displays messages and menus
+--------------------+
| Upper screen | <= Five important rows of boxes, words and
| | symbols



PREFACE 11 / 175

+--------------------+
| | Four columns, each containing empty space
| Tracker editor | <= at the top followed by lines of dashes and
| | zeros (which are numbered at the very left):
| | this is where you’ll compose your music
+--------------------+
| Lower screen | <= Line of boxes and words, followed by four
| | large boxes (on non-American computers)
+--------------------+

It all probably looks rather complicated at the moment, but before long you
should understand the main operations. To introduce some of these
operations, let’s watch OctaMED play a piece of music (or song).

1.11 Loading a song

a) Select the Open menu item from the Project menu (on the title bar)

A file requester appears. ==> File requesters show which files are on
your disks, and allow you to select one or more of them.

b) Put the OctaMED_Songs disk in any disk drive

==> This disk contains many songs, but we’ll for the moment concentrate
on one particular song.

c) To select the OctaMED_Songs disk:

* Click on the Disks box (at the foot of the file requester)
note that the Disks box is mentioned several times through the tutorials,
however, on later issues of OctaMED this has altered to read Volumes.

* Now click on OctaMED_Songs in the list. A list of file names appears

d) To select the file’s name:

* Double-click on DAVE_SULLIVAN-Funky_Fifth (6th in the list)

Wait a few moments while the song finishes loading. When it’s loaded, the
word Loaded will appear on the title bar. You’ll notice that the screen’s
contents have changed slightly, and in particular, new letters and numbers
have appeared in the Tracker editor.

1.12 Playing a song

a) Find the Play Song box (far top left of upper screen), and click on it

==> Boxes like this one are called action buttons.
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You’ll notice three changes to the screen while the song is playing:

- The Tracker editor’s contents scroll upwards: each line of information
(letters, dashes, numbers) is played in turn as it passes through the
white bar

- Four colorful rectangles bob up and down: these bar equalizers react to
the volumes of notes played on the four sound channels

- The waveforms of notes played on the four sound channels snake across
the four oscilloscopes in the lower screen

b) When you’ve had enough, click on the long STOP button (below Play Song)

c) Now to continue the song where it left off, click on Cont Song (beside
Play Song)

d) Keyboard shortcuts: a lot of mouse actions can be carried out more
easily and conveniently using the keyboard. Try these shortcuts:

* Press the space bar to stop the song

* Press Shift-space bar to continue the song

* Stop the song again (space bar)

Now let’s consider the components which make up the song.

1.13 The instruments

Selecting the current instrument

a) Find the current instrument number and name (to the right of Cont Song);
they should at the moment be 01 and Bell + Strings respectively

==> OctaMED recognizes four different "types" of instrument:

Sample, Hybrid, ExtSample, Synthetic

The commonest of these, and the type we’ll stick to for the moment, is
the sample; and this Bell + Strings instrument is one such sample.
Samples are sounds from real-life that are created by feeding the
required sound from a tape recorder, microphone etc. into the
computer by way of a sampler (which you need to buy separately).
Creating samples using OctaMED will be described in a later tutorial.

b) Select a new current instrument by pressing Shift-<right> (i.e. hold
down a Shift key and press the right arrow key)

You’ll notice the current instrument number is now 02 and the name is Lush
Strings (major). Again this instrument is a sample (as are all the
instruments used in this song).

==> Look to the right of the instrument name, and notice that the current
instrument size (in bytes) has changed from 12751 to 12430. The larger
the size, the more memory the instrument occupies, and the longer the
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instrument takes to play.

c) Repeatedly press Shift-<right> and you’ll see the names, numbers and
sizes of each instrument in the song

Notice that the instrument number after 09 is 0A. The complete sequence,
using the alphabet and numbers, is: 01 to 09; 0A to 0V; 10 to 19 and 1A
to 1V. 1V is the final instrument, the 63rd.

==> HOWEVER: in this particular song, instruments above number 0E aren’t
used. Instrument 0F, for example, has no name and (more importantly) no
size (the size is instead shown as -------).

d) Repeatedly press Shift-<left> until the current instrument number is 01

1.14 Playing the instrument

==> Instruments can be played using the Amiga’s keyboard. It has about two-
and-a-half octaves, which are arranged somewhat like a piano.

Piano keyboard layout: the notes of one octave

| | | | | | | | | | | | |
| | | | | | | | | | | | |
| |C#| |D#| | |F#| |G#| |A#| | <== Black keys (sharps)
| +--+ +--+ | +--+ +--+ +--+ |
| | | | | | | |
| C | D | E | F | G | A | B | <== White keys (naturals)
+---+----+---+---+----+---+---+

Amiga keyboard layout

Lower octave Middle octave Upper half-octave

| 2 3 5 6 7 | 9 0 = \ <== Black keys (sharps)
| Q W E R T Y U | I O P [ ] <== White keys (naturals)
| |

S D G H J | L ; | <== Black keys (sharps)
Z X C V B N M | , . / | <== White keys (naturals)

a) Try playing notes with the keys listed above. For example, press the
following keys in turn to play two different scales:

* C major scale: Z X C V B N M Q W E R T Y U I O P [ ]

* C# major scale: S D V G H J , L ; R 5 6 7 I 9 0 [ = \

The notes are played on the current instrument, number 01: Bell + Strings.

b) As shown in the diagram above, five of the notes in the middle octave
can each be played using two different keys. To illustrate, press these
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keys: , L . ; / then Q 2 W 3 E

c) Of course, you’re not restricted to playing instrument 01. Using
Shift-<left> and Shift-<right>, choose other instruments from the song
and try them on the keyboard

d) Now change back to instrument 01 (using Shift-<left>)

Playing the other half-octave

==> The sample instrument type has in fact a range of three octaves. But
the Amiga’s keyboard at the moment can only play two-and-a-half
octaves, as we’ve discovered.

a) Find a button containing a "cycle" symbol and the number 12 (upper
screen, fourth row, far right)

==> The 12 doesn’t actually represent the number twelve. It means that:

- The lower octave keys play using the first octave (octave 1)
- The middle octave keys play using the second octave (octave 2)
- (Implied) The upper half-octave keys play using part of octave 3

b) Press the F2 key. The button changes to 23

==> Now the lower octave uses octave 2, the middle octave uses 3,
but the upper half-octave still uses 3 (because samples only have a
range of three octaves).

c) Press the F1 key. The button changes back to 12

d) Let’s try playing a three-octave C major scale. Press these keys:
Z X C V B N M Q W E R T Y U, press F2, then Q W E R T Y U I O P [ ]

==> Notice that the upper half-octave keys (I O P [ ]) sound the same as
the first five middle octave keys (Q W E R T), since they both play
using octave 3.

e) Press F1 again to return to the 12 setting

(Note: Using other instrument types, a range of up to 10½ octaves is
possible. Other instrument types are described in later tutorials)

============================> HALF-WAY MARK! <===========================

[ To stop: just switch off your Amiga!
To restart: do the Loading (opening) a song section ]

1.15 The blocks

==> A song is made up of several small pieces of music called blocks.
Blocks consist of numbered lines of information, and they are displayed
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in the Tracker editor. (The information itself will be covered in the
next tutorial). Only one block can be displayed at a time.

Selecting the current line and current block

a) Press Left Alt-<up> (hold down the Alt key situated on the left of the
keyboard and press <up>) to display the first lines of the first block
in the song

The line numbers are displayed on the very left of the Tracker editor, and
the current line is highlighted with a white horizontal bar. So the current
line number is at the moment 000.

b) To select a new current line, you use the <up> and <down> keys. Press
<down> repeatedly until the current line number is 063 (this is the last
line of this block)

==> Although the last line is 063, this block contains 64 lines (since
the numbering begins at 000).

For musicians: the 64 lines in this block allow for 4 measures (bars in
Britain) of 4/4 time (one line = one sixteenth-note or semiquaver)

c) Press <down> again to highlight the first line of this block, 000

d) Locate the block status display (upper screen, fourth line, to the right
of the B action button); it shows 000/032: Main: C lead (part 3)

==> 000 is the number of the block currently being shown in the
Tracker editor (the current block)

==> 032 is the number of the last block in the song
Main: C lead (part 3) is the name of the current block

e) To select a new current block, you use Shift-<up> and Shift-<down>.
Press Shift-<down>, and notice the block status display and the Tracker
editor changing

f) To make the first or last block the current one, try pressing
Left Alt-<up> and Left Alt-<down> respectively

The Block List

a) Firstly, make sure the first block is current by pressing Left Alt-<up>

b) Now find the B action button to the left of the block status display
(upper screen, middle of fourth line), and click on it; a window
entitled Block List appears

==> The block list is (among other things) a convenient way both to view
the names and numbers of all blocks in a song and to select the
current block.

c) Find the black rectangle at the far top right of the block list; this is
the scroll bar. Drag it downwards, and you’ll see more numbers and names
of blocks in the song appear
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d) As an alternative to the scroll bar, you can use the two arrow gadgets
below the scroll bar; try clicking on them now. When you’ve finished,
drag the scroll bar up to the very top again

e) The white bar in the block list shows the current block. Click on one of
the block names or numbers in the list to select it as the current block

f) Close the window by clicking on its close gadget (far top left)

Playing the current block

a) Select any block using either Shift-<up> and Shift-<down> or the Block
List, then find the Play Block button (below Play Song) and click on it

==> When the block has played completely, it will begin again from its
first line.

b) Click STOP or press the space bar as usual to stop playing, then to
continue the block from where it left off, click Cont Block

c) Now stop the playing again

1.16 The playing sequence

==> To create a song, the various blocks are linked together. This involves
creating a list of blocks in the order in which they should be played,
and this list is called the playing sequence.

a) Find the Sq button (upper screen, directly above the word Chord in the
fifth row) and click on it. The Playing Sequence window appears

b) Drag the scroll bar (the black rectangle on the far right, as in the
Block List) upwards to the very top

==> On the left are two columns of numbers, each of three digits:

Left hand: the playing sequence position number
Right hand: the block filling each position

The respective blocks’ names are also displayed.

c) Slowly drag the scroll bar downwards, examining each line (or entry)

==> Notice that some blocks are repeated (e.g. block 19 has been entered at
positions 5 and 15 in the playing sequence); and the block numbers
aren’t in any kind of order (increasing, decreasing etc.).

-> In fact, blocks in a song can be played any number of times and in any
order. This is quite handy, because if a song contains parts that are
repeated, you need only create the duplicated section once, and then
tell the computer to play it as often as required.

Now we’ll watch what happens in the playing sequence as OctaMED plays
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a song.

d) Find Follow (below the list, to the right) and click on the small box to
the left of Follow. A "tick" (or check mark) will appear in it,
indicating that Follow is on. Boxes like this one are called check boxes

e) Now drag the Playing Sequence window’s title bar (thus moving the whole
window) to the very bottom of the screen, to reveal the Play Song button
(upper screen, top left)

f) Click Play Song

Watch what is happening:

- The song starts playing from playing sequence entry 001

- The white bar in Playing Sequence marks the current playing sequence
position (or playpos for short), and shows which block is currently
being played

- When the playpos number exceeds 004, the list scrolls downwards to keep
the highlighted line as close to the middle of the list as possible.
This is the effect of switching Follow on

-> The numbers beside the Sq button (upper screen, fourth row) show the
playpos number and the total number of entries in the playing sequence
(44). These numbers are duplicated in the Playing Sequence window,
beside Follow

g) Click on the Follow check box again

==> Follow is now off. This means you can scroll around the playing
sequence freely while the song is playing.

h) Use the scroll bar to move to any part of the playing sequence, then
click on any of the playing sequence entries

==> You’ll hear a "hiccup" in the music as the song continues to play
from the entry you selected

i) Stop the song in the usual way, and close the Playing Sequence window by
clicking its close gadget

1.17 Clearing a song

==> Finally, to set up for the next tutorial, we’ll erase the song ←↩
from

memory.

a) Select the New item from the Project menu. The New? window appears

b) Click Clear All



PREFACE 18 / 175

==> Checklist 1 - can you: <==

(1) Identify the four sections of the main screen ?

(2) Load a song from disk ?

(3) Play, stop, and continue a song ?

(4) Select a new current instrument ?

(5) Play notes with the current instrument using the keyboard ?

(6) Find and play notes with the "other half-octave" ?

(7) Select a new current line ?

(8) Select a new current block, using the keyboard or the Block List ?

(9) Play, stop, and continue a block ?

(10) Open and close the Playing Sequence window ?

(11) Find/explain the meaning of block / playing sequence status displays ?

(12) Clear a song ?

In the following tutorial 2, we’ll use the Tracker editor to
make a simple song.

TUTORIAL TWO

1.18 TUTORIAL TWO

This tutorial will cover:

Loading instruments

Entering notes

Space mode

Adding a new block

Marking - canceling a range

Better drum beat

Copying - pasting tracks
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The H -> B setting

Copying - pasting blocks

Create playing sequence

Saving a song

TUTORIAL THREE
If you’ve just joined us, we’ll make sure there’s no song in ←↩

memory:

a) Select the New item from the Project menu. The New? window appears

b) Click Clear All

1.19 Loading instruments

Loading instrument number 01

a) Find a small GetFile button, the second small button to the right
of 01 (upper screen, top row, on the left). Click on it

A file requester appears.

b) Put the OctaMED_Samples disk in any disk drive

c) To select the OctaMED_Samples disk:

* Click on the Disks box (at the foot of the file requester)

* Now click on OctaMED_Samples in the list. A list of drawer names
appears

==> Think of this disk as a filing cabinet, holding different drawers which
contain different files.

d) Click on Bass_Drums in the list. A list of the files contained in the
Bass_Drums drawer appears

e) Double-click on Bass Drum in the list

The Bass Drum sample will load. Note the new contents of the current
instrument name and size boxes (upper screen, top row).

f) Play the Bass Drum instrument using the keyboard. I think it sounds
best using the Q key (note C, octave 2)

Loading instrument number 02

a) Press Shift-<right> to select instrument 02
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b) Again open the file requester by clicking on the GetFile button (upper
screen, top row)

The file requester still lists the contents of the Bass_Drums drawer which
you chose above.

c) To display the list of drawers, click the Parent button (beside Disks)

==> The Parent button moves one stage up in the disk’s hierarchy. In
practical terms, this means listing the contents of the drawer
previously opened.

d) Click the Drums+Percussion drawer, then double-click the RSnareDrum
sample to load it

e) Play this new sample using the keyboard... how about the I key?
(Note C, octave 3)

Loading instrument numbers 03 - 05

See if you can load these instruments into their respective positions:

(Use the file requester’s scroll bar to see the tuned piano instrument)
(Remember: Shift-<right>, GetFile button, Parent button, click drawer,

double-click file)

Number Drawer name Sample name

03 Cymbals+Hi-Hats Hi-Hat Closed 2
04 Bass_Notes FlickBass (soft)
05 Pianos+Keyboards Tuned Piano

Play the instruments to hear what they sound like. Now we’ll create the
following blocks using these instruments:

Block 000: Drum beat (bass drums and snare drums)
Block 001: Drum beat (bass drums, snare drums and hi-hats)
Block 002: Drum beat (as above) with a simple bass line
Block 003: Drum beat, bass line and first half of melody
Block 004: Drum beat, bass line and second half of melody

1.20 Entering notes

==> The Amiga plays music using four sound channels, each of which can play
one sample at a time. The four columns in the Tracker editor, known as
tracks, correspond to these sound channels. You compose music by
entering notes on these tracks.

a) Press Shift-<left> until you reach instrument 01

b) Locate Edit (upper screen, bottom left) and click on the box to the left
of it
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==> Edit mode is now on. Playing notes using the keyboard now enters the
notes in the Tracker editor

c) Press the Q key

==> Note C is played on the Bass Drum instrument using octave 2, and the
first note in the Tracker editor changes to C-2 10000:

octave number
|

C - 2 1 0 0 0 0
| |

note name instrument number

The other four numbers (currently 0000) are used to create special
effects and to control some of OctaMED’s features. We’ll look at them
in Tutorial 4.

d) Move to line 004 by pressing <down> three times

e) Press Q again, then move to line 008

f) Again press Q, then move to line 012

We’ll carry on entering note C-2 every fourth line for some time, so let’s
look at a facility to make this easier.

*** ERRORS: If you make a mistake while entering notes, try pressing the
Del key to delete the note that the cursor is on (the cursor is the
gray patch on the white current line bar). Pressing the Del key will
also advance a line (like the <down> key).

1.21 Space mode

a) Select Keyboard Options from the Settings menu (title bar, far right)

b) In the window that appears, find the long rectangular box below Space
Value (about half-way down on the right)

c) Drag the small black rectangle in this long box to the right, until the
number on the right of the box changes to 4

==> Long boxes like this one are called sliders.

d) Close the window either by clicking its close gadget (top left) or by
clicking the Exit button (bottom right)

e) Now find Space (beside Edit, upper screen, bottom left) and click on
the box to the left of it

f) Repeatedly press Q until you reach line 036, then stop

==> As you’ve probably guessed, space mode is used to skip lines between
entering notes, thus spacing the notes out. Changing Space Value in the
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Keyboard Options window to 4 allows notes to be entered every fourth
line.

g) Press Shift-<right> to change to instrument 02, then enter the
RSnareDrum instrument on line 036 at pitch C-3 by pressing the I key

h) Press Shift-<left> to re-select Bass Drum, then press Q (on line 040)

i) Continue to alternate between entering C-3 on RSnareDrum and C-2 on Bass
Drum until you return to line 000

j) Click Play Block (upper screen, top left) to hear what we’ve done so far

k) Stop the block (click STOP or press space bar)

That’s our first block done... in this block, just one track has notes in
it and the other three are empty. Let’s make a new block.

1.22 Adding a new block

a) Memory refresh: Locate the block status display (upper screen, fourth
line, to the right of the B action button). It shows 000/000

==> The first number is the current block number
The second number is the number of the last block in the song

b) Holding the right mouse button down, take the following route through
the menus: Block menu -> New item -> Append sub-item. Release the mouse
button

==> Notice the last block number in the block status display has increased
to 001. A new block has been appended (added after the last block).

c) Press Shift-<down> to see this new empty block, then press Shift-<up> to
return to the previous block

1.23 Marking - canceling a range

==> We’ll want to copy part of the drum section we’ve created into the new
empty block. Here’s an easy way of doing this...

a) Firstly, hold down the left mouse button on the first C-2 in the block,
move the mouse down to line 006, and release the mouse button

==> The white area that appears is called a range. You can carry out
operations on the notes highlighted by the range. (Because line 000
has the white current line bar on it, the range here appears gray).

b) Now to remove (cancel) the range, click anywhere on the Tracker editor
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c) Move down to line 032 (using <down>), hold down the left mouse button on
the C-2 on this line, move down to the lower screen directly underneath
the leftmost track, AND KEEP THE LEFT MOUSE BUTTON HELD DOWN

d) When the last line (063) appears, release the left mouse button

==> You’ve just marked a range from lines 032 to 063.

e) Move to line 032 (using <up>) to see the range you’ve just marked

f) Now, using the right mouse button, select Copy Range from the Edit menu
(third from the right)

==> The notes in the range are stored in a copy buffer in memory.

g) Press Shift-<down> to move to block 001, then select Paste Range from
the Edit menu

==> Paste Range transfers the copy buffer’s contents to the Tracker editor,
starting at the current line.

h) Click Play Block. Sound familiar? Now stop the block playing

i) Continue the simple drum beat by moving to line 032 and choosing Paste
Range from the Edit menu again

Let’s add hi-hats every second line.

j) Move to line 000 by pressing the F6 key

k) Move the cursor across to the next track by pressing Alt-<right>

==> The cursor is now in track number 1 (notice the white 1 at the very
top of this track).

l) Select Keyboard Options from the Settings menu (title bar, far right)

m) Drag the Space Value slider to 2

n) Close the window

o) Now press Shift-<right>, and to fill every second line of this track
with note D-3, hold down the O key until you see the cursor move back to
the start of the block

p) Click Play Block to hear what we’ve done, then stop the playing

============================> HALF-WAY MARK! <===========================

[ To stop: go to the Saving a song section
To restart: select Open from the Project menu, insert your tutorial

disk, click Disks then the name of your disk, click Songs
then double-click Song1-Tut2. Select block 001, and switch
edit mode on (Edit check box) ]
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1.24 Better drum beat

==> Of course, most drummers don’t play the way we’ve just listened
to, so let’s alter the drum beat a little bit.

a) Firstly, turn space mode off (if it isn’t already off) by clicking the
Space check box (upper screen, bottom row, to the left of Space)

b) Alter the beat in any way you wish using instruments 01 to 03. Here’s
some suggested alterations:

(Remember: Shift-<left> and Shift-<right> to change instruments
Alt-<left> and Alt-<right> to change tracks)

Instrument Use this key Track no. Line numbers

01 Q 0 006 026 038 050 054
02 I 0 031 058 062 063
03 O 1 015 047

c) Again, click Play Block ... and stop the playing when you’ve had enough

When you’re happy with the drum beat, move on...

1.25 Copying - pasting tracks

Now we’ll try making a simple bass line to go along with the drum beat.

a) Firstly, create another new block (number 002) by selecting the Append
sub-item from the New item from the Block menu

==> We’ll now transfer the drum beat in block 001 to block 002.

b) Move the cursor to track 0 (if it isn’t already there) using Alt-<left>

c) Choose the Copy item from the Track menu

==> The notes in track 0 are now stored in the copy buffer.

d) Move to block 002 by pressing Shift-<down>

e) Choose Paste from the Track menu

f) Now move to block 001 track 1 by pressing Shift-<up> then Alt-<right>

g) Choose Copy from the Track menu again, then press Shift-<down>

h) Choose Paste from the Track menu

i) Play the block to confirm that blocks 001 and 002 are identical, then
stop the block

Time for the bass line...
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j) Move to track 2 line 000 by pressing Alt-<right> followed by F6

k) Select instrument 04 (FlickBass (soft))

l) Turn space mode on by clicking the Space check box

m) Now enter these notes on their respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

==> 000 A-2 Y | 024 E-2 E | 046 C#3 9
==> 006 G#2 6 | 028 F#2 5 | 048 B-2 U
==> 008 F#2 5 | 030 G#2 6 | 054 F#2 5
==> 014 C#2 2 | 032 A-2 Y | 056 E-2 E
==> 016 B-1 M | 038 G#2 6 | 060 F#2 5
==> 022 F#2 5 | 040 F#2 5 | 062 G#2 6

n) Play the block to hear what we’ve entered (you may recognize the tune,
although it has been changed a bit!), then stop playing

1.26 The H -> B setting

Inhabitants of certain countries may be puzzled by the note B on lines 016
and 048 of track 2.

==> The problem: to represent the note between A# and C, countries such as
the USA and Britain use note B, while others like Germany
and Finland (where OctaMED’s author comes from) use note H

a) Holding down the right mouse button, move to the Settings menu (far
right) and LOOK immediately to the left of H -> B (about half-way down
the menu)

==> The H -> B menu item is ticked (or checked), meaning that H notes
are displayed as B’s in the Tracker editor

a) So if you live in a country that uses note H, remove the check mark from
H -> B by selecting the H -> B item (Settings menu)

b) Move to line 016, and note that note B-1 has changed to H-1

Note B will be used in descriptions throughout this manual.

1.27 Copying - pasting blocks

Time to create another new block. The menu system of creating blocks may be
a little time-consuming, so try this keyboard shortcut instead...

a) Press Ctrl-N, and see the last block number in the block status display
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increase to 003

==> We’ll copy the drum beat and bass line to block 003 so we can add a
tune. Instead of copying each of the three tracks one by one, we can
copy the whole block in one go.

b) Choose the Copy item from the Block menu

c) Move to block 003 (Shift-<down>), then choose Paste from the Block menu

d) Move to track 3 using Alt-<right>

e) Select instrument 05 (Shift-<right>)

f) Now enter these notes on their respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

==> 000 A-2 Y | 026 A-2 Y | 052 B-2 U
==> 008 A-2 Y | 028 B-2 U | 054 A-2 Y
==> 016 A-2 Y | 032 C#3 9 | 056 B-2 U
==> 020 G#2 6 | 040 C#3 9 | 058 C#3 9
==> 022 F#2 5 | 048 C#3 9 | 060 D-3 O
==> 024 G#2 6 | |

g) Play and stop the block

Now to create the other half of the melody.

h) Create the final new block by pressing Ctrl-N

i) Choose Copy from the Block menu, press Shift-<down>, then choose Paste
from the Block menu

==> We need to get rid of the notes in track 3 so we can add the rest of
the tune, so....

j) make sure the cursor is in track 3, choose Cut from the Track menu

==> Cut removes the notes and places them in the copy buffer ready for
pasting. We don’t need to paste them anywhere, though, so we’ll just
let them sit in the copy buffer...

k) Now enter these notes on their respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

==> 000 E-3 P | 020 E-3 P | 028 B-2 U
==> 008 A-2 Y | 022 D-3 O | 032 A-2 Y
==> 018 F#3 = | 024 C#3 9 |

l) Play and stop this final block
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1.28 Create playing sequence

If you remember from Tutorial 1, a song is made by linking the various
blocks together. This involves creating a list of blocks in the order they
should be played, called the playing sequence.

We’ll create the following sequence: 000 001 002 003 004 003 004. This
means the introductory blocks are played then the tune is played twice.

a) Open the Playing Sequence window by clicking the Sq button (upper
screen, directly above the word Chord in the fifth row)

==> Notice that one entry in the playing sequence has already been created
for us: block 000.

b) Find the Bottom button (about two-thirds of the way down on the left),
and click on it

==> The current playing sequence position (or playpos for short) is now
below the last entry in the sequence.

c) To insert a new entry, click Insert (in the middle of the window)

d) To increase this new entry 000, find the small > button (slightly above
and to the left of Insert) and click on it

e) Now click Bottom again, followed by Insert

==> In this case, Insert in fact duplicates the last entry in the
playing sequence. So a 001 is inserted.

f) Click the > button to increase the new entry to 002

g) To add block number Click these gadgets

==> 003 Bottom Insert >
==> 004 Bottom Insert >
==> 003 Bottom Insert <
==> 004 Bottom Insert >

h) Close the Playing Sequence window

i) Finally, click Play Song. Notice that after the last entry in the
playing sequence has been reached, the song starts again

1.29 Saving a song

a) Select the Save item from the Project menu (far left)

The Save Options window opens, and a file requester also appears, covering
part of the window. Notice that the writing in the requester is gray on a
black background; this indicates that a save, rather than a load, operation
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is taking place.

==> IF YOU’VE HAD TO REMOVE YOUR OCTAMED BOOT DISK FROM A DRIVE: click
Cancel in both requesters that appear, and don’t worry about the
Directory Error message!

b) Insert your tutorial disk (the disk you formatted before you started
these tutorials) in any disk drive

c) Click on the Disks box, then click on the name of your formatted disk
(I suggested something like OctaMED_Tutorials)

d) Create a new drawer for songs by typing Songs then pressing Return
( press TAB, then Shift-<Right> )

e) In the requester that appears, click on the OK button
( on later versions the OK reads as the Create button )

==> It isn’t necessary to create a new drawer before saving, but this will
help organize the files we’ll store on your disk.

f) Type Song1-Tut2 (this stands for Song 1, Tutorial 2) and press Return

==> You can name your song anything you wish, but logical names like the
one you’ve just typed are usually best!

g) In the Save Options window, find Create Icon (near the top on the left),
and click the check box to the left of it to turn Create Icon off

==> When Create Icon is on, OctaMED saves an icon file with the song for
use with Workbench and OctaMEDPlayer. We won’t need this, so we
turned it off to save a little disk space.

h) Click the Save button (very bottom left of window)

When OctaMED has finished saving, the Save Options window closes and a
Module saved message appears on the title bar.
(Module is another name for song).

Setting up for Tutorial 3

a) Turn both edit and space modes off (upper screen, bottom left)

==> Checklist 2 - can you: <==

(1) Load an instrument from disk using the file requester ?

(2) Turn edit and space modes on and off (well, you just have!) ?

(3) Enter notes into the Tracker editor ?

(4) Delete notes by pressing the Del key ?

(5) Change the space value using the Keyboard Options window ?

(6) Create a new block using either the Block menu or the keyboard ?
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(7) Move the cursor to a new track ?

(8) Set the H -> B setting if necessary ?

(9) Mark, cancel, copy and paste a range ?

(10) Cut, copy and paste a track or block ?

(11) Create a playing sequence using Bottom Insert < > ?

(12) Save a song to disk ?

Now carry on to tutorial 3 where we’ll look at an easier way of loading
instruments and add an extra bit to the song we’ve just created... or even
better, take a break and make a nice cup of tea - you’ve earned it!

TUTORIAL THREE

1.30 TUTORIAL THREE

TUTORIAL 3 - The sample list, changing the song speed, and ←↩
more

This tutorial will cover:

Creating sample list

Saving sample list

Easier instr loading

Block’s length and name

New keyboard shortcuts

Changing tempo (song speed)

Menu shortcuts

Line highlighting

Creating playing sequence

Saving using less disk space

Setting up for tutorial 4

TUTORIAL FOUR
If you’ve just joined us:

a) Select the Open item from the Project menu. A file requester appears
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b) Insert your tutorial disk (the disk you formatted) in any drive

c) Click on the Disks box, and then on the name of this disk

d) Click Songs, and then double-click Song1-Tut2

1.31 Creating sample list

If you found the method of loading instruments described at the start of
Tutorial 2 a bit tedious, this is for you!

a) Select Sample List Editor from the Display menu (second from the left).
The Sample List Editor window appears

==> The sample list is just that: a list of all your instruments. You
create it by telling OctaMED the names of your sample directories, and
the program then loads the names of all the samples in these
directories.

After you create this list, you save it to disk. When you then load
OctaMED later on, the list is automatically loaded into the program.

The sample list is a convenient, organized catalog of all your instruments.
It is very useful in two different ways, as we shall discover. We’ll now
select each of our sample directories to form a sample list.

b) Find Add Dir... (slightly below and to the right of center) and click it

==> Add Dir stands for Add Directory.
Directory is another word for drawer.

A drawer requester appears. This is like a file requester, except only
drawers are listed.

c) Put the OctaMED_Samples disk in any disk drive

d) Click the Disks button, then click OctaMED_Samples

e) To sort the list alphabetically, click on the scroll bar (the long black
rectangle on the right). ( ignore this if you have V5.01 or later )

f) Now click on the first drawer in the list (Bass_Drums), then on the OK
button (bottom left)

==> The disk and directory name (OctaMED_Samples:Bass_Drums) appears in the
directory list (on the right), and the contents of the directory
appears in the instrument list (on the left).

==> NOTE: The instruments themselves are not loaded, only their names
and in which disk and directory they’re stored

g) Click Add Dir... (near the middle) again to open the drawer requester
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h) Click the Parent button to display the disk’s sample drawers

i) To sort the list alphabetically, click on the scroll bar (on the right)
( ignore this if you have V5.01 or later )

j) Now click on the second drawer in the list (Bass_Notes), then on the OK
button

k) In answer to the question "Where should I insert the directory?" that
appears at the top left, click End of the List

==> This new drawer and its contents is added to the end of the sample list

l) To view all the instruments in the new drawer, drag the instrument list
scroll bar (the long black rectangle to the right of the instrument
list) downwards and upwards

m) Now over to you! See if you can add the rest of the directories on the
disk to the sample list

(Remember: Add Dir, Parent, scroll bar, click drawer, OK,
End Of The List)

==> There should finally be 9 directories in the list. (If you have sample
directories or disks of your own, however, by all means have a go at
adding them to the list).

1.32 Saving sample list

a) Put the OctaMED boot disk in any drive (if it isn’t already in one)

b) Click Save List... (near the middle on the far right)

A file requester appears. ==> The normal place to save a sample list is in
the S drawer of your boot disk, and the normal name is MED_Paths (so-called
because it contains the path OctaMED should travel on to find each sample).

When loading OctaMED later on, the program looks for the MED_Paths file in
the S drawer, so you should normally save the sample list under this name.

c) Bearing this in mind, simply click the OK button to save the list as
S:MED_Paths

Sample list use number 1: Easier instrument loading

Let’s replace the snare drum sample in our song with a different sample.

a) Use Shift-<left> and Shift-<right> to select instrument 02, then play
this RSnareDrum instrument using the keyboard

b) Insert the OctaMED_Samples disk in any drive (if necessary)
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c) Select the OctaMED_Samples:Drums+Percussion directory by clicking on it
in the directory list (on the right)

d) Select the SnareDrum.u20 sample by clicking on it in the instrument
list (on the left)

==> The use of the boxes beside Name, Repeat, RepLen, Transpose,
Finetune etc. will be explained in a later tutorial.

e) To load this sample, click on the Load Inst button (at the very bottom
in the middle)

==> The SnareDrum.u20 sample has replaced the RSnareDrum sample in
instrument position 02.

f) Close the Sample List Editor (close gadget (top left) or Exit (bottom
right))

g) To hear the difference between the two snare drum samples, play the new
instrument using the keyboard then play and stop the song (upper screen)

1.33 Easier instr loading

a) Find the small Instrument Load button (upper screen, top row,
immediately to the right of 02) and click on it

==> The sample list appears in a simpler-looking window than the Sample
List Editor. Loading instruments is made very easy here.

We’ll load an open hi-hat sample for the next part of the song.

b) To select the nearest empty instrument position, click Next Free
(bottom, right of center)

==> Notice that the current instrument has changed from 02 to 06.

c) In the directory list (right), click OctaMED_Samples:Cymbals+Hi-Hats

d) Now in the instrument list (left), click Hi-Hat Open 1

The instrument’s loaded in just four clicks of the mouse button. Easy?!

e) Try playing the instrument (I think the P key - note E-3 - sounds best),
then close the window (close gadget or Exit)

1.34 Block’s length and name
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We’re now going to add another part to the song: a variation on the tune we
composed in Tutorial 2. There will be a different drum beat followed
by a guitar solo.

a) Add a new block by pressing Ctrl-N, and move to this new block (005) by
pressing Left Alt-<down> (this moves to the last block in the song)

==> This new block will contain a new drum beat on its own in track 0.
We’ll make the block half the size that it usually is (i.e. 32 lines
instead of 64 lines).

==> Note for musicians: you may be wondering why the normal OctaMED block
length is 64 lines. Well...

+ The time signature of most music is 4/4 (4 quarter-note beats per
measure (or per bar in Britain) )

+ Each line can be thought of as a sixteenth-note (semiquaver)
+ In 4/4 time, there are 16 of these sixteenth-notes in a measure, so

one measure takes up 16 OctaMED lines

So 64 lines allow for four measures of 4/4 time.

b) To open the Block Properties window, find the B button (upper screen,
middle of fourth row) THEN HOLD DOWN THE Shift KEY while clicking on it

==> This technique is called shift-clicking.

c) Notice the blue cursor in the Name text box (the embellished box to the
right of Name), then type Beat 2 [32 lines] and press Return

==> Look at the block status display (upper screen, to the right of the
B button). The block name you’ve just typed is displayed.

Back in the Block Properties window, we’ll reduce the length from 64 to 32.

d) To reduce the length by 10 three times, click the << button three times

e) To reduce the length by 1 twice, click the < button twice. The contents
of the Length numeric box should now be 32

f) Close the window (close gadget or Exit)

g) To confirm that the block really is 32 lines long, press F10 to move to
the last line. It should be number 031. Press F6 to return to line 000

Default pitch and changing instruments using Instrument Parameters

==> New to this version of OctaMED, the default pitch function allows you
to set a standard note for each instrument. For example, we’ve been
entering instrument 01 (Bass Drum) with note C-2 (the Q key), so we can
call this the standard note for this instrument.

You can then enter the instrument using its standard note (or default
pitch) by pressing the F key (as in deFault pitch). This is especially
useful for percussion instruments, which are usually always played at
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the same pitch.

So we’ll set default pitches for Bass Drum, SnareDrum.u20, Hi-Hat Closed 2,
and Hi-Hat Open 1. At the same time, we’ll learn how to select the current
instrument using the Instrument Parameters window.

a) Find Inst Params (upper screen, middle of second row) and click on it to
open the Instrument Parameters window

b) Select instrument 01 (Bass Drum) by clicking on the 1st button (at the
top right of the window)

c) Find the pitch box to the right of Default Pitch (bottom left), then
hold down the left mouse button on it and press the Q key. Release the
mouse button

==> Default pitch C-2 is now set for this instrument.

d) Select instrument 02 by clicking the > gadget (top right, beside 1st),
then set this instrument’s default pitch to C-3 (using the I key)

e) Click > again, then set instrument 03’s default pitch to D-3 (using O)

f) Select the last used instrument in this song (06) by clicking L.U. (top
right), then set the default pitch to E-3 (using P)

g) Now close the window (close gadget or Exit)

1.35 New keyboard shortcuts

This section - entering the drum beat - introduces four new shortcuts.

a) Press Shift-Alt-<left> *NEW SHORTCUT* (hold down both Shift and Alt and
press <left>) to select instrument 01

b) Turn edit mode on by pressing the Esc key *NEW SHORTCUT* (very top left
of keyboard)

c) Now enter the following instruments at their default pitch using the F
key (all notes in track 0) :

(Remember: Shift-<left> and Shift-<right> to change instruments
Alt-<left> and Alt-<right> to change tracks)

Line Instrument | Line Instrument | Line Instrument
-------------------+--------------------+-------------------

==> 000 01 | 004 03 | 010 01
==> 002 03 | 006 02 | 012 02
==> 003 03 | 008 03 | 014 06

We’ll now copy the notes we’ve just entered into the second half of the
block.



PREFACE 35 / 175

d) To mark a range from line 000 - 014, hold down the left mouse button on
the E-3 60000 on line 014 and press F6 to move to line 000. Release the
mouse button

e) Now to copy the range into the copy buffer, press Ctrl-C *NEW SHORTCUT*

f) To paste the copy buffer starting from half-way through the block (line
016), press F8 then Ctrl-V *NEW SHORTCUT*

g) Change the final note in track 0 (line 030) to instrument 03 (at default
pitch)

h) To hear what we’ve just composed, play and stop this block

1.36 Changing tempo (song speed)

You may find the speed of this new beat a bit slow... so let’s speed it up.

a) Find the two tempo sliders (upper screen, third row, on the right)

==> The longer slider is the primary tempo (current value 033); the shorter
slider is the secondary tempo (current value 06). The difference
between and use of the two sliders will be covered in later tutorials.

For now, we’ll alter the primary tempo slider because it offers greater
control over the speed than the secondary tempo slider.

b) Click Play Block, and slowly drag the primary tempo slider (left-hand)
until it reaches about 071. Stop the playing

==> Notice that the slider value increases in steps of 2 as well as of 1.
This is because the slider itself is not long enough to allow you to
slide all 240 possible values of this slider.

To select values between the steps of 2, you need to click inside the
slider box but not directly on the small black knob. We’ll now try to
select one such intermediate value: 044.

c) Drag the primary tempo slider to the left until it reaches 043

d) Click anywhere inside the slider box immediately to the right of the
small black knob

==> The tempo increases by one to 044. Clicking immediately to the left
of the knob would have decreased the tempo by one.

e) Now play and stop the block again. A better speed, don’t you think?

============================> HALF-WAY MARK! <===========================

[ To stop: do the Sample list use number 2 section
To restart: do the If you’ve just joined us section ,
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EXCEPT in step d double-click Song1-Tut3, then switch edit
mode on (Esc key or Edit check box) ]

1.37 Menu shortcuts

==> Many operations selected using the menus have their keyboard shortcut
actually displayed on the menu.

a) Firstly, add a new block (006) by pressing Ctrl-N, and move to the last
line of this new block using Shift-<down> and F10

==> It’s 031! There’s only 32 lines in this block, because pressing
Ctrl-N takes the number of lines from the current block.

The current block (005) had 32 lines, so another 32-line block was
added.

We now need to change this block to 64 lines long. This involves selecting
the Set Properties item from the Block menu, but we’ll select this item
using a different method from usual...

b) Holding down the right mouse button, move to the Block menu and LOOK
immediately to the right of the words Set Properties...

==> The odd-looking A and the letter B is this item’s keyboard shortcut.
The A represents the Right Amiga key... (Release the mouse button)

c) So select Set Properties from the Block menu using Right Amiga-B (the
Right Amiga key is beside Right Alt)

==> To sum up, there are three ways to open the Block Properties window:

+ Hold down Shift and click the B button (as we did earlier)
+ Select Set Properties from the Block menu (right mouse button)
+ Press Right Amiga-B

d) Put the blue cursor in the Length numeric box by pressing the Tab key,
press Del twice, then type 64 and press Return

==> Putting the cursor in a text or numeric box is known as activating
the box.

e) Close the window

We’ll copy the drum track from block 005 to block 006, using more menu
shortcuts.

f) Holding down the right mouse button, move to the Track menu and find
out the keyboard shortcuts for Copy and Paste

==> The Right Amiga key is usually referred to as simply Amiga (since Left
Amiga is not used nearly as often).

g) Move to block 005 and copy track 0 using Amiga-C (Copy Track)
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h) Move to block 006 and paste into track 0 using Amiga-V (Paste Track)

Since block 005 has 32 lines and block 006 64, only the first half
of block 006 has the drum beat in it. Let’s paste it to the second half of
the track (from line 032).

i) Move to the half-way line by pressing F8, then press Ctrl-V (Paste
Range)

==> Paste Track pastes the copy buffer from line 000
Paste Range pastes the copy buffer from the cursor

(All editing operations use the same copy buffer)

j) Play and stop the block

1.38 Line highlighting

==> Standard Western music has a regular pulse which is known as a beat.
In the note for musicians I mentioned that a 64-line block
is 4 measures of 4/4 time. In 4/4 time in OctaMED’s Tracker editor, a
beat is every four lines of track.

There is a function in OctaMED to highlight lines regularly. One use of
this is to highlight every beat, which can be very useful when composing,
so we’ll look at how to highlight every fourth line.

a) To open the Highlight Options window, select Highlight from the Block
menu

b) To highlight every fourth line, click the 4 button (along the top row)

c) Close the window

d) Scroll down the block (using <down>) and notice the highlighting every
fourth line

Adding a new block using the Block List, and gadget shortcuts

First, we’ll add the new bass line.

a) Move to track 1 line 000 (Alt-<right>, F6)

b) Select instrument 04

c) Since the notes we’ll enter are all on even-numbered lines, turn space
mode on by pressing ~ (the key directly above Tab)

d) Now enter these notes on their respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
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> 000 A-1 N | 028 C#2 L | 054 E-1 C
> 006 A-1 N | 032 B-1 M | 056 E-1 C
> 012 C#2 L | 038 B-1 M | 058 F#1 G
> 016 F#1 G | 044 C#2 L | 060 G#1 H
> 022 F#1 G | 050 E-1 C |

e) Play and stop the block

Now we’ll examine another way to add new blocks and type in blocks’ names.

f) Open the Block List by clicking B (upper screen, middle of fourth row)

==> The current block, 006, is highlighted in white

g) To give block 006 a name, activate the block name text box (directly
above Ins To Seq) by clicking inside it, then type Beat 2, bass 2 and
press Return

h) Add two new blocks by clicking Append New (bottom center) twice

==> Gadget shortcuts: Notice that the A on the Append New gadget is
underlined. This means that holding down the Left Alt key while
pressing A is the shortcut for this gadget.

i) So add another two blocks by pressing Left Alt-A twice (you’ll have to
use the scroll bar to see the newly-added blocks)

j) To give block 000 a name: drag the scroll bar to the very top, click on
block 000, click inside (activate) the text box, then type Beat (bass +
snare) and press Return

k) By using the scroll bar, clicking on blocks and activating the text box,
give the following names to their respective blocks:

Block number | Block name
---------------+-----------------------------

> 001 | Beat (bass, snare + hi-hat)
> 002 | Beat + bass line
> 003 | Beat, bass line + tune (1)
> 004 | Beat, bass line + tune (2)
> 007 | Guitar solo (1)
> 008 | Guitar solo (2)
> 009 | Guitar solo (3)
> 010 | Guitar solo (4)

l) Select block 007 as the current block (ready for the next part)

m) Notice that the x is underlined on the Exit gadget, then press Left
Alt-X to close the window

Adding the guitar solo, and the Copy and Paste Block shortcuts

If you like, you can highlight every fourth line in this new block as well.
I find that highlighting every beat in this way gives some sort of musical
structure to blocks. If you find this helps as well, do the following:
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a) To open Highlight Options, select Highlight from the Block menu

b) Click on the 4 button, then close the window

==> This next bit isn’t optional! We’ll load a guitar sample.

c) To open the Load Instrument Window, click the small gadget resembling a
list (upper screen, left of top row, to the right of 04)

d) Move to the next free instrument (07) by clicking Next Free

e) Click the OctaMED_Samples:Guitars directory, then click the Guitar Solo
instrument

f) Close the window (use Left Alt-X if you like!)

Now we’ll copy block 006’s drum beat and bass line into block 007 using
two new keyboard shortcuts.

g) Move to block 006 (Shift-<up>), then copy the block using Shift-Alt-C

h) Move back to block 007, then paste the block using Shift-Alt-V

Now to add the guitar solo. This spreads over four blocks.

i) Move to track 2 (Alt-<right>), then enter the following notes on their
respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 000 C#2 2 | 032 F#2 5 | 056 F#2 5
> 006 E-2 E | 036 C#3 9 | 060 E-2 E
> 024 E-2 E | 038 B-2 U |

j) Play and stop the block, then move to block 008 (and highlight every
fourth line if you want)

k) The beat and bass line are still in the copy buffer (see step g above),
so press Shift-Alt-V

l) Enter the following guitar notes on their respective lines:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 000 C#2 2 | 024 E-2 E | 046 B-2 U
> 002 E-2 E | 032 F#2 5 | 056 C#3 9
> 004 F#2 5 | 040 C#3 9 | 060 D-3 O
> 006 E-2 E | 044 E-3 P |

m) Play and stop the block, move to block 009 (highlight if you wish),
and paste the drum beat + bass line (Shift-Alt-V)

==> For the next block, we need to turn space mode off (to enter a note on
line 031) and change to keyboard octaves 2+3 mode (to enter note A-3).

n) Press ~ (the key above Tab) to turn space mode off, then F2 to switch to
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octaves 2+3 (notice the octave cycle gadget (upper screen, fourth row,
far right) changing to 23)

o) Now continue the guitar solo (you’ll need to use <down> a bit more!):

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 000 F#3 5 | 022 C#3 2 | 048 E-3 E
> 004 E-2 E | 030 G#3 6 | 052 F#3 5
> 008 F#3 5 | 031 A-3 Y | 056 E-3 E
> 012 E-2 E | 044 G#3 6 | 060 B-2 M
> 016 F#3 5 | 046 F#3 5 | 062 C#3 L
> 020 E-2 E |

p) Play and stop the block, move to block 010 (highlight if you wish), and
paste the drum beat + bass line (Shift-Alt-V)

q) Change back to keyboard octaves 1+2 by pressing F1, turn space mode on
(the ~ key) and enter some more guitar notes:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 008 F#2 5 | 012 A-2 Y | 020 C#3 9
> 010 G#2 6 | 016 B-2 U | 022 A-2 Y

r) Play and stop the block. Since this is the final block, we’ll add a
little ending. Enter these notes on track 1 using instrument 04:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 038 E-1 C | 044 B-1 M | 048 A-1 N

Finally, we’ll delete all the notes in the block from line 050 to the end
using a handy keyboard function:

s) Move to track 0 line 050, then press Shift-Ctrl-K

t) Play and stop this final block

1.39 Creating playing sequence

==> Using the Playing Sequence window in Tutorial 2, it took three clicks
of the mouse to create each entry (the Bottom, Insert and arrow
buttons). Using the Block List, it takes just two clicks.

a) Open the Block List (B button, upper screen, fourth row), then open the
Playing Sequence window (Sq button, to the left of the B button)

==> Notice that the Playing Sequence window displays block names. This
makes reading the playing sequence much easier.

We’ll add to the playing sequence all blocks in increasing order from 005
to 010.
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b) Select block 005 in the Block List, then click App To Seq (bottom left)

==> App To Seq appends (adds to the bottom) the current block to the
playing sequence. So here, 005 was appended to the playing sequence.

c) Append block 006 twice by selecting block 006 then clicking App To Seq
twice

d) Now append blocks 007 to 010 (in increasing order) to the playing
sequence. (Remember: Click on block, App To Seq)

e) Close both windows, then play the whole song through (then stop). You’ll
notice the speed of the first section has increased from what we’re used
to (we set the primary tempo to 044 earlier on)

1.40 Saving using less disk space

==> In Tutorial 2, we saved the song together with its instruments. Since
we’ve now created a sample list, we can save the song without its
instruments. When the song is loaded later on, the instruments are
automatically loaded, using the sample list to find out in which disk
and directory each instrument is stored.

a) Open the Save Options window by selecting Save from the Project menu

First we’ll change the song’s filename to Song1-Tut3.

b) Notice the blue cursor highlighting the E in the filename text box (very
top)

c) Move the cursor to the very right of the filename by pressing
Shift-<right>, then press Backspace, 3 and Return

Now we’ll discover the substantial difference in size between saving a song
with and without instruments.

d) Notice that the Save Instruments check box (on the left) is on, then
click Calculate Size

==> It should be around 111,000 bytes. That’s a lot of disk space!

e) Now turn the Save Instruments check box off by clicking on it, and click
Calculate Size again

==> It should now be around 13,000 bytes, almost a tenth of the previous
value. This underlines the amount of disk space the song takes up
compared with its instruments.

f) Switch Create Icons off (if it isn’t already), then save the song
without its instruments by clicking Save (bottom left), and close the
window
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1.41 Setting up for tutorial 4

a) Turn both edit and space mode off by pressing Esc and ~

b) Clear the whole song by selecting New from the Project menu and clicking
Clear All in the window that appears

==> Checklist 3 - can you: <==

(1) Add directories to, and save, the sample list ?
(2) Load an instrument using the Instrument Load Window ?
(3) Open the Block Properties window using the Block menu, the B gadget or

the keyboard shortcut ?
(4) Name a block and change a block’s length using Block Properties ?
(5) Define and enter notes with an instrument’s default pitch ?
(6) Select the previous, next, first and last used instrument using the

Instrument Parameters window ?
(7) Change the primary tempo (steps of 1, 2 or 3) ?
(8) Recognize and use menu (Right Amiga) and gadget (Left Alt) shortcuts?
(9) Activate a text or numeric box by clicking inside it ?
(10) Highlight lines regularly ?
(11) Name blocks, add new blocks and create a playing sequence using the

Block List ?
(12) Save a song without its instruments ?
(13) Many keyboard shortcuts were introduced in this tutorial. However, you

need for the moment only remember five of the new ones:

Esc and ~ -> Switch edit mode and space mode on/off
F6, F8, F10 -> Move to the first, middle, last line of the block

It’s been a long tutorial, but hopefully it’s also been worth it! If you’d
like to do this tutorial again, you’ll have to clear the sample list:

a) Choose Sample List Editor from the Display menu

b) Click on the first directory (OctaMED_Samples:Bass_Drums)

c) Repeatedly click Remove Dir (directly below the directory list)
until the list is cleared

Before you go on to Tutorial 4, where mainly we’ll be looking at adding
special effects to the song, it’s DEFINITELY time for a cup of tea! ;^)

I’m sory ED, I don’t like tea, so I will have another Coffee...Ray ;-)
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TUTORIAL FOUR

1.42 TUTORIAL FOUR

TUTORIAL 4 - Tuning samples and player commands

This tutorial will cover:

Loading song without instruments

Load more than one instrument

Transposing an instrument

Inserting tracks

Player commands

The vibrato command

Creating pitch slides

Generic slide

Splitting a block

Naming a song

Minor perfections

TUTORIAL FIVE
If you’ve just joined us:

a) Select New from the Project menu, and in the window click Clear All

1.43 Loading song without instruments

In Tutorial 3 we saved the song without its instruments. Let’s watch what
happens as we reload this song.

a) Select Open from the Project menu

b) Insert your tutorial disk in any drive, click Disks and click the
disk’s name

c) Click the Songs drawer, then double-click Song1-Tut3

d) When prompted, insert the OctaMED_Samples disk in any drive
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==> Each instrument used in the song is now loaded directly from the
instruments disk. OctaMED knows where the instruments are because their
disk and directory names are defined in the sample list (which we made
in Tutorial 3).

e) Play the song through to remind you how it goes, then stop playing

f) Now move back to block 000 by pressing Left Alt-<up>

The F6 - F10 keys, flushing, clearing and reloading

This next section of the tutorial won’t progress you further with the song,
but will introduce three quite important new operations.

First we’ll look at the function of the F6, F7, F8, F9 and F10 keys.

a) Move to track 1 (of line 000), select instrument 05, and turn edit mode
on (Esc key or Edit check box)

b) Now enter note G-2 by pressing T, and press F7 to move a quarter of the
way down the block (line 016)

c) Enter note G-2 again (T key), and press F8 to move half-way down (032)

d) Again enter G-2, and press F9 to move three-quarters down (line 048)

e) Enter G-2, press F10 to move to the last line (063), and enter G-2 again

f) Play and stop the block to hear what we’ve done

==> You’ll find these five function keys very useful while composing.
(Probably not for entering a G-2 every sixteenth line, though!).

g) Now turn edit mode off, then flush (remove) instrument 05 by selecting
Flush Current from the Instr menu. Its name and size disappears (upper
screen, top row)

h) Play and stop the block again, and notice that the notes we entered with
instrument 05 no longer sound because the sample is no longer in memory

We’ll now clear the whole song but retain the song’s instruments.

i) Select New from the Project menu

==> The window’s title bar shows WARNING: Current project modified!
because we haven’t saved the changes to the song we made above. And
we won’t either!

j) To clear the song without clearing the instruments, click Clear Current

k) Use Shift-<left> and Shift-<right> to confirm that the instruments are
still in memory

Remembering that instrument 05 isn’t in memory (we flushed it in step g on
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above), we’ll reload the Song1-Tut3 song.

l) Select Open from the Project menu (DON’T cancel the Please insert volume
requester if it appears), and insert your tutorial disk in any drive if
necessary

m) The correct directory and filename should already be displayed in the
file requester, so simply click Ok to reload the song

n) If asked, insert the OctaMED_Samples disk in any drive

==> Notice that ONLY INSTRUMENT 05 (Tuned Piano) IS LOADED. The other
instruments the song uses are already in memory, so they don’t need
to be reloaded.

1.44 Load more than one instrument

==> The Instrument Load Window, we learned in the previous tutorial, is
very useful for loading instruments contained in the sample list.
However, with the Load Instrument(s) file requester you can select more
than one instrument at a time.

We’re going to add a backing to the guitar solo section of our song, using
three choir-like samples. We’ll load these three samples now.

a) Select instrument 08 (Shift-<right>). It is at the moment empty

b) To open the Load Instrument(s) file requester, click the GetFile button
(upper screen, second small button to the right of 08)

==> If a Please insert OctaMED_Pro_V5 requester appears, click Cancel

c) Click Disks then OctaMED_Samples, and click the Strings+Choirs drawer
( note that in later versions Disk is replaced with VOLUME)

d) Hold down a shift key and then Click ONCE on each of the following
instruments: Chorus (sus 4), Chorus (minor), Chorus (major);
then click the OK button (bottom left)
==> The current instrument is now 0A. OctaMED loaded the three selected

samples into positions 08, 09 and 0A in alphabetical order.

e) To confirm this, select the instruments (08, 09 and 0A) (Shift-<left>)

1.45 Transposing an instrument

There is a small problem with these three new instruments, in that they are
each tuned to a different pitch. To prove it...

a) Play instrument 07 using (say) the I key, then play each of the new
Chorus instruments in turn (08, 09, 0A) using the same key. Press the
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space bar to stop notes playing

==> To make composing easier, playing each melodic instrument (i.e. not
percussion) using any given key should produce the same pitch. At the
moment, this isn’t true of the Guitar Solo and three Chorus samples.

So we’ll make it true, by tuning the Chorus instruments to the Guitar Solo
instrument.

Tuning instrument 08

a) To open the Instrument Parameters window, click on Inst Params (upper
screen, middle of second row)

b) Find the tuning gadgets: a cycle gadget marked Transpose (half-way down
on the left), and a slider to the right of it

==> Dragging the slider alters the pitch of, or tunes, the instrument. The
slider is currently in Transpose mode, where the pitch is changed in
halfsteps (semitones in Britain).

c) To change the cycle gadget to Finetune, click on it. You’ll notice the
slider’s knob become slightly larger

==> Finetune mode allows tuning in far smaller steps.

d) Change back to Transpose mode by clicking the cycle gadget again

Now we’ll change instrument 08’s Transpose value to -2.

e) First select instrument 08 and play it using the I key (don’t stop it)

f) Drag the tuning slider very slightly to the left to select value -3,
then click inside the slider box anywhere to the right of the black knob
to select -2. Play the instrument again using the I key

==> You’ll notice that the pitch has dropped. It has in fact lowered by
exactly two halfsteps (e.g. D-3 -> C#3 -> C-3).

Now we’ll change instrument 08’s finetune value to 2.

g) Select Finetune mode by clicking the cycle gadget displaying Transpose

h) Slide the tuning slider to the right until value 2 is reached, and play
the instrument again using I

==> The pitch has now slightly raised. Notice the -2/2 beside the cycle
gadget: this means that the Transpose value is -2 and the Finetune
value is 2. The instrument’s tuning is said to be -2/2.

i) Now play Guitar Solo (instrument 07) using I, then play instrument 08
again. They’re in tune! (Stop the sample playing using the space bar)

Tuning instruments 09 and 0A
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a) Play instruments 08 and 09 in turn using the I key (space bar to stop)

==> Instrument 09 is 1 note sharper (higher in pitch) and 2 finetune
steps flatter (lower in pitch) than instrument 08. So we’ll set its
tuning to -1/2.

b) Select instrument 09, select Transpose mode by clicking the usual cycle
gadget, and click inside the slider box anywhere to the left of the knob

c) Select Finetune mode (cycle gadget), then drag the slider right to 2

d) Play instruments 08 and 09 again to hear that these two are now in tune

Finally, we’ll tune instrument 0A to 09.

e) Select instrument 0A and set its finetune value to 2 (using the slider)

f) Now it’s over to you to set 0A’s transpose value! First switch the cycle
gadget to Transpose, then play instruments 09 and 0A in turn using the
same key and make adjustments to the slider until they are in tune.
(This will involve clicking inside the slider anywhere to the left of
the knob)

==> Instrument 0A’s final transpose value should be -4.

g) Play instruments 07, 08, 09 and 0A to prove that they’re all in tune
with each other, then close the Instrument Parameters window

1.46 Inserting tracks

Time to add the backing, and in customary fashion we’ll learn a couple of
new functions at the same time...

a) Using Shift-<down>, slowly examine blocks 002 - 004, and notice that the
bass is in track 2 and the solo instrument in track 3

b) Now examine blocks 006 - 010, and notice that the bass and solo lines
have moved one track to the left (bass in track 1, solo in track 2)

==> For consistency throughout the song, it’s good practice to keep the
various components of the song (e.g. bass and solo lines) on the same
tracks. For this reason, we’ll shift the bass and solo tracks in blocks
006 - 010 one track to the right for consistency with blocks 002 - 004.

c) Select block 006 track 1, and select Insert Empty -> Current Block from
the Track menu. The contents of track 1 shift to the right into track 2

d) Select block 007, then again select Insert Empty -> Current Block from
the Track menu. Repeat this for blocks 008 to 010

To enter the backing, we’re going to switch Space on to skip every 8 lines.
Here’s an easy way to do this...
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e) Select block 006, then shift-click (i.e. hold down a Shift key and
click) the Space check box (upper screen, left of bottom row). Space is
turned on and the Keyboard Options window is opened

f) In Keyboard Options, drag the Space Value slider (center right) to 8
then close the window

g) Now switch edit mode on (Edit check box or Esc key), then enter these
notes with their respective instruments on their respective lines:

Line Instrument Note Keypress | Line Instrument Note Keypress
-----------------------------------+-----------------------------------

> 000 08 A-2 Y | 048 0A E-2 E
> 016 09 F#2 5 | 056 08 E-2 E
> 032 09 B-2 U |

h) Play and stop the block

Finally in this section, we’ll copy and paste the backing track into block
numbers 007 to 010, then alter the backing in block 010 slightly.

i) Select Copy from the Track menu, then paste the copy buffer into blocks
007 to 010 in turn (always in track 1) by using Shift-<down> and
selecting Paste from the Track menu (or by using its menu shortcut if
you like: Amiga-V)

j) Switch space mode off (Space check box or ~ key), then change some of
the notes in block 010 track 1 to the following:

Line Instrument Note Keypress | Line Instrument Note Keypress
-----------------------------------+-----------------------------------

> 038 0A E-2 E | 048 08 A-2 Y
> 044 08 E-2 E | 056 Delete note (press Del)

k) Play and stop each of blocks 007 to 010 (and play the song if you like!)

1.47 Player commands

==> So far we’ve ignored the 0000 that appears to the right of the note
names in the Tracker editor. It’s time to unravel the mystery... The
four digits are collectively known as the command digits. By altering
them, you can add special effects to the notes, and ask OctaMED to
perform certain actions.

command type
/ \

A typical note ==> C - 2 1 0 0 0 0
\ /

command level

The command type is the sort of effect or action, and the command level
allows you to control the effect or action’s intensity, depth, speed
etc. (depending on the sort of command).
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Examples of commands affecting notes are slide pitch, vibrato (rapid up-
and-down pitch sliding), change volume, and stop note playing. Examples of
commands performing actions are stop song playing, jump to a certain
playing sequence entry, change tempo (speed of song), and repeat certain
lines of a block a specified number of times.

==> The command digits use a different numbering system from the decimal
system we are used to: hexadecimal. In this system, digits may have one
of sixteen values: 0 1 2 3 4 5 6 7 8 9 A B C D E F.

The rest of this tutorial will take you through some of the most important
player commands.

Adding a player command to a block, and switching tracks on and off

We’re now going to add a player command to the bass line (in blocks 006 -
- 010): on lines 048 and 052, we’ll enter a stop note playing command (0FFF)
to make the bass line a bit "snappier" (you’ll understand when you hear
it!).

a) Select block 006, and move to track 2 line 048

b) Move the cursor on to the second command type digit by pressing <right>
three times, and press F

==> The first command type digit is already 0 (remember we’re adding
command 0FFF).

c) Move to the next digit by pressing <up> then <right>, press F again,
press <up> then <right>, and finally again press F

==> Now that we’ve added this command, on line 048 the note currently being
played on track 2 will be stopped (or cut).

d) By looking at track 2 line 044, we realize that the note that will be
stopped is C#2 played with instrument 04 (FlickBass (soft))

e) Play the block. If you listen carefully, you’ll hear the bass line stop
at line 048

==> But it’s quite hard to hear because of the chorus in track 1. So we’ll
learn an easy way of temporarily switching off track 1.

f) Keeping the block playing, find the row of blue track selection gadgets
(upper screen, bottom row) and click on number 1

==> Track 1 switches off (the 1 gadget goes gray). Can you hear the cut
at line 048 more clearly now?

We’ll add another player command 0FFF on line 052.

g) First stop the block playing, then move to the note name part of track 2
by pressing Alt-<left>, and move to line 052

h) As in steps b and c above, press: <right> three times, F, <up>, <right>,
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F, <up>, <right>, and F

i) Now play the block. See if you can hear the new cut at line 052

j) Keeping the block playing, switch track 1 back on by clicking the
track 1 gadget (upper screen, bottom row)

Finally in this section, we’ll copy and paste this altered bass line track
to blocks 007 - 009.

k) Stop playing, then copy the track (Track menu -> Copy or Amiga-C), and
paste the track into blocks 007 - 009 NOT BLOCK 010! (Track menu ->
Paste or Amiga-V)

============================> HALF-WAY MARK! <===========================

[ To stop: go to Tutorial 3, and do the Sample list use number 2
section EXCEPT save as Song1-Tut4 (not 3)

To restart: do the Loading a song saved without its instruments section
EXCEPT double-click Song1-Tut4 (not 3), then
switch edit mode on (Esc key or Edit check box) ]

1.48 The vibrato command

Command type 04 adds vibrato (rapid up-and-down pitch sliding) to a note.
We’ll now add this command type to one of the guitar solo notes.

a) Move to block 007 track 3 line 006

b) To add command 0452 to this note, press <right> three times,
then 4 <up> <right> 5 <up> <right> 2

To keep the vibrato going throughout some of the lines following 006, we
have to enter the vibrato command with command level 00 (i.e. command 0400)

c) To quickly enter command 0400 to lines 007 - 023, press <left> twice
then repeatedly press 4 until you reach line 024

d) Now play the block to hear the vibrato

Explanation of the vibrato command level: the first command level digit (5
in the command on line 006) is the vibrato speed, the second digit (2 on
line 006) is the vibrato depth (the length of the pitch slide). We’ll now
experiment with different values of the command level.

e) Move to line 006, position the cursor over the 2 (using <right>), and
press 7

f) Play and stop the block. The vibrato depth has lengthened

g) Now move back to line 006, position the cursor over the 5 (using <left>)
and press 2
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h) Play and stop the block. The vibrato speed has decreased

i) Experiment with other command level values (remember that 0 - 9 and
A - F are the values allowed), then change the command back to 0452

1.49 Creating pitch slides

Commands 01, 02 and 03 all create different types of pitch slide. However,
you need never enter these commands in the way we entered commands 0FFF
and 04: we’ll now look at the Pitch Slide menu item.

==> To use the Pitch Slide function, you have to:

(1) Enter the notes that the pitch is to slide from and to
(2) Position the cursor where the pitch slide is to begin

a) Move to block 008 track 3 line 016, select instrument 07, and enter note
D-2 (the W key)

==> We’ll slide down from E-2 (line 006) to D-2 (line 016) and back up to
E-2 (line 024). The slides will begin on lines 012 and 020 respectively

b) Move to line 012 and choose Edit menu -> Pitch Slide -> Type 1

==> The D-2 note is moved upwards, and five 03 commands are
automatically entered at various levels (saving a lot of time!)

c) Now move to line 020 and choose Pitch Slide -> Type 1 again

d) To hear the sliding effect, play and stop the block

You may have noticed from the Pitch Slide sub-menu that there are two
different types of pitch slide. We’ll now find out what the difference is.

e) Move to block 009 track 3, and create a type 2 pitch slide between lines
000 and 004, starting at line 002, by moving the cursor to line 002 and
selecting Edit menu -> Pitch Slide -> Type 2

==> This time the D-2 isn’t moved, and command 02 is used instead of 03.

f) Create a type 1 pitch slide between 008 and 012, starting at 010, by
moving to line 010 and choosing Edit menu -> Pitch Slide -> Type 1

g) Finally, create another type 2 pitch slide between lines 016 and 020,
starting at line 018

We’ll play the block, but first we’ll solo track 3 (make track 3 play on
its own) so we can hear the difference between the slide types easily.

h) Find the track 3 gadget (upper screen, directly below the Gu in Guitar
on the right of the fourth row) and shift-click it (click it with Shift
held). Now only track 3 is on
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i) Listening carefully to the two pitch slide types, play + stop the block

==> Pitch slide type 1 (the second slide in this block) should sound a
little smoother than pitch slide type 2. This is because with type 2,
the note slid to (E-3 in all these cases) is replayed, but not with
type 1.

Which type you use depends completely on how it sounds to your ear. I find
that I usually get the better results with type 1.

j) Turn all tracks back on (or set all tracks) by clicking Set (upper
screen, far bottom right)

==> Notice that tracks 4 5 6 7 8 9 A B C D are also turned on, although
in this block they don’t exist (so you needn’t worry about them!).

Volume slides, and inserting blocks and playing sequence entries

==> Command type 0C sets the volume of a note. Its command level can be 00
(no volume) - 64 (full volume) in DECIMAL. This is the only command
type whose level can be specified in decimal... so make the most of it!

Volume Slide in the Edit menu creates a string of 0C commands down a track,
with gradually increasing or decreasing levels. When this is played, the
volume of the note(s) in the relevant track gradually increases/decreases.

a) Select block 006, play it right through once then stop playing

==> At the moment, in the song this one block is played twice. We’ll change
it into two blocks that are played once each. In the first of the
blocks, we’ll create a volume slide so that the chorus’ volume (in
track 1) gradually increases from almost no volume to full volume. The
second of the blocks will be exactly like the current block 006.

First, we’ll insert a block between 005 and 006, and see what happens in
the playing sequence as we do.

b) Open the Block List by clicking B (upper screen, middle of fourth row),
then open the Playing Sequence window (Sq button, left of B)

c) Drag the scroll bar in Playing Sequence until the list shows entry
numbers 008 onward. Notice the sequence is 005 006 006 007 008 009 010

d) In Block List, to insert a new empty block at the highlighted position
click Insert New (bottom center)

==> The sequence has adjusted itself to 005 007 007 008 009 010 011.
Although the block numbers have changed, the block order is the same.

e) Activate the text box in the Block List (click inside it), then give
block 006 the name Beat 2, bass 2, chorus fade (and press Return)

We need to insert this new block 006 in the playing sequence between
entries 008 and 009, and then one of the 007:Beat 2, bass 2 entries.

f) So click on playing sequence entry 009, then to insert the current block
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click Ins Curr (slightly below center of the Playing Sequence window)

g) Now click on either 010 or 011 sequence entry and then click on the
Delete button in the Playing Sequence window (center right)

h) Close both windows

Now for the volume slide. We’ll gradually increase track 1’s volume from 1
to 64 between lines 000 and 048.

i) To copy block 007 into 006, move to block 007, select Block menu ->
Copy, move to block 006, and select Block menu -> Paste

j) Highlight every fourth line if you find it helps (Block -> Highlight)

k) Now move to track 1, and on line 000 enter command 0C01 to set the
starting volume (using the <up>, <right>, 1 and C keys, but not in that
order!)

l) Move to line 048 and enter command 0C64 (ending volume)

m) Now move to any line between the starting and ending volume commands
(e.g. line 005, 042, 027 ...), and choose Edit menu -> Volume Slide

n) Hear the effect of this by playing and stopping the block

1.50 Generic slide

In Tutorial 3, you may remember changing the primary tempo from 033 to 044
to make the second half of the song sound a bit better. Well, we’re going
to change the tempo back to 033, but then use player command 0F to
gradually speed the tempo up to 044.

In practical terms, we’re going to create yet another slide!, this time
using command 0F, throughout block 005 (which is the "link" block between
the two halves of the song).

==> Remember entering the 0FFF command earlier, to stop notes in the bass
line? This was using command 0F at level FF (255 decimal). Command 0F
can also alter the primary tempo if you use levels 01 - F0 (1 - 240
decimal). Using still other levels with this command performs various
other actions: put simply, it’s OctaMED’s multi-purpose command.

a) Move to block 005

Now to test you on decimal -> hexadecimal conversion! What’s decimal 33 in
hex? ...... 33 Devided by 16 = 2 remainder 1. So it’s 21. Easy?

b) Put command 0F21 on the first line of any track. This sets the starting
speed to 033

so what’s decimal 44 in hex? ...44 devided by 16 = 2 remainder 12, so 2C.
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c) Put command 0F2C on the last line (press F10) of the same track as step
b. (Sets ending speed to 044)

d) Now move to any line (but keep the track the same) between the starting
and ending speed, and choose Edit menu -> Generic Slide

==> Generic Slide creates a slide using any command. Volume Slide always
uses 0C commands, but it can create a slide in decimal (Generic Slide
always creates in hexadecimal).

e) Play and stop the block to hear the speed gradually increase, and watch
the primary tempo slider (upper screen, fourth row) at the same time

The stop playing song command, and an introduction to sample loops

==> As you know, clicking Play Song usually plays the song repeatedly until
you stop it. Using command 0FFE, however, you can stop the song playing
at any place you wish (usually at the very end of the song).

So we’ll add command 0FFE to the last block. There’s an easy way to do it..

a) Select the last block (Left Alt-<down>), move to any track on line 056,
then to quickly add 0FFE shift-click (click with Shift held) STOP (upper
screen, top left)

b) Now play the whole song through, and notice it stop at the 0FFE command

But something’s still playing: the chorus sample on track 1! How come this
sample is so long? Let’s find out...

c) First stop the sample playing (space bar), then open the Sample Editor
by clicking Edit Sample (upper screen, right of second row)

The squiggly black line in this quite complicated-looking window is the
current sample’s waveform, which is a graphic representation of the
actual sample.

d) Play the instrument once using the keyboard, and watch the white play
marker scroll across the waveform while the sample plays

e) Now select instrument 0A, and find the loop pointers (the two small
black triangles attached to dotted lines on the waveform)

f) Play this instrument, and watch the play marker repeatedly scroll across
the part of the waveform marked by the loop pointers

g) Stop the sample playing, then select the other chorus samples (09
and 08) and notice that they also have loop pointers, then play them

==> So the reason why the chorus samples seem so long is that they have a
defined part that is repeated continuously. It’s called a loop.

h) Stop the playing, then close the window (using the close gadget since
there’s no Exit button)
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1.51 Splitting a block

Since the chorus sample on track 1 line 048 is played until you stop it,
we’ll fade it out (decrease its volume until it’s silent) using the Volume
Slide function.

Firstly, we’ll split block 011 into two blocks (011 and 012), with the
break coming at line 048. This means block 011 will have 48 lines, and the
new block 012 16 lines (since the current block 011 has 64 lines).

a) Move to line 048, then select Block menu -> Split At Cursor

==> Line 048 becomes line 000 of a new block 012.

b) Press F10 to confirm block 012 has 16 lines, then move to the last line
of block 011 to confirm the 48-line length. Move back to block 012

==> In block 012, we’ll decrease the volume by one level at a time from
full volume (64) to no volume (00). To do this, we need to increase
block 012’s length to 65 lines (to accommodate levels 00 - 64).

Firstly, we’ll delete the 0FFE command on line 008, increase the block’s
length to 65, then add a new 0FFE command on the last line.

c) Move to line 008 on the track where you put the 0FFE command, then to
set all the command digits to zero press Alt-Del

d) To increase the block’s length, open Block Properties (Block menu,
Amiga-B or shift-click B gadget), then press Tab, Del twice, and type 65
and press Return. Close the window

e) Move to the last line (F10) of any track except track 1 (since we’ll put
a volume slide on that track), then shift-click STOP (upper screen)

Now to create the volume slide.

f) Move to track 1, then to set the starting volume, put a 0C64 command on
line 000

g) To set the ending volume, put a 0C00 command on line 064

h) Now move to any line between the two commands (063 will do fine), and
select Edit menu -> Volume Slide

i) Play the block to hear the smooth volume decrease, and notice that the
block stops playing at the last line (where the 0FFE command is)

And now for the quick way!

Yes folks, except for demonstrating how to split a block in two, and
reinforcing some ideas previously introduced, that last section was a bit
of a waste of time!

==> Remember that we repeatedly decreased the volume one level at a time
until the chorus sample was silent (i.e. level 00 was reached)? Well,



PREFACE 56 / 175

there is a player command to decrease the volume by a specified level,
and another player command to repeat player commands a specified number
of times. We’ll examine these two new commands now.

a) First, rejoin block 011 with block 012 by moving to block 011 and
selecting Block menu -> Join With Next (at the very bottom of the menu)

b) We’ll now only need one extra line after the chorus sample on line 048
is played, so open Block Properties and change the line length to 50
(remember: Tab, Del three times, 50, Return)

c) Delete the 0C63 command on the last line of track 1 (using Alt-Del),
then change the 0C64 command on track 1 line 048 to 1B01

==> Command type 1B decreases the note’s volume by the command level (01
in this case).

We’d like to repeat this 1B01 command 63 times, so that the volume is
decreased by one a total of 64 times (64 -> 00). Player command 1E does
this, so...

d) First convert 63 to hexadecimal .... (63 - 16 = 3 remainder 15, so 3F),
then...

==> Using <up> and <right> all the time when entering commands is a bit
time-consuming, so here comes an easier way...

e) Open Keyboard Options by selecting Settings menu -> Keyboard Options

f) Find the Advance Cursor radio button (top right), and click the small
button to the left of Right

==> This type of gadget is called a radio button because the buttons act
like those used to select wavebands (SW MW LW FM) on old radios: one
and only one must be selected.

g) Close the window, and now enter command 1E3F (to replay 63 times) on any
track of line 048 (except track 1!). You won’t need to use the <up>
or <right> keys very often!

h) Finally, to stop the song at line 049, move to any track of line 049 and
shift-click STOP (to enter command 0FFE)

i) Now for the exciting bit... play the block! (You won’t need to stop it!)

1.52 Naming a song

a) To open the Song Options window, select Song menu -> Set Options

b) Activate the Name text box (very top) by clicking inside it, clear the
<unnamed> text by pressing Ctrl-X, then type Song 1, Tutorial 4 and
press Return

==> The song name you’ve just typed appears on the screen’s title bar.
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c) Close the window

1.53 Minor perfections

a) Notice that block 011’s name and line highlighting (if any) has
disappeared (as a result of splitting and joining blocks). Rename the
block Guitar Solo (4) (using Block Properties or Block List), and if
desired re-highlight every fourth line (using Block menu -> Highlight)

b) Play block 003. Isn’t the piano sample slightly sharp? Tune it down 1 or
2 finetune steps (select instrument 05, open Instrument Parameters,
click the tuning cycle gadget, drag the slider to -1 or -2 (whichever
you prefer))

==> Remember we produced a tempo slide from 033 to 044 in block 005? The
tempo at the moment is 044 already, so we need to set the tempo to 033
at the very beginning of the song.

c) First convert 33 to hexadecimal .... then move to the first line of the
first block (Left Alt-<up>), and enter command 0F21 on any track

d) Play block 008. The guitar vibrato on track 3 sounds a little silly,
don’t you think?! Change the vibrato depth to 1 by changing command 0452
on line 6 of track 3 to 0451

e) Now play the song through. It’s not really so bad... is it?...

Saving the song, and the Overwrite? requester

a) Open Save Options by choosing Project menu -> Save

If you stopped at the half-way mark, first change the filename back to
Song1-Tut3 (Shift-<right>, Backspace, 3, Return)

b) Turn Create Icons and Save Instruments off if they aren’t already, then
click Save (bottom left) AND DON’T CLICK OK IN THE REQUESTER!!

c) Click Cancel in the requester instead! (Sorry for screaming at you!)

==> The Overwrite? requester appears when the filename is the same as
one already in the drawer. Song1-Tut3 is the name of the song we
saved in Tutorial 3, so we’ll rename the song Song1-Tut4.

d) Activate the name text box (very top) and change the name (using
Shift-<right>, Backspace, 4, Return)

e) Now click Save again (and if you stopped at the half-way mark, click OK
in the requester this time)

==> Checklist 4 - can you: <==
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(1) Use the F6 - F10 keys ?
(2) Flush (remove) an instrument ?
(3) Clear the song while retaining its instruments ?
(4) Tune an instrument (both transpose and finetune values) ?
(5) Insert a track ?
(6) Switch Space on and open the Keyboard Options window with one click ?
(7) Convert two-digit decimal numbers to hex ?
(8) Switch tracks on and off, solo a track, and set all tracks at once ?
(9) Enter a player command, with or without Advance Cursor Right in the

Keyboard Options window selected ?
(10) Use player commands 04, FFE and FFF ?
(11) Create the following slides: pitch (both types), volume and generic ?
(12) Insert a new block using the Block List ?
(13) Insert and delete entries in the Playing Sequence ?
(14) Find the loop pointers in the Sample Editor ?
(15) Split and join blocks ?
(16) Name a song ?

This tutorial was even longer than the last one! Well, I think
congratulations are in order - you’ve just completed the introductory
tutorials. Well done... hopefully the time you spent on them was worth it!

So what happens now? You could work through the rest of the tutorials,
which cover the more advanced features of OctaMED such as making and
editing samples and synthetic sounds, using MIDI, the notation editor (yes,
you CAN compose using traditional music notation!), and working in 5 - 8
channel mode (the feature that gives the program’s title its "Octa" !).

Alternatively, you should know everything necessary to start creating
songs of your own, so you could go ahead and do just that! In fact, it’s
advisable to reinforce the basic ideas covered in the previous four
tutorials by experimenting on your own, before you go on to the rest of the
tutorials.

Anyhow, when you think you’re ready, I’ll see you in Tutorial 5 !

I have just blown my woofer Ed... That’ll teach me not to use full bass!!
(How about a tutorial on repairing expensive speaker systems)... Ray ;-(

TUTORIAL FIVE

1.54 TUTORIAL FIVE

TUTORIAL 5 - The Sample Editor

This tutorial will cover:
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Loading an instrument

Sample pitches

Moving and deleting

Magnify scrolling waveform

Reverse

Change volume

Echo

Filter and Boost

Renaming saving a sample

TUTORIAL SIX
If you’ve just joined us:

a) Select New from the Project menu, and in the window click Clear All

In this tutorial we’ll load a speech sample, alter it using the sample
editor, then save it back to disk under a different name.

The sample we’ll work on is called Bedtime For Lebanese Goats, which is a
little bit silly but perfect for our purposes!

*** IMPORTANT NOTE ABOUT MEMORY ***

If you only have half a megabyte of CHIP RAM, I’m afraid this tutorial
won’t run entirely successfully (i.e. at a certain point, OctaMED will
display Not enough memory and you’re stuck!). Users most likely to have
just half a meg of CHIP RAM are those with old un-upgraded A500s.

If you think you’ll run out of memory, please do the following:

(1) Select Settings menu -> Workbench -> Close (which frees about 40K)

(2) Carry on with the tutorial as normal, until you reach step t of
the Effect number 3: Echo section. You are most
likely to receive a Not enough memory message at this point.

(3) Do the To stop section of the HALF-WAY MARK, then reset
your machine and re-boot with OctaMED V5 disk 1

(4) Now do the To restart section of the HALF-WAY MARK, and
carry on from step t. With any luck, you should just
find enough memory to complete the tutorial (please accept my
sincere apologies if you don’t!)

I’m really sorry for this inconvenience, but the sample editor is a very
memory-intensive part of OctaMED. If you intend to use OctaMED at its
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most powerful levels, it really is worth considering buying some extra
memory if you can afford it. I have 2 megabytes of memory in my A500 (1
meg CHIP, 1 meg FAST), and I find this perfectly adequate in pratically
all situations.

1.55 Loading an instrument

==> First we’ll learn a new way of loading instruments contained in the
sample list.

a) Activate (click inside) the instrument name text box (upper screen, top
row), then type exactly Bedtime For Lebanese Goats and press Return

b) Insert the OctaMED_Samples disk when prompted

c) Open the Instrument Load Window by clicking on the small gadget
immediately to the right of 01 (upper screen, top row), then click
OctaMED_Samples:Effects+Speech (sixth down in the right hand list)

==> When you typed Bedtime For Lebanese Goats in step a, OctaMED
searched for the name in the sample list and loaded the sample when
it was found (its name appears in the left hand list, second from
the top).

This method of loading instruments which are contained in the sample list
can sometimes be handy when the name is short (so not really here!).

d) Close the Instrument Load Window (close gadget or Exit button)

1.56 Sample pitches

a) To open the Sample Editor, click Edit Sample (upper screen, second row)

==> If you remember from Tutorial 4, the squiggly black line in this window
is the sample’s waveform, which is a graphic representation of the
sample. The sample editor is used to change the whole or part of the
waveform, which can involve copying sections of waveform to other
places in the sample, changing the volume or pitch of the waveform,
creating echo effects, and a lot more.

The white line across the center of the waveform marks zero volume. The
further away from the white line a point on the waveform is, the louder the
point’s volume.

Volumes of points on the waveform display

Display: 0032098 Buffsize: 32098 R Start: 0 R End: 0
+----------------------------------------------------+ <- maximum volume
| |
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| TOP HALF OF WAVEFORM DISPLAY | <- half volume
| |
+---------------------white-line---------------------+ <- zero volume
| |
| BOTTOM HALF OF WAVEFORM DISPLAY | <- half volume
| |
+----------------------------------------------------+ <- maximum volume

==> The number to the right of Buffsize (above the waveform on the left)
is the size of the current sample, which for Bedtime For Lebanese Goats
is 32098. (This is duplicated on the upper screen’s top row).

We’ll now discover how OctaMED creates different sample pitches.

b) Press the I key. This is the correct pitch for this particular sample
(note C-3)

c) Now listening carefully, press the following keys to play the sample at
different pitches: P T B Q ]

==> Notice that the higher the pitch, the quicker the sample is played.
This illustrates that pitches are created by playing the sample at
different speeds.

d) Play the sample again using any keys, and watch the white cursor move
across the waveform

==> The white cursor marks the point in the waveform that is currently
being played.

Now we’ll learn how to mark and play a particular section of the waveform.

e) Notice that the waveform contains seven separate waveform parts
(distinct squiggles)

==> Each of these waveform parts represents a separate part of speech:

"Time -- for -- bed -- for Leb -- banese -- goa -- ts"

f) To mark a range over the third waveform part ("bed"), drag the
mouse (using the left mouse button) from the start to the end of the
third waveform part. It should now be highlighted in white

==> The Range Start and Range End numeric boxes (top right of window)
show the actual byte positions of the start and end of the range.

g) Find the Pitch gadgets (directly below the waveform on the far right),
consisting of a numeric box and a pitch box (showing 428 C-2); and to
change the playing pitch from C-2 to C-3, hold down the left mouse
button on the C-2 and press the I key. Release the mouse button

h) Now to play the marked range at the playing pitch (C-3), find the Play
button (on the left of the third row of gadgets below the waveform). You
should hear the word "bed"

i) Now mark a range over the fifth waveform part ("banese") by dragging the
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mouse, and click Play again

j) Try marking ranges over other parts of the waveform, and then playing
them at different playing pitches (by changing the pitch box to a
different pitch - see step g above - and then clicking Play)

1.57 Moving and deleting

In this part we’ll rearrange and delete sections of waveform so that the
sample becomes "Goats for bed". This is how we’ll do it:

"Time -- for -- bed -- for Leb -- banese -- goa -- ts"
| | | | | |

delete +----delete-----+ move to start of sample

Firstly we’ll remove the word "time" (the first waveform part).

a) Mark a range from the start of the second waveform part ("for") to the
very end of the complete waveform (by dragging the mouse to the very
right of the screen)

b) Now to mark the start of the range more accurately, first hold down a
Shift key and HOLD DOWN the left mouse button on a part of the waveform
not marked by a range (that is, the gray area to the left of the white
highlighted area)

c) Now still holding the left mouse button, drag the mouse slowly to the
left or right until the Range Start numeric box (above and to the right
of the waveform) shows 4829. Release the mouse button

==> Holding down Shift while dragging the mouse over the waveform
adjusts the marked range.

d) Play the range by clicking Play (left of third row of gadgets)

e) To delete the gray area not marked by a range (in this case, the word
"time"), select Edit menu -> Chop (on the title bar)

==> Notice that the sample editor’s set of menus are different from the
main screen’s menus.

f) Play the sample using the keyboard to confirm that "time"’s been removed

Next we’ll remove "for Lebanese" (the third and fourth waveform parts).

g) Mark a range from the start of the third waveform part to the end of the
fourth waveform part

h) To adjust the range’s start: hold down Shift, hold down the left mouse
button on anywhere to the left of the range, then drag the mouse left or
right until Range Start (above the waveform) displays 6751
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i) To adjust the range’s end: hold Shift, hold down the left mouse button
on anywhere to the right of the range, then drag the mouse until Range
End displays 18909

j) Play this range by clicking Play (third row of gadgets)

k) Now to clear this range (just as a demonstration), click Clear (middle
of third row of gadgets)

l) Play the whole sample using the keyboard (the I key is best)

==> Notice the "gap" in the playing when the range is reached. Clearing
a range produces a silent part of the sample, i.e. of zero volume

m) Now to remove (or erase) the range, click Erase (to the left of Clear)

n) Again play the whole sample using the keyboard ("for bed goats")

Finally, we’ll move the third and fourth waveform parts ("goats") to the
start of the sample.

o) By coincidence, the start of the range is already where we want it (at
the beginning of the third waveform part); so to extend the range to the
very end of the waveform: hold down Shift, then drag the mouse over the
waveform to the very right of the screen

p) Play this range (Play button). You should hear the word "goats"

q) Now to transfer the range to the sample editor’s copy buffer and then
erase the range, click Cut (to the right of Play)

r) Play the whole sample using the keyboard (only "for bed" should be left)

s) Now to set both Range Start and Range End to zero: activate (click
inside) the Range Start box, clear it by pressing Ctrl-X, set it to zero
AND move to the next box by pressing Tab, then set this Range End box to
zero by pressing Ctrl-X then Return

==> You can set most numeric boxes to zero by clearing them and pressing
Return, Tab (to move to the next box) or Shift-Tab (to move to the
previous box).

t) Finally in this section, insert the contents of the copy buffer (see
steps p and q above ) starting at the Range Start position
(i.e. zero, the start of the sample) by clicking Paste (right of third
row of gadgets)

u) Play the sample using the keyboard. It should now be "Goats for bed"

1.58 Magnify scrolling waveform

==> As a result of clicking Paste in step t of last section, the waveform
display now shows only part of the sample instead of the whole sample:
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in fact, the first 6751 bytes.

The number to the right of Display (far top left of window) shows how many
bytes are currently being shown in the waveform display (now 6751). When
the whole sample is being shown, the Display number is equal to Buffsize.

a) Find the scroll bar (long black rectangle below the waveform display),
and notice that it’s at the very left of the screen and is a little less
than half the screen width long

==> The size and position of the scroll bar compared to the screen width
relates to the size and position of the displayed sample part compared
to the whole sample. (Try reading that again!)

So in this case, the displayed sample part is at the very start of the
sample and is a little less than half the sample length.

b) To scroll the waveform right (so that the displayed sample part moves
closer to the end of the sample), slowly drag the scroll bar to the very
right of the screen, watching what happens in the waveform display

c) Play this new displayed sample part by clicking Play Display (first row
of gadgets below waveform, on the left). You should hear "for bed"

d) Now to double the waveform magnification, click Zoom In (right of Play
Display). Notice that the Display value (top left) has halved (now 3375)

e) Play this new display (Play Display), then press the <left> key to move
the scroll bar one place to the left, and click Zoom Out (below Zoom In)
to halve the waveform magnification (note the new Display value)

f) Again play this new display, then by using Zoom In, Zoom Out, Play
Display, the <left> and <right> keys and by dragging the scroll bar,
move to other places in the sample at different magnifications and play
them. (You might also like to try changing the playing pitch.
but return the pitch to C-3 after you’ve changed it)

g) When you’ve had enough, click Show All (below Play Display) to display
the whole sample again

1.59 Reverse

Apart from the final section, the rest of this tutorial will take you
through some of the effects that you can add to samples using the editor.

Firstly, we’ll turn the entire sample backwards!

a) To easily mark a range over the currently displayed sample part (which
for us is the whole sample), click Range Display (slightly below center)

b) Now click Reverse to turn the range backwards (far right of third row of
gadgets)

c) Play this reversed sample using the keyboard
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"Shneh boot swerg", eh? Hopefully this doesn’t mean anything to you, or
I’ll be in trouble!...

d) Since the whole sample is still marked as a range, simply click Reverse
again to put the sample back to normal (play it to confirm this)

============================> HALF-WAY MARK! <===========================

[ To stop: do steps a - i of the Renaming and saving a sample to disk

To restart: insert your tutorial disk in any drive, select Instr menu
-> Load Instrument(s), and in the requester click Disks,
the name of your disk, Samples, and double-click Goats For
Bed (echo). Finally, click Edit Sample (upper screen,
second row) ]

1.60 Change volume

Firstly in this part we’ll change the volume of the sample so that it fades
in towards the middle then fades out towards the end. These changes won’t
be permanent; so we’ll also look at a way to store a copy of the whole
sample in memory, which will be retrieved later.

a) So to store a copy of the whole sample in the copy buffer, click >Buffer
(middle of second row of gadgets)

b) Mark a range from roughly half-way through the sample - you need not be
accurate - to the very end of the sample (by dragging to the very right)

c) Now open the Change Volume window by selecting Effects menu -> Change
Volume, and in this window click Fade Out (near the bottom)

==> The Start and End sliders in the Change Volume window represent
percentages of the existing range volume. When you clicked Fade Out,
they changed to 100% and 0% respectively, meaning the marked range
now gradually changes from 100% of its volume to 0% (that is, fades
out).

d) Play the sample using the keyboard, and notice the fading out

e) Now in the main Sample Editor window: activate (click inside) the Range
End numeric box (top right), clear its contents using Ctrl-X, then type
in the same number as is currently in the Range Start box and press
Shift-Tab (to activate the previous box, Range Start)

f) Set Range Start to zero by pressing Ctrl-X followed by Return, then in
the Change Volume window click Fade In

==> This time the Start and End sliders are set to 0% and 100%, so the
volume fades in from no volume (0%) at the range’s start to normal
volume (100%) at the range’s end
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g) Play the sample using the keyboard, and notice the new fading in

==> We’ll now restore the sample to what it was before we changed
its volume, which involves transferring the copy buffer’s contents to
the sample (see step a above). The button that does this is labeled
Sample<, but it is currently obscured by the Change Volume window.

h) So to shrink the window so that only its title bar can be seen, click on
the Change Volume window’s zoom gadget (far top right of window, the
leftmost of the two small square gadgets)

i) Now in the Sample Editor window, click on Sample< (just below the
shrunken Change Volume window) to restore the sample

j) Play the sample to confirm the restoration (i.e. no fading in or out)

Next we’ll examine the Change Volume window’s Halve and Double gadgets,
learning how to magnify a range in the process, and also recognize a
problem with volume changing known as distortion.

==> We’ll firstly mark a range accurately by typing the starting and ending
bytes directly into the Range Start and Range End numeric boxes.

k) In Range Start (top middle): click on the 0 (zero), press the Del key to
delete the zero then type 11348 and press Tab to activate Range End...

==> Whoops! A bug!! Range End isn’t activated! Well, OctaMED did in fact
activate it, but then also entered the number 11348 into it, causing
the de-activation. I’m afraid this bug occurs more than once...

l) So to activate Range End by hand: click on the 3 in the Range End box,
press Ctrl-K to delete the numbers to the cursor’s right (i.e. 348),
then type 912 and press Return

m) Now to magnify this range so that it fills the whole waveform display,
click Show (bottom left of window)

==> The display now shows part of the word "bed". Notice that the scroll
bar (black rectangle below waveform) has changed size and position,
and the Display value (far top left) has changed to 565 bytes.

n) Change the Pitch value to C-1 (hold down the left mouse button on the
C-3 in the pitch box - far right - and press Z), then click Play Display
a few times to get an idea of the current volume of the display (our
next step is to halve this volume)

o) Now click Range Display (roughly in the center), unshrink the Change
Volume window using its zoom gadget (the second gadget from the right),
and in the Change Volume window click Halve

==> Notice the height of the waveform reduce by half, moving the tops
and bottoms (or peaks) of the waveform closer to the white center
line (which is actually gray at the moment!).

p) Use Play Display (on the left) to confirm the halved volume
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q) Now, since the required range is already marked, click Double in the
Change Volume window to restore the range to its original volume, and
again use Play Display to confirm the altered volume

r) What happens if we try to double the volume again? Watching the waveform
display carefully, click Double (in Change Volume) again

==> Notice that the waveform peaks (tops and bottoms) are cut at the
very tops and bottoms of the display: they are replaced by short
horizontal lines. The maximum volume limits have been exceeded, and
this leads to an "effect" called distortion.

s) To hear this "effect", click Play Display a few times

==> Because of the rather ugly sound distortion causes, it is best to
avoid it if at all possible!

Finally in this section, we’ll restore the sample to its original state
(so getting rid of the distortion), then increase the whole sample’s volume
by a quarter (25%).

t) To restore the sample (see steps a and i of this section), shrink the
Change Volume window by clicking its zoom gadget (top right of window),
then click Sample< (just below the shrunken Change Volume window). Play
the sample to confirm the restoration

u) Now range the whole sample by clicking Range Display, then unshrink the
Change Volume window (using its zoom gadget) and notice that both the
Start and End sliders are currently at 200%

==> When the Start and End values are the same, the range’s volume is
changed by a constant amount rather than increasing or decreasing
(in this case by 200%, double the existing volume). So to increase
the volume by a quarter (25%), we need to set both the Start and End
values to 125% (to decrease by a quarter we would use 75%).

v) So to change the Start slider’s value to 125%, drag the slider’s black
knob to the left until the value reaches 124%, then click inside the
slider box anywhere to the right of the knob to increase to 125%

w) Do the same with the End slider, then to change the volume and close the
window in one go, click the CHANGE VOLUME button with a Shift key held

==> Shift-clicking any action button in any sample editor effects window
performs its function then closes the window.

x) Finally, play the sample to hear the slight increase in volume

1.61 Echo

In this part we’re going to echo the word "bed", so that the sample becomes
"Goats for bed ... bed ... bed ... bed (etc.)" (slowly fading away).
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a) Firstly, store a copy of the whole sample in the copy buffer by clicking
>Buffer (slightly below center); we’ll need it for later

==> In order to echo, we need to add some extra space to the end of the
sample; this extra space will contain the echoed "bed"s.

b) So to increase the total sample size to, say, 70000 bytes, activate the
Buffsize numeric box (above the waveform), press Ctrl-X to clear it,
then type 70000 and press Return

c) In answer to the question "Retain existing sample?", click Retain

==> Clicking Clear in the requester would have cleared the entire 70000
bytes, rather than keeping the existing sample.

d) Play the sample using the keyboard, and notice that the original sample
is still there but some extra space now follows it (which, of course, is
silent)

e) Now to range the word "bed" accurately, change Range Start to 11042 and
Range End to 15109 (click inside numeric box, clear its contents using
Ctrl-X, then type the value and press Return)

f) Change the playing pitch back to C-3 (hold down the left mouse button on
the C-1 - far right - and press I), then play the range using the Play
button (bottom left). You should hear "bed"

g) Open the Echo window by selecting Effects menu -> Echo

==> Time for some maths. Think about what will happen in the echo. The
first part of the sample ("Goats for bed") will play, then there’ll be
a period of silence, then "bed" will play, then another silent period,
then "bed" will play again, then another silent part, and so on...

The Echo Rate is the total number of bytes between each echo. In other
words, it’s the length of "bed" added to the length of the silent part.

L1 L2
+-+ +-------+
| | | |

"Goats for bed (silence) bed (silence) bed (silence)"
| |
+------------+

Echo Rate (L1 + L2)

==> So referring to the current Range Start and Range End values, the
length of "bed" is 15109 - 11042 + 1 = about 4000 bytes. Let’s try 6000
bytes of silence to begin with. So Echo Rate is 4000 + 6000 = 10000.

h) So in the Echo window, to change the Echo Rate numeric box to 10000:
click on the number 4, press Del, then type 100 and press Shift-Tab to
activate Number of Echoes

i) Let’s have five echoed "bed"s. Press Del, type 5 and press Return

==> The Volume Decrease box sets how quickly the echoes will fade away,
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but if set to zero (like now) the echoes fade evenly throughout the
marked range. We’ll leave it at zero.

j) One more thing to do before we echo: extend the range to include all the
extra space as well as the word "bed". So hold down a Shift key, hold
down the left mouse button anywhere to the range’s right, then drag the
mouse to the very end of the sample (i.e. the very right of the screen).
(Range End should now be 69999)

k) Now we can echo. In the Echo window, click Do Echo (bottom left), and
prepare to wait a short while if you have a 68000 processor (on my
standard A500 it takes 24 seconds...)

l) Play the sample using the keyboard

It’s quite a slow echo, don’t you think? Let’s start again, but this time
we’ll echo with a slightly reduced echo rate to speed it up.

==> Firstly, we need to restore the original sample
using the Sample< button. It’s currently obscured by the Echo window,
so we’ll shrink it... but not by clicking its zoom gadget!...

m) Shrink the Echo window by simply pressing the right mouse button

==> If a window doesn’t have a set of menus attached to it (like the
Sample Editor window has), clicking the right mouse button shrinks
and unshrinks the window as an alternative to the zoom gadget.

n) Now click Sample< (middle of screen) to restore the original sample,
play the sample to confirm the restoration, then change Buffsize to
70000 (activate, clear using Ctrl-X, type 70000, Return). Click Retain
in the requester that appears

o) To easily mark a range from byte 11042 to the end: click Range Display,
then type 11042 into Range Start (activate, Ctrl-X, type, Return). Play
the range to confirm that it’s "bed" + the extra space

p) Now to unshrink the Echo window, click on the word Echo on its title bar
to activate the window (it turns blue), and press the right mouse button

==> This requires two clicks (one of the left button, one of the right),
whereas clicking the zoom gadget requires only one click. So for
unshrinking windows, the right mouse button usually isn’t quite as
convenient as the zoom gadget (unless the window is already active).

==> Earlier we found that the length of "bed" was 4000 bytes. We added 6000
bytes of silence to produce an echo rate of 10000. So to speed the echo
up, let’s instead add 2000 bytes of silence to produce a rate of 6000.

q) To change the echo rate to 6000: in the Echo Rate numeric box, click on
the 1, press Del twice, then type 6 and press Return (remember always to
press Return, Tab or Shift-Tab after altering a text or numeric box)

r) Now to perform the echo and close the Echo window in one go, shift-click
Do Echo (click with Shift held). This one takes my Amiga 33 seconds...
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s) Play the sample using the keyboard

And finally, notice that there is a lot of extra space after the final
echo. We could range the extra space and click Erase to remove it, but
OctaMED provides an easier way that’s new to version 5...

t) Select Edit menu -> Remove Unused Space (near the bottom of the menu),
and notice that the sample size is now significantly less (44816 bytes)

==> This handy function removes any extra space both before and after
the sample, thus saving memory.

u) Finally, play the sample again

1.62 Filter and Boost

This final effect (or pair of effects) that we’ll look at makes a marked
range sound more muffled (filtered) or brighter (boosted). We won’t keep
the changes that the effects make; we’ll just hear what they do.

a) Once again, we’ll start by storing a copy of the whole sample in the
copy buffer: click >Buffer (slightly below center)

b) Now range the whole display using Range Display, then open the
Filter/Boost window by selecting Effects menu -> Filter/Boost

==> In this window, the Averaging slider controls the strength of the
filter or boost. The Distance slider affects the sound in a peculiar
way, and we’ll try it later...

c) Increase the strength from 16 to 40 by dragging the Averaging slider,
then click Filter (bottom left)

d) When the operation’s finished, play the sample using the I key, then
activate the Sample Editor window by clicking on its title bar, and play
the old unfiltered sample which is currently in the copy buffer by
selecting Edit menu ->
Play Buffer Contents. Play the sample again using the I key

==> When used together with >Buffer (as in step a), Play Buffer Contents
is useful for comparing the results of an effect with the original
sample (as we’ve just discovered).

e) Now shrink the Filter/Boost window using its zoom gadget, drag the
shrunken window to the right so that the Sample< button is no longer
obscured, then click Sample< to restore the unfiltered sample (play to
confirm)

Let’s try altering the Distance slider.

f) Click Range Display, unshrink the Filter/Boost window by clicking its
zoom gadget, then drag the Distance slider up to maximum (128) and click
Filter again
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g) Again compare the filtered sample with the original sample by activating
the Sample Editor window (title bar) and using the I key and Play Buffer
Contents (Edit menu)... odd!

We’ll now have a go at boosting the sample.

h) Shrink the Filter/Boost window (zoom gadget), click Sample< and
Range Display, then unshrink the window (zoom gadget)

i) Drag the Distance slider back down to 1, and the Averaging slider down
to 16, then shift-click Boost

==> Again, the window closes because the action button was shift-clicked

j) Now compare the boosted sample with the original sample (I,
Play Buffer Contents)

==> Boosting seems to introduce "hiss" when used with this particular
sample, but boosting more muffled samples can make them sound
"brighter" and more audible.

k) Finally, restore the original sample again using Sample<, then find the
chip memory status display (below the Sample Editor window, on the left
beside the word Chip:)

l) Watching this Chip display carefully, select Edit menu -> Discard Copy
Buffer. The display should increase by just under 50,000 bytes

==> The chip memory status display shows how much chip memory is free
(all samples are stored in chip memory), and Discard Copy Buffer
removed the copy buffer’s contents from memory, freeing about 50,000
bytes. This function is important if you’re low on memory.

m) Play the final sample using the keyboard

1.63 Renaming saving a sample

Before we save the sample on your tutorial disk, and then add the ←↩
sample to

the sample list, we’ll rename the sample to Goats For Bed (echo).

If you stopped at the half-way mark, close the Sample Editor window, select
Instr menu -> Save Instrument -> Raw Format, and carry on from step d
(IGNORE STEP h since no requester should appear!).

a) Close the Sample Editor window (close gadget or Project menu -> Exit
Sample Editor), then open the Instrument Parameters window by clicking
Inst Params (upper screen, middle of second row)

b) Activate the Name text box (top of window), clear it using Ctrl-X, then
type Goats For Bed (echo) and press Return
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==> Notice that the instrument name text box (upper screen) has changed
to the new name you’ve just entered

c) Close Instrument Parameters (close gadget or Exit), then select Instr
menu -> Save Instrument -> Raw Format. A file requester appears

==> Samples can be saved in one of two different formats: IFF 8SVX or
raw. The difference is that IFF files also contain sample loop
information .
Since our sample has no loop, we’ll save it in the raw format
to save a little disk space.

d) If a "Please insert volume xxx" requester appears, click Cancel in this
requester and in the "Directory Not Found" requester that follows it

e) Insert your tutorial disk in any disk drive

f) Click on *Disks* ( at bottom ), and then on the name of your disk.

g) Create a new drawer for samples by pressing Tab and then shift <right>,
now type Samples then press Return

h) In the requester that appears, click on the OK button

i) The required filename (Goats For Bed (echo)) is already in the File text
box, so simply click OK (bottom left) to save the sample. If you stopped
at the half-way mark, click OK in the "Overwrite?" requester

Now we’ll add the new Samples drawer on this disk to the sample list.

j) To open the Sample List Editor, pick Display menu -> Sample List Editor

k) Click Add Dir (slightly below and to the right of center), and again if
a "Please insert volume xxx" requester appears, click Cancel in it

l) Now select the disk and drawer name by clicking Disks, the name of your
tutorial disk and the Samples drawer; then click the OK button

==> Remember that since this is a drawer requester, no filenames appear.

m) In answer to the requester, click End Of The List, and notice the new
drawer and its contents appearing in the sample list

Finally, we’ll save the altered sample list.

n) Put the OctaMED boot disk in any drive if necessary

o) Click Save List (near the middle on the far right), and in the file
requester click the OK button

p) When saving is complete, close the Sample List Editor window

* later versions read volume *

==> Checklist 5 - can you: <==
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(1) Understand how different pitches are created ?
(2) Change the playing pitch (using the pitch box) ?
(3) Mark and adjust a range, either by dragging or by using the Range

Start and Range End numeric boxes ?
(4) Add extra space using the Buffsize numeric box ?
(5) Remove extra space from either side of the waveform (Remove Unused

Space) ?
(6) Use these range functions: Play, Clear, Erase, Range Display,

Edit menu -> Chop ?
(7) Use these magnification and scrolling functions: Zoom In, Zoom Out,

the Display status box, Show All, Show range, Play Display, the scroll
bar, the <left> and <right> keys ?

(8) Use these copy buffer functions: Cut range, Paste range, >Buffer,
Sample<, Play Buffer Contents, Discard Copy Buffer ?

(9) Use these effects: Reverse, Change Volume (all action buttons, the
Start and End sliders, recognizing distortion), Echo (all gadgets),
Filter/Boost (all gadgets), and shift-click effects’ action buttons ?

Other functions

(10) Load an instrument by typing its name into the inst name text box ?
(11) Shrink and unshrink a window using its zoom gadget or the right

mouse button ?
(12) Activate a window by clicking its title bar, and recognize an active

window (its border is blue) ?
(13) Use these keys in a numeric or text box: Return, Tab, Shift-Tab, Del,

Ctrl-X, Ctrl-X + Return (in some numeric boxes to set them to zero) ?
(14) Locate the chip memory status display ?
(15) Rename an instrument ?
(16) Save a sample to disk ?

Phew, that’s a long checklist! We’ve managed to cover most of the sample
editor’s features, although we have left a few notable functions - looping,
digitizing, mixing, chord creation - for later on.

When you’ve had time to compose yourself, perhaps you’d like to run through
the tutorial again, or alternatively carry on to Tutorial 6. See you later!

TUTORIAL SIX

1.64 TUTORIAL 6

This tutorial will cover:

Changing number of tracks in block

Chord entering mode

The programmable keys

Limitation 1: Volume
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Limitation 2: Sound quality

Minor tidy-ups and saving

Setting up for tutorial 7

TUTORIAL SEVEN
When composing using OctaMED, you may find that the Amiga’s ←↩

ability to play
a maximum of four samples at once (using its four sound channels) is a
little limiting. Luckily, OctaMED allows you to add up to four extra
tracks, extending the maximum number of simultaneous samples to five, six,
seven or eight; and this feature is called 5 - 8-channel mode.

Since the Amiga only really has four channels, and due to the heavy load
put on the computer’s processor, there are a few limitations to this mode,
most noticeably a slight loss in sound quality; but the limitations are
usually more than made up for by the extra tracks available.

So this tutorial will guide you through working with this mode and how best
to overcome some of its limitations, and will also introduce other
functions such as chord-entering mode and the programmable keys.

Load that song again!

Yes, I’m afraid we’re going to continue adding bits to our old friend...

a) So insert your tutorial disk in any drive, and pick Project menu -> Open

b) Cancel the Please insert volume requester if it appears, then in the
file requester click on Disks and on the name of your disk

c) Now click on the Songs drawer and double-click Song1-Tut4 (insert the
OctaMED_Samples disk if asked)

d) Play once through the song when it’s loaded (Play Song)

1.65 Changing number of tracks in block

a) Select block 010 (Shift-<up>) and play it once (Play Block, STOP)

OK. The practical side to this tutorial is altering blocks 010 and 011:
we’ll delete the "chorus" backing in track 1 and replace it with a piano
backing.

This piano backing will consist of chords spreading over 3 tracks, instead
of the single track taken up by the chorus backing. So, remembering that
track 1 will be free when we delete the chorus backing, we need to add an
extra 2 tracks to the block to bring the total to 6.

b) Firstly, we’ll delete the chorus backing in track 1 of block 010: move
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the cursor to track 1 (Alt-<right>) and select Track menu -> Cut (then
play the block through if you wish)

c) Now open Block Properties by choosing Block menu -> Set Properties (or
by pressing Amiga-B, its menu shortcut), and in the window drag the
Tracks slider slightly to the right so that its value becomes 6

d) Close the window (close gadget or Exit button), and move to the top of
the block if necessary (the F6 key)

==> A couple of things have happened in the Tracker editor. Firstly, two
new tracks (4 and 5) have been added to bring the total to 6 (note the
white number 6 at the far top left of the Tracker editor).

Secondly, the width of the letters and numbers has halved to allow a
maximum of 8 tracks to be displayed at the same time (notice the empty
tracks 6 and 7 at the far right, bringing the total to 8 tracks).

Although it’s certainly useful to have all six tracks displayed at once, it
does make them a bit harder to read (especially on a TV!), so let’s look at
a way to change the maximum number of displayed tracks.

e) Keeping the right mouse button held, move to Settings menu ->
Display Max Tracks and notice that 16 is checked (or "ticked") in the
sub-menu that appears. Release the mouse button

==> This means that a maximum of 16 tracks can currently be displayed at
the same time (although this figure is useful only for MIDI work).

f) So change the maximum number of displayed tracks to 4 by selecting
Settings menu -> Display Max Tracks -> 4

==> Back on home territory now. But although we can’t see the two extra
tracks, the white number 6 at the top left shows that they exist...

g) To reveal the extra tracks, press Alt-<right> six times, pausing between
each press to see what’s happened to the display (and especially to the
white track numbers)

==> So the display scrolled to the left to reveal the extra tracks, and
"wrapped around" to show track 0 when the last track was reached.

h) The exact opposite happens when pressing Alt-<left>... try it!

i) If you’re happier with this larger text size, by all means keep it. If
you prefer the smaller size, however, select Settings menu ->
Display Max Tracks -> 8 or 16 (it doesn’t matter which)

1.66 Chord entering mode

In this section, we’ll insert a new block in which we’ll practice entering
some chords.

a) To insert a new block before the current block (010), choose Block menu
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-> New -> Insert

b) To understand exactly what’s happened, open the Block List (B button,
upper screen, middle of fourth row) and notice the position of the white
bar

==> So there’s now an empty block between blocks 009 and 011. Notice
that this new empty block also has 6 tracks; this is because
inserted and appended blocks copy the size (lines and tracks) of the
current block.

The current block in step a above (010) had 6 tracks of 64 lines, so
a block of this size was inserted.

c) Close the Block List, then turn editing on (Edit check box or Esc key)
and also turn chord-entering mode on by clicking the Chord check box
(to the right of the Edit check box)

d) Move to line 000 track 0 if necessary, then select instrument 05 -
Tuned Piano (using Shift-<right>)

e) Now to enter an A major chord (A-2 C#3 E-3), hold down the following
keys together: Y 9 P. Release the keys

==> The notes might not be entered in the order A-2 C#3 E-3, but it
shouldn’t matter

f) Move to line 004 (<down>), then enter a A-2 D-3 F#3 chord by holding
down these keys together: Y O =. Release the keys

g) You should now understand how the chord-entering mode works, so enter
the following chords on their respective lines:

Line | Notes of chord | Keys to press together
--------+----------------+------------------------

> 008 | A-2 E-3 G-3 | Y P ]
> 012 | A-2 D-3 F#3 | Y O =
> 015 | A-2 C#3 E-3 | Y 9 P

h) Play the block through a couple of times, and listen carefully to the
end of the last chord in the block

==> Notice that the last chord’s notes don’t come off together, but are
slightly staggered. This is because OctaMED produces different
pitches by playing samples at different speeds, so the E-3 on line
number 015 finishes first and the A-3 finishes last

Now that you’ve got the hang of chord-entering mode, we’ve got no further
use for this block, so let’s delete it!

i) Open the Block List (B button in fourth row) and click Delete to delete
the current block (highlighted by the white bar), then close the window

The Select track mode, selecting 6-channel mode and changing the tempo

a) Notice that tracks 1, 4 and 5 are empty in this block (use Alt-<right>
if you chose Display Max Tracks ->
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We’ll enter our piano chords in these tracks using chord-entering mode.

==> However, there is a slight problem in that tracks 1, 4 and 5 aren’t
directly beside each other. So let’s look at a way to select the tracks
that chord-entering mode affects.

b) Find the track mode cycle gadget (displaying On/Off, upper screen,
middle of bottom row) and click on it to change it to Select

==> When this cycle gadget shows On/Off, the row of small blue gadgets
(upper screen, bottom row) choose which tracks are played. When it
shows Select (as it does now), the row of blue gadgets select tracks
for certain functions - such as chord-entering mode.

c) So to select tracks 1, 4 and 5: click Clr (upper screen, far bottom
right) to turn all the track selection gadgets off, then click track
selection gadgets 1, 4 and 5

d) Now to enter chord G#2 C#3 E-3 on line 000: move to line 000 track 1
(F6, Alt-<right>), then hold down the 6, 9 and P keys together. Release
the keys

==> The notes were correctly entered on tracks 1, 4 and 5, but only one
note out of the three sounded! It was in fact the note on track 1. To
hear the notes on the two "extra" tracks (4 and 5), we need to change
from 4-channel to 6-channel mode.

Changing to 5, 6, 7 or 8-channel mode (i.e. 5 - 8-channel mode), as we’re
about to do, is what this tutorial is all about. Unfortunately, it is
normally physically impossible for the Amiga to play more than four samples
at once, so you’ll notice some side effects pretty quickly...

e) Find the song status display (showing 4Ch, upper screen, left of second
row)
==> The 4Ch means that the song is currently in 4-channel mode

f) Open the Song Options window by choosing Song menu -> Set Options

g) On the left of this window, click on the small button to the left
of 6 Channels, and in answer to Shall I halve the samples?, click Halve

h) Move the window down a little (by dragging its title bar), and notice
that the song status display (upper screen, second row) now shows 6Ch

i) Close the window then play the block through once, and stop the playing

==> Immediately, two things are apparent (apart from the equalizers
being turned off!):

* (1)The volume has reduced. In fact, each sample’s volume has halved
as a result of clicking Halve in the requester (step g above).
(You’ll probably need to turn the volume up on your
TV/monitor/amplifier!)

j) To prove that each sample’s volume has halved: open the Sample Editor
window by clicking Edit Sample (upper screen, second row), and examine
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each sample’s waveform using Shift-<left> and Shift-<right>

Notice that the samples’ volume never goes above half volume

* (2) The tempo (song speed) has reduced. This is due to the slightly
different method of setting the tempo in 5 - 8-channel mode.

k) Close the Sample Editor, click Play Block, then try dragging the primary
tempo slider (upper screen, the longer of the two sliders in the third
row) slowly to the far right. Has the tempo increased?

l) Now try dragging the primary tempo slider to the far left so that its
value becomes 001. Has the tempo increased now? Stop the playing (STOP)

==> In 5 - 8-channel mode (remember that 5 - 8 means 5, 6, 7 or 8), only
values from 001 to 010 can be used with the primary tempo slider.
Value 001 gives the quickest speed, value 010 the slowest.
Values 011 - 240 give the same speed as 010.

So only ten song speeds are possible in 5 - 8-channel mode? Not quite. The
answer lies in the secondary tempo slider, which we’ve ignored until now...

m) Without the block playing, try dragging the secondary tempo slider (very
right of third row) very slowly to the far right, and notice if anything
unusual happens to the slider’s value (it should reach 20)

==> Did you notice the A B C D E F ? Yes, the slider’s value is given in
hexadecimal, just like player commands (remember from Tutorial 4 ?
If you need a memory refresh on hexadecimal, So its
value has a range of 1 - 20 hexadecimal ( = 1 - 32 decimal).

n) Now click Play Block, and slowly drag the secondary tempo up to 05. Stop
the block playing

==> So dragging to the left means an increase in speed, the opposite
to the primary tempo in 4-channel mode (but the same as the primary
tempo in 5 - 8-channel mode... quite confusing, isn’t it?)

==> To summarize the primary and secondary tempo values:

+-----------------------+-----------------+
| Primary tempo | Secondary tempo |
+----------+------------+-----------------+
| 4-chan | 5 - 8-chan | Both chan modes |

+--------------------------+----------+------------+-----------------+
| Value range | 11 - 240 | 1 - 10 | 1 - 20 |
| Value in decimal or hex? | decimal | decimal | hexadecimal |
| Dragging to right means: | faster | slower | slower |
+--------------------------+----------+------------+-----------------+

o) Perhaps the tempo is a little fast now, so drag the primary tempo very
slightly to the right until its value becomes 005. Now play the block

Adding the rest of the chords
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Now that we’re in 6-channel mode and the tempo is at a good value, let’s
add the rest of the piano chords to block 010.

a) First: stop the block if it’s playing, make sure the cursor’s in track 1
(Alt-<left>/<right>), and select instrument 05 (Shift-<left>/<right>)

b) Since all the chords we’ll enter will be on even-numbered lines, turn
space mode on (Space box or ~ key) to make entering a little easier

c) Now enter these chords on their respective lines:

Notes of chord | Keys to press together | Line numbers
----------------+------------------------+---------------------

> G#2 C#3 E-3 | 6 9 P | 004 010
> A-2 C#3 E-3 | Y 9 P | 014 020 026
> A-2 D-3 F#3 | Y O = | 030 036 042 046 052
> G#2 D-3 F#3 | 6 O = | 056
> G#2 D-3 F-3 | 6 O [ | 060

d) Play and stop the block, listening especially to the volume of the piano
chords compared with the other instruments

1.67 The programmable keys

Do you think the piano chords are a bit loud? They seem to especially drown
out the guitar melody in track 3. So let’s halve the volume of all the
piano notes using the set volume player command.

==> Memory refresh from Tutorial 4: player command type 0C sets the volume
of a note. Its command level can be 00 (no volume) - 64 (full volume)
in decimal; so command level 32 sets the volume to half.

So we’ll begin adding command 0C32 to the piano notes.

a) Firstly, turn both space and chord modes off (upper screen, bottom left)

b) To make entering player commands easier, open the Keyboard Options
window (Settings menu -> Keyboard Options), then find the Advance Cursor
radio button (top right of window) and click on the small button next
to Right

c) Close the window, then move to line 000 track 1

d) Now add command 0C32 to this first piano note by pressing <right> three
times, C, 3 and 2

e) Move to track 4, then add 0C32 to this note

f) Finally on this line, add command 0C32 to the note on track 5

g) Now move down to the next piano chord (on line 004), and in the same way
as the previous three steps, add command 0C32 to tracks 1, 4 and 5
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This method of adding player commands is perhaps a little time-consuming,
so let’s look at another method.

h) To open Programmable Keys, select Settings menu -> Programmable Keys

==> Using the programmable keys you can enter notes or player commands (or
both) with a single keypress. There are ten different programmable
keys (0 - 9), and the Programmable Keys window is used to define which
notes or player commands each programmable key enters.

(From now on, programmable keys will be referred to as "progkeys").

So to make entering command 0C32 easier, we’ll now assign that command to
progkey number 7.

i) To select progkey number 7, find the progkey slider (top right of
window), currently showing 1, and slide it to 7

==> We could just as easily assign the command to progkey number 1, but
we won’t!

j) Find the progkey definition box (under the slider, showing --- 00000)

==> This box displays the definition of the current progkey (in our
case, progkey 7). At the moment, the note and the command digits are
all blank.

k) To change the definition to --- 00C32: in the definition box, hold down
the left mouse button on the third 0 (zero), press the C key, and KEEP
THE MOUSE BUTTON HELD DOWN

l) Move the mouse to the next digit (always keeping the mouse button held),
and press the 3 key

m) Still holding the mouse button, move to the final digit and press the 2
key. Now release the mouse button

==> (It isn’t necessary to hold the mouse button throughout - you could
release the button after every change to the definition - but it
perhaps requires less effort to hold?...)

Now we’ll enter our progkey number 7 on the next piano note, thus adding
command 0C32 to the note.

n) Firstly, move the Programmable Keys window to the very top of the screen
by dragging its title bar (to make sure we can all see what will happen)

o) Next, activate the main screen by clicking anywhere in the main screen
that won’t perform an action (a good place is anywhere in the lower
screen). You’ll see the window’s title bar change from blue to gray

p) Now move to line 010 track 1 (<down> and Alt-<left>/<right>), and
remember which note the cursor is now over (it will be G#2, C#3 or E-3.
You may wish to write this down somewhere!)

q) Now to enter progkey 7, press Shift-7
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==> You enter a progkey by holding Shift and pressing the progkey’s
number

==> Look at what happened to line 010 track 1. The 0C32 command was
correctly entered, but the note and instrument number (perhaps G#2 5)
was changed to --- 0! This is because progkey 7’s definition
(--- 00C32) actually tells OctaMED to change the note and instrument
number to --- 0. So OctaMED was just doing what it’s told.

What we need to do is alter the definition so that the note and
instrument number is ignored. This is called transparency.

r) To make the note transparent: in the Programmable Keys window, hold down
the left mouse button on the --- in the definition box, and press Return

==> The note changes to xxx, indicating that it’s transparent.

s) To make the instrument digit transparent: keeping the mouse button held,
move to the instrument digit (the leftmost 0) and press Return again

==> The definition should now be xxx x0C32.

Now when progkey 7 is entered, command 0C32 will be inserted and the note
and instrument digit will be left alone.

t) Close the window, then since the note and instrument number on line 010
was deleted in step q, move up to line 010 and enter it again (using the
6 key for G#2, the 9 key for C#3, and P for E-3 - see step p in the
previous to jog your memory!)

u) Now for the big moment... move back up to line 010 and across to the
next piano note (on track 4), and press Shift-7 to insert our progkey

==> At last, the 0C32 command is inserted with just one keypress. In a
moment, we’ll make entering the command even easier...

v) Move to line 010 track 5, and insert another 0C32 (Shift-7)

w) Open the Keyboard Options window (Settings menu -> Keyboard Options)

==> Since we’ll be adding 0C32 commands to all the piano chords in the
block, it would be easier if the cursor automatically advanced to the
next track after entering each command.

x) To make this happen, find the Advance Track radio button (top middle of
window), and click on the small button next to Next Track

y) Close the window, move to the next piano note (line 014 track 1), and
insert 0C32 to the whole chord on line 014 (i.e. tracks 1, 4 and 5) with
Shift-7. Notice the cursor conveniently moving to the next track

z) To simplify entering even further, switch the caps lock on (on the
keyboard), then on line 020 insert 0C32 to tracks 1, 4 and 5 WITHOUT
HOLDING DOWN THE SHIFT KEY! Just press 7!
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==> With the caps lock on, programmable keys can be entered simply by
pressing their number.

A) Finally, insert 0C32 to the other piano chords, on these lines:

026, 030, 036, 042, 052, 056, 060

B) Play the block through... a better volume?

============================> HALF-WAY MARK! <===========================

[ To stop: do steps h and i of the final section
To restart: do the Load that song again! EXCEPT in

step c double-click Song1-Tut6, then on the bottom row of
the upper screen click on the On/Off gadget, shift-click
the track 1 gadget and click the 4 and 5 gadgets. Finally,
move to block 010, select instrument 05 and switch Edit
mode on

1.68 Limitation 1: Volume

a) Hang on... play the block through again, and again listen carefully to
the piano chords

==> Can you hear that the chords’ notes appear to be slightly staggered
(i.e. not quite played together) ?

We’ll switch the bass and guitar solo tracks (2 and 3) off to hear the
chords more clearly.

b) To switch the track selection gadgets from Select to On/Off mode, click
the cycle gadget showing Select (upper screen, middle of bottom row)

c) Now, keeping the block playing, click the track 2 and 3 gadgets (beside
the On/Off cycle gadget)

==> You should hear the "staggering" more clearly now.

d) Stop the block playing

==> This undesirable effect reveals one of the limitations of 5 - 8-channel
mode. It has to do with volume. Since the Amiga only really has
four channels, only four different volumes are available at the same
time.

So in blocks containing more than four tracks, these four available
volumes have to be shared out. OctaMED does this by making two tracks
share one volume.

How volumes are shared among tracks

+---------------+
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+---|-----------+ | (i.e. 0 and 4
| | | | 1 and 5

Track 0 1 2 3 4 5 6 7 2 and 6
| | | | 3 and 7)
+---|-----------+ |

+---------------+

So: on any given line, each track pair (0+4 1+5 2+6 3+7) must have the
same volume.

e) Using <up> and <down>, examine the track pair 1 and 5. Do tracks 1 and 5
have the same volume?

==> Yes. All the notes on both tracks 1 and 5 have a volume of 32 (due
to the 0C32 player commands). So it can’t be these two tracks that
are causing the "staggering" effect we heard earlier.

f) Now examine the track pair 0 and 4. Do tracks 0 and 4 have the same
volume?

==> No! All track 4’s notes have a volume of 32 (due to the 0C32
commands), but all track 0’s notes are played at the full volume of
64 (as there are no commands that change the volume on this track).

==> So how do we overcome this problem? The answer is to swap two of the
tracks around. But which ones?

Well, remember that each of the track pairs must have the same volume.
We can leave tracks 1 and 5 alone since they have the same volume
already, so we should look at the 0 and 4 track pair. Now, because all
of the remaining tracks (0, 2, 3, 4) have full volume EXCEPT track 4,
we’ll arrange the tracks so that track pair 0 and 4 has full volume.

To do this, we need to swap either track 2 or 3 with track 4. We’ll go for
track 2 with track 4.

g) To swap track 2 with track 4: firstly, move to anywhere in track 2, and
select Track menu -> Cut

h) Secondly, move to anywhere in track 4, and select Track -> Swap w/Buff

i) Thirdly, move back to track 2, and select Track menu -> Paste

==> So there are three steps to swapping two tracks: Cut, Swap w/Buff
(w/Buff means with buffer), and Paste. Swap w/Buff swaps the
contents of the copy buffer with those of the current track.

j) Switch all tracks on by clicking Set (upper screen, far bottom left),
then play the block. There should now be no piano chord "staggering"

==> To summarize the new track pair volumes in this block:

Track pair | Volume | Contents of tracks
------------+--------+------------------------------

0 and 4 | 64 | Drum beat (0), bass line (4)
1 and 5 | 32 | Piano notes
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==> Notice that there’s no mention of tracks 2 and 3. This is because
tracks 6 and 7 don’t exist in this block, so tracks 2 and 3 aren’t
actually paired.

This means that these two non-paired tracks have a special quality, which
we’ll now look at.

1.69 Limitation 2: Sound quality

a) To solo track 0 (i.e. make track 0 play on its own), click the track 0
gadget with Shift held (upper screen, bottom row)

b) Now play the block, and listen carefully to the sound quality of the
samples, especially the open hi-hat sample on lines 014 and 046. Stop
the block playing

==> Another limitation of 5 - 8-channel mode is the loss of sound quality.
The quality loss is especially pronounced in the "gritty"-sounding open
hi-hat sample in this track.

BUT: this sample quality loss only applies to paired tracks. Remember
we mentioned that tracks 2 and 3 aren’t paired?...

So let’s compare the difference in quality between paired and non-paired
tracks, by copying track 0 (paired) to track 3 (non-paired) and then
playing each track in turn.

c) Without the block playing, move to track 0 and select Track menu -> Copy

d) Now move to track 3 and select Track menu -> Swap w/Buff

==> Since we used Swap w/Buff instead of Paste in that last step, the
original contents of track 3 are now in the copy buffer. We’ll
restore the original contents later.

e) Listening carefully, play the block to hear track 0, then (keeping the
block playing) shift-click the track 3 gadget (upper screen, bottom row)
to solo it

f) Did you hear any difference in sound quality? Keeping Shift held down,
click the track 0 and 3 gadgets in turn until you’re satisfied that
track 3 produces the better quality

==> So the non-paired track 3 gives better quality than the paired
track 0. You should hear a difference in open hi-hat sounds.

g) Just as an aside, try switching on both tracks 0 and 3 then playing the
block. (You’ll have to click one of the track gadgets without holding
Shift). Not a bad effect!?...

h) Now restore the original contents of track 3 (see step d above) by
selecting Track menu -> Swap w/Buff
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==> So is there any way that the quality of track 0 can be improved?
Fortunately, there is. The improvement isn’t great, but it should be
noticeable...

i) Firstly, stop the block playing if necessary, then solo track 0 (upper
screen, bottom row, remember to hold down Shift)

j) Now open the Song Options window by selecting Song menu -> Set Options

k) In the window, find the High Quality Mode check box (middle right), and
click on it to switch high quality mode on

l) Keeping the window open, play the block (top left of upper screen), and
again listen especially to the open hi-hat sample

m) Now stop the block, switch high quality mode off (Song Options window),
then play the block again. Can you hear any difference in sound quality?

n) Try turning high quality mode on and off a few times until you’re
convinced (remember to stop the block before clicking the check box or
you’ll hear some strange effects!)

==> So high quality mode produces slightly better quality. Its
disadvantage is that it takes up a lot of the Amiga’s spare time,
and consequently it can’t be used in 7 or 8-channel mode if your
computer has a 68000 processor

o) Keeping high quality mode on, close the Song Options window

p) Finally, switch all tracks on (Set button, bottom left of upper screen),
and play the block through a few times before stopping it

The Right Alt programmable key definition and ghosting

Now that we’ve finished doctoring block 010, we’ll make the same changes
(chorus backing -> piano backing) to block 011.

a) Move to block 011 (Shift-<down>)

b) To add two extra tracks to this block: open the Block Properties window
(perhaps using the Block menu), and drag the Tracks slider to 6 before
closing the window

c) To remove the chorus backing from track 1, move to track 1 then select
Track menu -> Cut. If you wish, play the block through

d) To make the cursor advance down a line when notes are entered: open
Keyboard Options (Settings menu), find the Advance Track radio button
(top middle of window), then click the button next to Don’t Advance and
close the window. (You won’t need to do this if you stopped at half-way)

e) Turn chord-entering mode on (upper screen, bottom left), and switch
the caps lock off if necessary (on the keyboard)
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==> We’re now ready to add the piano chords... or almost ready. Do you
remember the two problems with volume we had last time?

(1) The piano was too loud, so we added command 0C32 to each piano note
(2) The chords appeared to "stagger", so we swapped tracks 2 and 4

Let’s fix problem number 2 first, by moving track 2 into track 4.

f) Move to track 2 and pick Track menu -> Cut

==> Track 2 is moved to the copy buffer.

g) Now move to track 4 and pick Track menu -> Paste

Since we’ve moved track 2 to track 4, track 2 is now free. So we’ll now
make the piano chords we’ll enter affect tracks 1, 2 and 5
(instead of 1, 4 and 5 as they did previously).

h) Click the On/Off cycle gadget (bottom of upper screen) to change to
Select mode, then switch track gadget 4 off and 2 on (by clicking them)

==> Now for problem number 1 (see the arrowed (==>) section above
Do you remember how we added command 0C32 to each piano
note? We used programmable key number 7 with definition xxx x0C32. This
added the command while ignoring the note and instrument digit.

You can also use the Right Alt key as a programmable key. If you assign
a player command (e.g. 0C32) to Right Alt, then enter notes in the
Tracker editor while holding down the Right Alt key, the assigned
player command is automatically inserted with the note.

So we’ll assign player command 0C32 to Right Alt before entering the new
piano chords with Right Alt held down, saving a lot of time.

i) Firstly, move to block 010 (Shift-<up>), then move to track 1
(Alt-<left>) and line 010 (<down>). The cursor should now be over a note
with a 0C32 player command

j) Now open the Programmable Keys window (Settings menu), and find the
cycle gadget showing Numeric (top of left window) and click on it to
change it to Right Alt

==> Clicking the cycle gadget produced two changes in the window:

(1) The Right Alt definition - xxxxx0000 - is now shown in the
definition box. This definition always has transparent note and
instrument digits

(2) The slider at the top right is now checkered, or ghosted. This
means that the slider is disabled for the moment (i.e. pretend
it isn’t there!). You can enable the slider by changing back to
Numeric mode using the cycle gadget (but please don’t do this
just now!)

k) To change the definition to the note and player command under the
cursor, click Note (bottom left of window)
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==> Because the command nearest the cursor (in Tracker editor) is 0C32,
the Right Alt definition changes to xxxxx0C32. Remember that
the Right Alt definition always has transparent note and instrument
digits, so the G#2 (or C#2 or E-3) under the cursor is ignored.

(By the way, you don’t have to use the Note gadget to change the
Right Alt definition: you may also use the hold-left-mouse-button-
and-press-key method we used earlier. Similarly, you may also use
the Note gadget with normal numerical progkeys).

l) Close the window, then move back to block 011 (Shift-<down>)

We’ll now enter the new piano chords while holding down the Right Alt key.

m) Keeping the Right Alt key held down, press the following keys
together: 6 9 P. Release all the keys

==> Look at the result. The chord has been entered as usual on the
selected tracks (1, 2 and 5), but command 0C32 has been inserted
with the notes because we held Right Alt down. Neat, isn’t it?

n) Now enter the following chords on their respective lines (remember to
hold down Right Alt!):

Line | Notes of chord | Keys to press together
--------+----------------+------------------------------

> 006 | B-2 C#3 E-3 | U 9 P [ with Right
> 012 | B-2 C#3 E-3 | U 9 P Alt held
> 016 | B-2 E-3 G#3 | U P \ down! ]

o) For the next chord, change to octaves 2+3 by pressing F2, move to
line 022, then hold down Right Alt and press the 2, E and Y keys
together (notes C#3, E-3 and A-3 should appear)

p) Press F1 to change back to octaves 1+2, then enter the following
chords while holding Right Alt:

Line | Notes of chord | Keys to press together
--------+----------------+------------------------------

> 028 | B-2 E-3 G#3 | U P \ [ with Right
> 032 | A-2 D-2 F#3 | Y O = Alt held
> 038 | A-2 D-2 F#3 | Y O = down! ]
> 044 | G#2 D-2 E-3 | 6 O P
> 048 | A-2 C#2 E-3 | Y 9 P

q) Move to line 048, and if the 1E3F command on one of the tracks hasn’t
been deleted, move to it (Alt-<left>/<right>) and delete it (Alt-Del)

r) Play the block right through, and notice the sudden stop on line 049 due
to the 0FFE command somewhere on that line

==> In 4-channel mode, the 0FFE command stops the song but allows notes
to finish playing. In 5 - 8-channel mode, the 0FFE command stops
both the song and the notes immediately.
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So we need to lengthen the block to allow the notes to finish before the
song is stopped by an 0FFE command.

s) Firstly, move to the 0FFE command on line 049 and delete it (Alt-Del)

t) Now open Block Properties (Block menu) and change the block length to 80
lines (Tab, Del, 8, Return) before closing the window

u) Move to the last line (the F10 key) and insert an 0FFE command on any
track by shift-clicking STOP (left of upper screen)

v) Play the block through. It works!

1.70 Minor tidy-ups and saving

==> Since the method of setting the tempo is different in 5 - 8-channel
mode, we’ll need to change the command level of all the change
tempo (0F) commands in the song. Luckily, there’s only a few!

Firstly, we’ll re-create the primary tempo slide that we made in block 005
in Tutorial 4

a) Move to block 005, then move to the track containing the tempo slide
(the row of 0F commands) and select Track menu -> Cut

b) To create a primary tempo slide from tempo 9 to tempo 5: insert a 0F09
command in any track on line 000, then move to the last line of the same
track (F10, Alt-<left>) and insert command 0F05

c) Now move to any line between the two commands (on the same track), and
select Edit menu -> Generic Slide. The slide is created

d) Play the block through

==> Remember that in 5 - 8-channel mode, the larger the primary tempo
value the slower the tempo. This explains why the tempo 9 set at the
beginning of the block is slower than tempo 5 at the end.

Next we’ll set the starting tempo at the very beginning of the song
(block 000, line 000) to 9 (the same tempo as at the start of the slide
we’ve just created).

e) Move to block 000 (Left Alt-<up>), and change the 0F21 command somewhere
on line 000 to 0F09

==> Look at the song name on the screen’s title bar... this is Tutorial 6 !

f) Open the Song Options window (Song menu -> Set Options), then click on
the 4 in the song name (top of window) and change it to 6 (Del 6 Return)

g) Close the window, then why not play the song right through?
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==> Finally, we’ll save the song.

h) Open the Save Options window (Project menu), and change the song name to
Song1-Tut6 if necessary (Shift-<right>, Backspace, 6, Return)

i) Switch the Create Icon and Save Instruments check boxes off (if
necessary), then click Save (bottom left). Click OK in the requester if
you stopped at the half-way mark

1.71 Setting up for tutorial 7

a) Select the New item from the Project menu. The New? window ←↩
appears

b) Click Clear All

==> Checklist 6 - can you: <==

(1) Change the number of tracks in a block ?
(2) Change the maximum number of displayed tracks ?
(3) Use chord-entering mode ?
(4) Select tracks for chord-entering mode (and for other functions) ?
(5) Insert and delete blocks ?
(6) Change the tempo in 5 - 8-channel mode (using the primary/secondary

tempo slider), and recognize the properties of each slider’s values
(7) Use the programmable keys (create them by using the hold-and-press

method or by clicking Note, enter them with or without the caps lock
on, make notes or digits transparent, and change and enter the Right
Alt definition) ?

(8) Select Advance Next Track (in the Keyboard Options window) ?
(9) Swap two tracks ?
(10) Recognize gadget ghosting ?
(11) Recognize two limitations of 5 - 8-channel mode and how to overcome

them:

a) Volume: How volumes are shared among tracks, and knowing that
each pair of tracks must have the same volume

b) Sound quality: Using high quality mode, and knowing that loss of
quality only appears on paired tracks

The 5-8 channel mode is, sadly, not often used because of its limitations,
(although there are few), We Amiga users can only wish for the number of
hardware sound channels to be increased to at least eight, removing the
need for this mode and enabling the Amiga to show its true potential as a
marvellous music-making machine.

==> for a complete list of the limitations to 5 - 8-channel mode, see
appendix g.

Please progress to Tutorial 7 when you think you’re ready.
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TUTORIAL SEVEN

1.72 TUTORIAL SEVEN

TUTORIAL 7: Ticks and tricks for freeing tracks

This tutorial will cover:

Spreading notes

Transposing notes

Player command 0D: volume slide

Player commands 06 and 14

Sample editor Chord creation

Sample editor - Creating a loop

Default instrument volume

Sample list’s add and save

Song compression: PowerPacker

TUTORIAL EIGHT
In this tutorial we’re going to move on to another song.

The new song will be very simple, consisting of just two instruments,
(Acoustic Guitar and PanFlute 1), + speech sample we edited in Tutorial5.

1.73 Spreading notes

First of all, we’ll create a block consisting of four guitar chords. Of
course, we’ll need to load a guitar sample before we start...

a) Open the Instrument Load Window by clicking on the small gadget
immediately to the right of 01 (upper screen, top row), then click
OctaMED_Samples:Guitars (near the bottom in the right hand list)

b) Click Acoustic Guitar (top of left hand list) and insert the
OctaMED_Samples disk if asked, then close the window

As you may know, there are two ways in which a guitar can produce a chord.
The strings can be plucked together, meaning that the chord notes are
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played together; or the strings can be strummed, meaning that the chord
notes are played one after the other. We’ll go for the strummed approach.

c) Switch the edit and space modes on (upper screen, bottom left), then
enter the following notes on their respective lines in track 0 (you’ll
only need to use the <down> key between lines 006 and 016):

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------

> 000 C-2 Q | 006 E-3 P | 020 A-2 Y
> 002 G-2 T | 016 F-1 V | 022 E-3 P
> 004 B-2 U | 018 G-2 T |

d) Play the block through once, then stop the playing

==> Doesn’t sound much like a strum... The problem is that all the notes
are on the same track. As we know, each track can only play one
sample at a time. So when each note is played, the note played
previously is stopped.

We’ll solve this problem using OctaMED’s spread notes function.

e) Move to line 000 (F6 key), then mark a range from line 000 to 006 in
track 0 (by dragging the mouse from lines 000 to 006)

==> The C-2 G-2 B-2 E-3 notes should now be highlighted in white.

f) Open the Spread Notes window by selecting Edit menu -> Spread Notes

g) In the window, drag the Width slider to 4, then click Spread

==> The notes previously in one track have been spread to the right
across four tracks. (Dragging the Width slider to 4 set the spread
width to four tracks).

e) Move to line 016 (F7 key), then mark another range from line 016 to 022
in track 0 (by dragging the mouse)

f) Keeping the spread width at 4, shift-click (click with Shift held) the
Spread button

==> Just as in the Sample Editor’s effects windows ,
shift-clicking Spread spreads the notes then closes the window.

g) Play and stop the block. A bit better?

1.74 Transposing notes

Before we look at transposition, we’ll copy the first half of this block
into the second half.

a) To range lines 000 - 022 and tracks 0 - 3: press F6, hold the left mouse
button on the C-2 on line 000, press F7, then drag the mouse downwards
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and across to track 3 of line 022. Release the mouse button

==> Lines 000 - 022 and tracks 0 - 3 should now be highlighted in white
(please try step a again if they aren’t!)

b) Select Edit menu -> Copy Range to store the range in the copy buffer

c) Now to paste the copy buffer starting at the second half of the block,
move to line 032 track 0 and select Edit menu -> Paste Range

Next, we’ll mark a range over the second half of this block (you’ll see why
in a moment!).

d) Hold the left mouse button on the C-2 on line 032, drag across to track
three then press F10 to move to the last line. Release the mouse button

e) Play the block through once, stop the block then move to line 032 (F8)

==> At the moment, the two halves of the block are identical. However,
we’re now going to try out OctaMED’s transpose function. Transposing is
changing the pitch of all the notes in a group by a certain amount. So
we’ll lower the pitch of all the notes in the second half of the block
by two halfsteps (semitones).

f) Open the Transpose window by selecting Edit menu -> Transpose

==> Before transposing, we need to choose which notes of the song the
transposition should affect. We’d like to affect all the notes in
the second half of the block, and we ranged the second half of the
block in step e above. So let’s choose Range as the affected area.

g) Find the two transpose affect radio buttons (on the left of the window).
On the left-hand radio button, click Range

==> The left-hand radio button selects the affected area: the whole
song, the current block, the track that the cursor is on, selected
tracks , or the currently marked range.

The right-hand radio button selects the notes played with which
instruments: all instruments or the current instrument (chosen using
Shift-<left>/<right>). Our range only contains notes played with
instrument 01, but since this is the only instrument in the song, we
left the radio button at All. (We could click Current, however).

h) To transpose down by two halfsteps, click Halfstep Down twice (slightly
right of center). Notice the notes in the visible part of the range
lower in pitch

==> Clicking Halfstep Up, Octave Up or Octave Down in the Transpose
window would have changed the pitch in those ways instead.

i) Close the window, cancel the range by clicking anywhere in the Tracker
editor, then play the block through to hear the change. Stop the playing

The difference between the primary and secondary tempo: ticks
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a) Firstly, insert a new block by selecting Block menu -> New -> Insert,
then move to line 000 (the F6 key)

We had to reach this stage sooner or later... To fully understand the
difference between the primary and secondary tempo, you’ll need to know a
few technical aspects. Don’t worry, it’s all quite simple really!

==> To keep "in time", OctaMED responds to regular ticks that come from one
of the Amiga’s clocks. The tempo (playing speed) depends on two factors
relating to these ticks:

* (1) The time between each tick (primary tempo)

* (2) The number of ticks between each Tracker editor line (secondary
tempo)

b) To illustrate this idea, first turn space mode off, then try changing
the first three lines of track 0 in the current block to the following:

> 000 C-3 10047 <= Hint: Use the I, <right>, <up>, 4 and 7 keys
> 001 --- 00FFF <= Hint: Use the <left, <right>, <up> and F keys
> 002 --- 00FFE <= Hint: Shift-click the STOP button

c) Now set the primary tempo to 011 (upper screen, third row, slide to 010
then click to the right of the knob), and set the secondary tempo to 01

==> Firstly, we’re going to use this block to illustrate that the secondary
tempo is the number of ticks between each Tracker editor line.

So how does it work? Well, usually notes are only played on the first
tick of each line. Using command type 00, however, notes are played
every tick. So on line 000 of track 0 (which contains command 0047), a
new note is played on every tick of that line. The 0FFF command on line
001 stops the note played on the final tick of line 000, and the 0FFE
command on line 002 stops the song playing.

Perhaps a diagram can clear all this up! With a secondary tempo of 3
(i.e. 3 ticks per line), lines 000 and 001 look like this:

Line no. Tick no. Action
/ 000 1 Play note

/ 000 2 Play new note
> 000 C-3 10047 --\ ZOOMED --\ 000 3 Play new note
> 001 --- 00FFF --/ ZOOMED --/ 001 1 STOP note

\ 001 2 (silence)
\ 001 3

So basically, each line is divided into ticks. When we play this block,
we’ll hear a new note being played on each tick of line 000 before the
notes are stopped on line 001. Here goes...

d) Note that the secondary tempo is currently 01 (upper screen, right of
third row), then play the block a few times (it will stop automatically)

==> Only one note was played on line 000 with a secondary tempo of 1.
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e) Move the secondary tempo to 02, then listening carefully play the block
a few times again

==> Did you hear two notes? Since there are now 2 ticks per line, 2
notes were played on line 000. (Remember that the 0047 command
forces a new note to be played on every tick of line 000; usually
notes are only played on the first tick of each line).

f) Always listening carefully, gradually increase the secondary tempo in
steps of one, playing the block between each increase. Stop when you
reach a tempo of 0A

==> Hopefully you now understand the effect of the secondary tempo. But
what about the primary tempo? Well, the primary tempo sets the length
of time between each tick. So increasing the primary tempo will
increase the rate at which notes are played... Let’s try it.

g) Firstly, change the 0FFE command on line 002 to 0F00 (this command
replays the block automatically, saving a bit of time)

h) Now start the block playing, and listening carefully, increase the
primary tempo to 013 by clicking twice in the slider box (right of knob)

==> Can you hear any change? The notes are now played at a quicker rate.

i) By clicking in the slider box anywhere to the right of the knob,
slowly increase the primary tempo until it reaches 025

j) Now stop the block playing

==> So the primary tempo sets the time between ticks, the secondary tempo
sets the number of ticks per line. But what real use does this have?
Why not have just one tempo slider? We’ll examine these questions in
the next section.

1.75 Player command 0D: volume slide

==> Many player command effects (e.g. pitch slide, vibrato) are performed
on every tick. So with a secondary tempo of 6, effects are carried out
six times per Tracker editor line.

One such effect is player command 0D. It increases or decreases the
volume of a note by a specified amount on every tick.

We’ll look at this player command now.

a) To delete the current block, select Block menu -> Delete -> Current

==> The "guitar chords" block (000) is now shown in the Tracker editor.

b) Set the primary tempo to 033 and the secondary tempo to 06, then play
the block through once, and stop the playing
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==> We’re now going to use command 0D01 to make each guitar chord fade
away before the next chord is played. (I’ll explain exactly what’s
going on in a moment, so don’t worry if you’re a bit lost!).

c) To insert 0D01 commands to lines 011 - 015 of track 0: move to line 011
of track 0, move across to the middle 0 (<right> three times), press the
D key five times, move back up to line 011 and across to the last 0
(<right> twice), then press the 1 key five times

d) Now mark a range over the 0D01 commands on lines 011 - 015 and select
Edit menu -> Copy Range

e) Move up to line 011 and across to track 1, select Edit menu ->
Paste Range, move to track 2 (Alt-<right>), paste the range again (Edit
menu), then move to track 3 and again paste the range

f) Play the block, and listen carefully to the end of the first chord
before stopping the block

==> Because of the 0D01 commands, the first chord gradually fades away.

g) Now move to line 016 (F7), then mark a range over all the 0D01 commands
on all three tracks (lines 011 - 015, tracks 0 - 3), and select Edit
menu -> Copy Range

h) Move to track 0 (Alt-<left>), then paste the range at the following
lines:

(Remember: <down> key, Edit menu -> Paste Range) 027, 043, 059

i) Play and stop the block, then move to line 016 (using the F7 key)

==> Let’s stop to think about what’s happening. Remember that there are 65
possible volume levels: 0 (no volume) to 64 (full volume), and that
the secondary tempo is the number of ticks per Tracker editor line.
A 0D01 command reduces the volume by one level on every tick. So, with a
secondary tempo of 6 (as is currently the case), the volume is reduced
by six levels on each Tracker editor line.

Look at lines 011 - 015 in the Tracker editor. Each track contains
five 0D01 commands, each of which reduces the volume by six levels.
So what final volume is reached after all these reductions?

Line Starting volume Volume after reduction

> 011 --- 0D01 <== 64 (full) - 6 = 58
> 012 --- 0D01 <== 58 - 6 = 52
> 013 --- 0D01 <== 52 - 6 = 46
> 014 --- 0D01 <== 46 - 6 = 40
> 015 --- 0D01 <== 40 - 6 = 34

The final volume reached is 34, which is just over half volume.

j) Now increase the primary tempo to 045, and play the block again
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==> Although the fading produced by the 0D01 commands is now a bit
quicker, the final volume reached is still 34 (see above) because
the secondary tempo hasn’t been changed. (There are still 6 ticks
per Tracker editor line).

k) Stop the block, then set both the primary and secondary tempo sliders to
maximum (i.e. 240 and 20) and play the block again. Listen especially
carefully to the chords fading away

==> This time, the chords fade very rapidly, so that there’s in fact a
short silent period between each chord. This is due to the secondary
tempo now being 20 hexadecimal, which is 32 decimal. So each 0D01
command now reduces the volume by 32 levels. So what final volume is
now reached after all the reductions?

Line Starting volume Volume after reduction

> 011 --- 0D01 <== 64 (full) - 32 = 32
> 012 --- 0D01 <== 32 - 32 = 0
> 013 --- 0D01 <==
> 014 --- 0D01 <== Volume is already zero!!

==> You should now be able to see how the two tempo sliders affect the way
effects are performed: the primary tempo governs the rate, the
secondary tempo governs the number of times per line.

These last two sections have been necessarily technical, so don’t worry if
you don’t quite understand parts of it! For most purposes it is quite
sufficient to leave the secondary tempo set to 06 and to only change the
primary tempo.

1.76 Player commands 06 and 14

In this section we’ll copy our guitar chord block into a new block, and in
this new block we’ll make some changes to the 0D01 commands.

a) To create a new block, pick Block menu -> New -> Append (or use Ctrl-N)

b) To copy block 000 into block 001: select Block menu -> Copy, move to
block 001 (Shift-<down>), then select Block menu -> Paste

c) Now set the primary and secondary tempos to 036 and 06 respectively, and
play and stop the block

==> We’re now going to attempt to add vibrato to the 0D01 volume fades.

Memory refresh: command type 04 adds vibrato to a note. The first
command level digit is the vibrato speed, the second digit is the
vibrato depth.

d) Firstly, switch Advance Cursor Right on (Settings menu ->
Keyboard Options, click Right on top-right radio button, close window)
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e) Now move to line 010, and insert command 0461 (medium speed, least
depth) on ALL the tracks on this line

f) Listening carefully to lines 010 - 015, play and stop the block

==> Did you hear the brief vibrato caused by the 0461 commands on line 010?
Perhaps we’d rather the vibrato continued for a while after line 010
(i.e. on lines 011 - 015). To do this, we’d normally use 0400 commands
on lines 011 - 015, but unfortunately these lines have already been
taken up by 0D01 commands.

The answer is to use command 06. This command both continues the
vibrato and fades at the same time. (In other words, it combines
command 0400 with command type 0D).

So we’ll replace the 0D01 commands on lines 011 - 015 with 0601 commands.

g) Firstly, switch Advance Cursor Right off (Settings menu -> Keyboard
Options, click Don’t Advance on top-right radio button, close window)

h) Now move to the D on line 011 of track 0, and press the 6 key five
times. Repeat this for tracks 1, 2 and 3

i) Again listening carefully to lines 010 - 015, play and stop the block

==> The vibrato now continues, but... don’t you think it sounds a bit
"wobbly" ? What we really need to do is reduce the depth. But we
can’t! The depth’s already at its least possible value, 1! (Remember
that we’re using command 0461).

Command 14 to the rescue. This command behaves exactly like command
04, except that command 14’s depth values produce exactly half the
depth of command 04’s values. For example, command 1461 = command
0461 with half the depth.

So to halve the vibrato depth in this block, we just need to change
all 0461 commands to 1461. Easy.

j) Switch Advance Cursor Right on (Settings menu), then move to line 010
and insert a 1 just before each 461 on all four tracks

k) Play and stop the block. A bit better?

l) Now mark a range over lines 010 - 015 on all four tracks, and select
Edit menu -> Copy Range

m) Move to track 0, then paste the range at lines 026, 042 and 058 (using
the <down> key and the Edit menu)

n) Play the block through. There’s now vibrato after every chord

============================> HALF-WAY MARK! <===========================

[ To stop: do the Song compression section
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To restart: load the Song2-Tut7 song back into memory (if you’re not
sure how to do this, then move
to block 001 and switch edit mode on ]

1.77 Sample editor Chord creation

In the next tutorial we’ll add a lead line to this song. At the moment,
however, there are no spare tracks available for the lead line. We could
switch to 5-channel mode (see Tutorial 6), but let’s instead look at one
of OctaMED’s useful tricks for freeing tracks.

Firstly, just to make the point clear, we’ll move all the notes in track 3
up two lines (you’ll soon see why!).

a) Move to track 3, then make the following changes to this track:

Line Note Keypress | Line Note Keypress | Line Note Key
------------------------------+----------------------+------------------

> 004 E-3 P | 022 Delete note | 052 D-3 O
> 006 Delete note (Del key) | 036 D-3 O | 054 Delete note
> 020 E-3 P | 038 Delete note |

b) Listening to the last note of each chord, play and stop the block

c) Move to the top line (F6 key), and switch edit mode off

==> The notes on tracks 2 and 3 are now played together; in other words,
these notes are small chords consisting of two notes each. Now, these
notes are played on instrument 01, which consists of a single guitar
note. Using OctaMED’s sample editor, you can turn a sample that plays a
single note (such as instrument 01) into a sample that plays a chord.

So look at line 004. A chord consisting of notes B-2 and E-3 is played
on instrument 01. If we were to copy instrument 01 to instrument 02,
then change instrument 02 into a chord that plays notes B-2 and E-3, we
could replace those two notes on line 004 with a single note played by
instrument 02, thus freeing a track. To attempt to simplify:

Step (1) Instrument 01 => Instr. 02 => two-note chord (B-2 and E-3)
(2) Line 004: B-2 10000 E-3 10000 => B-2 20000 --- 00000

In the same way, the A-2 and E-3 chord on line 020 (press F7 to see it)
could be replaced by copying instrument 01 to instrument 03, and then
changing instrument 03 into a chord that plays notes A-2 and E-3. (The
other two chords in this block needn’t be created, as you’ll later
discover).

So we’ll begin by copying instrument 01 into instruments 02 and 03. (Don’t
worry if you’re not completely sure what’s happening here, it should become
clearer soon).

d) To open the Sample Editor, click Edit Sample (upper screen, second row)

==> Instrument 01’s waveform is displayed in the window.
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e) To store a copy of this sample in the copy buffer, click >Buffer (just
below middle of window)

f) Now select instrument 02 (Shift-<right>), and to transfer the copy
buffer to this sample, click Sample< (to the left of >Buffer)

==> Instrument 01 should now have been copied to instrument 02 (play the
sample using the keyboard to confirm this)

g) Select instrument 03 now, and transfer the copy buffer to this sample
(using the Sample< button). Play the sample to confirm the copying

Next, we’ll give the new instruments 02 and 03 names.

h) Close the Sample Editor, then open the Instrument Parameters window by
clicking Inst Params (upper screen, middle of second row)

i) To rename instrument 03, activate the Name text box (top row of window),
and type Guitar 5ths and press Return

j) Now select instrument 02 (Shift-<left>), then rename this instrument by
activating the Name text box and typing Guitar 4ths (then press Return)

Now let’s turn instruments 02 and 03 into chords.

k) Close the window and open the Sample Editor again (upper screen, second
row), then select Effects menu -> Create Chord (bottom of Effects menu)

==> A window opens displaying a row of four pitch boxes. These boxes
contain the notes of the chord you require, and at the moment are
all empty (---).

Remember which chords we’re trying to create: B-2 and E-3 in
instrument 02 (the current sample); A-2 and E-3 in instrument 03.

l) To enter the first note (B-2): hold down the left mouse button on the
top pitch box, then press the U key. Release the mouse button

m) To enter the second note (E-3): hold down the mouse button on the second
pitch box, then press the P key. Release the mouse button

n) Now to create the chord, click Create Chord (bottom left of window).
Play the sample using the keyboard to confirm the chord creation

o) Select instrument 03 (Shift-<right>), then (just as a demonstration)
to delete the B-2 in the top pitch box, hold down the left mouse button
on the B-2 and press the Del or Return key. Release the mouse button

p) Now enter note A-2 into the top pitch box (hold the mouse button and
press the Y key), then create this new chord by shift-clicking
Create Chord

==> As usual, shift-clicking the button closes the window.

q) Listening carefully to the end of the sample, play the instrument using
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the keyboard at fairly low pitches (use e.g. the M, B and C keys)

==> Did you hear the higher note in the chord stop before the end of the
sample? This is because, as we learnt in Tutorial 5 , the
higher the pitch the quicker the playing speed. We could erase the
part after the high note stops playing, but as you’ll see in the
next section, we won’t need to...

1.78 Sample editor - Creating a loop

Have you noticed that we’ve forgotten something?

a) Compare instrument 01 with instruments 02 and 03 by playing them...

==> Instrument 01 keeps on playing, whereas instruments 02 and 03 stop
quickly. Remember why from Tutorial 4 ? It’s because instrument 01 has
a loop: a part of the sample that’s repeated over and over again.

b) Select instrument 01, and find the loop pointers (the two small black
triangles attached to dotted lines on the waveform)

c) Play the sample using the Z key (lowest pitch possible), and watch the
white play marker repeatedly scroll across the area marked by the loop
pointers when it reaches them

d) Now move the Sample Editor to the very bottom of the screen (by dragging
its title bar), and open Instrument Parameters (upper screen, 2nd row)

e) In Instrument Parameters, find the loop gadgets (Repeat, RepLen and
Loop On, third row from the top)

==> (1) Loop On check box: Checked (ticked) if the sample’s loop is active
(2) Repeat numeric box: Length in bytes from the start of the sample to

the start of the loop
(3) RepLen numeric box: Length of the loop in bytes

| |
Waveform: --------------------|----------------|---------------------

|> <| <= loop pointers
\ Repeat /\ RepLen /

So, referring to the Instrument Parameters window, instrument 01 has a
Repeat of 5304 and a RepLen of 318.

Let’s give instruments 02 and 03 a loop by typing in values for Repeat and
RepLen.

f) Select instrument 02, then activate the Repeat gadget (third row of
Instrument Parameters), clear its contents (Ctrl-X) and type 5746 and
press Return or Tab

g) Delete the 4 that appears in RepLen (Del or Backspace key), then
type 382 and press Return
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h) Shrink the window (right mouse button), and notice that loop pointers
have appeared in the Sample Editor. Play the sample using the keyboard

i) Now unshrink the window (right mouse button), select instrument 03, then
activate the Repeat gadget, clear its contents (Ctrl-X), type 5172 and
press Return or Tab

j) Delete the 4 that appears in RepLen, then type 256 and press Return

k) Close the Instrument Parameters window, and play the sample

==> So both chord samples now have decent-sounding loops. But where did the
magic Repeat and RepLen numbers come from? Well, by dragging the loop
pointers in the Sample Editor you can change the values of Repeat and
RepLen. This can be a long and difficult-to-follow process, so to save
you the trouble we typed in values that I’d already found.

Page 162 details the Sample Editor’s facilities for finding loops.

l) Close the Sample Editor

The numeric keypad settings (with apologies to Amiga 600 owners!)

(In this section, steps marked * should be ignored by Amiga 600 users)

==> The numeric keypad is the small collection of 18 keys on the far right
of your Amiga’s keyboard.

a) * Watching the track selection gadgets carefully (upper screen, bottom
right), try pressing any of the numbers (0 - 9) on your numeric keypad

==> Did you notice various track gadgets switching on or off, depending on
which key you pressed (e.g. the 2 key switches track 2 on or off) ? In
OctaMED, the keypad can be set to either turn tracks on and off or to
select instruments.

We’ll now enter the chord instruments (02 and 03) into the song, but before
this we’ll change the numeric keypad mode to Select Instruments.

b) * Click the Set button (upper screen, bottom right), then open the
Keyboard Options window (Settings menu)

c) * Find the keypad mode cycle gadget (showing Tracks On/Off, left of
window), and click on it to change it to Select Instr)

d) Close the window, then press the 2 key on the numeric keypad to select
instrument 02 (Amiga 600 owners use Shift-<left>)

==> This sample is our B-2 E-3 instrument.

e) Now move to track 2 and turn edit mode on, then make the following
changes to track 2 on the given lines:

(Non-A600 users should select instruments using the numeric keypad)
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Instrument | Line | Change to | Keypress
--------------+--------+-------------+------------

> 02 | 004 | B-2 20000 | U
> 03 | 020 | A-2 30000 | Y
> 02 | 036 | A-2 20000 | Y
> 03 | 052 | G-2 30000 | T

f) To clear track 3, move to track 3 and select Track menu -> Cut

g) Now play and stop the block

==> So the chord samples have replaced the single-note samples, leaving
track 3 free for the melody line.

1.79 Default instrument volume

a) But wait! Play the block through again, and listen to the volume of the
chord samples on track 2 compared to the single-note sample on tracks 0
and 1...

==> Can you hear that the chord samples (02 and 03) are slightly quieter
than the single-note sample (01)? This is a small side-effect of the
sample editor’s Chord Creation function: the created chords are usually
a bit quieter than the original sample.

So we’ll make the samples’ volume levels roughly equal by reducing the
volume of the single-note sample. Remembering that level 64 is full
volume, let’s reduce instrument 01’s volume to (say) 45.

==> We could do this by adding 0C45 commands to all notes played by
sample 01, but that would take ages!, so we’ll look at an easier way.

b) Stop the block playing if necessary, then open the Instrument Parameters
window (upper screen, second row)

c) Select instrument 01, then find the default volume slider (middle right
of window, to the right of Vol, showing level 64)

==> This means that, unless a different volume is set using the 0C
command, all notes played with instrument 01 have full volume (64).
(This is the same as using command 0C64 beside every note).

d) To set the default volume to 45, slide the default volume slider to the
left until it reaches 45

e) Now close the window and play and stop the block. The samples’ volume
levels should now be about equal
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1.80 Sample list’s add and save

We’ll now save the chord samples to disk and add them to the sample list.

a) Select instrument 02, then select Instr menu -> Save Instrument ->
IFF 8SVX Format

==> We’re saving in IFF 8SVX format because this format includes sample
loop information (i.e. Repeat and RepLen values .

b) Cancel any Please insert and Directory xxx does not exist requesters
that may appear, then insert your tutorial disk in any disk drive

c) Click on Volumes (bottom of requester), and click the name of your disk

d) Click on the Samples drawer, then click the OK button to save the sample

Now let’s add the Guitar 4ths instrument to the sample list. Remember that
it was saved in the OctaMED_Tutorials:Samples directory.

e) Open the Sample List Editor (Display menu), and click on
OctaMED_Tutorials:Samples in the right-hand list (you may have to use
the scroll bar on the far right)

f) Now to add the current instrument (02: Guitar 4ths) to the directory
you’ve just selected, click Add (far left, about half-way down)

==> Notice the Guitar 4ths entry appear in the instruments list, and
also notice that the instrument’s Repeat and RepLen values are
displayed in two numeric boxes (bottom right).

Finally, we’ll save instrument 03 to disk and add it to the sample list in
one go.

g) Select instrument 03, then click Save Ins (under the instruments list)

==> The Save Ins button saves the current instrument to the selected
directory and adds it to the sample list. It’s always saved in IFF
8SVX format when you use this button.

h) Now save the sample list (click Save List - middle right - and click OK
in the file requester), then close the window

1.81 Song compression: PowerPacker

Finally, we’ll save the song in a compressed form.

a) Select Project menu -> Save, and change the song name to Song2-Tut7

b) Switch Create Icons and Save Instruments off if necessary, then click
Calculate Size (bottom left)
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==> The calculated size should be about 3,150 bytes.

c) Now click the Compression cycle gadget (above Calculate Size) to change
it to PowerPacker Compr.

==> PowerPacker is an excellent compression program by Nico FrangÀois.
Our song will now be compressed in PowerPacker format before
it is saved, reducing the file size. (For those that know PowerPacker,
the settings are always Medium speedup buffer and Good efficiency).

d) Click Save (bottom left), and click OK in the requester if you stopped
at the half-way mark

==> Notice the message on the title bar: the compressed file size should
be about 380 bytes, a very significant reduction in size.
Especially when used with longer songs,
song compression is a very valuable feature for saving disk space.

e) To set up for Tutorial 8, select Project menu -> New and click Clear All

==> Checklist 7 - can you: <==

(1) Use the Spread Notes function ?
(2) Transpose window: select the affected area and instruments, and

change the pitch in one of four ways ?
(3) Understand the difference between the primary and secondary

tempo (with regard to ticks) ?
(4) Realize that many command effects are performed on every tick ?
(5) Use player commands 06, 0D and 14 ?
(6) Create chords using the Sample Editor ?
(7) Create a loop by typing in the Repeat and RepLen values ?
(8) Use the numeric keypad in two different modes? ( NOT A600 )
(9) Adjust the default instrument volume ?
(10) Understand the difference between IFF 8SVX and Raw sample formats ?
(11) Sample List Editor: Add, save + add, an instrument to a directory ?
(12) Compress a song in PowerPacker format ?

When you’ve made sure you can do everything in the checklist, I’ll see you
in Tutorial 8: the final tutorial!!

TUTORIAL EIGHT

1.82 TUTORIAL EIGHT

TUTORIAL 8: A bit of everything

This tutorial will cover:

Hold and decay
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Player command 19

Song compression: sfcd

Timing a part of a song

Setting sample parameters

Hexadecimal volumes

BITS AND BOBS

And finally...

Reference - MIDI
This final tutorial will take you through a few assorted OctaMED ←↩

features
that, although less-often used than some other functions, can still be very
useful...

Yes, you heard me correctly, this is the FINAL tutorial!! I would have
liked to "tutorialize" (is that a word?) more features, but due to time
restrictions this hasn’t been possible. This isn’t the end of the manual,
though, you’ll be delighted to know: I’ve included a reference section and
a few appendices to prolong your pleasure.
( any small features missed will be included in the V6 tutorial )

Using instruments above 0V

a) Load Song2-Tut7 from your tutorial disk (hopefully you won’t need more
explanation by now!)

b) To select instrument 11, watch the current instrument number (upper
screen, top row) carefully and press Shift-Alt-<right> twice

==> Shift-Alt-<right> moves 16 instruments forward. So instrument 11 is
the 32nd instrument. (Shift-Alt-<left> moves 16 instrs. backwards).

c) Open the Load Instrument Window (small button immediately to the right
of the current instrument number), and load Pan Flute 1 from the
Brass+Woodwind directory before closing the window

Now we’ll create five new blocks, and copy block 001 into these new blocks
before adding the lead line.

d) Move to block 001, and select Block menu -> Copy

e) Now create five new blocks by pressing Ctrl-N five times, then paste the
copy buffer into blocks 002 - 006 (i.e. use Shift-<down>, Block menu ->
Paste five times)

f) Move back to block 001, and to easily switch space mode on and set the
space value to 4, mark a range five lines long anywhere in the block
(e.g. lines 000 - 004) and press Alt-~
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==> Alt-~ sets the space value to the length of the range - 1.

g) Now move to track 3, switch to keyboard octaves 2+3 (F2 key), turn edit
mode on, and enter the following notes:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
>052 A#2 J | 056 C-3 Q | 060 D-3 W

h) Play the block then move to block 002, and continue entering notes:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
>000 E-3 E | 024 G-3 T | 040 A-2 N
>012 D-3 W | 028 E-3 E | 052 C-3 Q
>016 E-3 E | 032 D-3 W | 056 F-3 R
>020 A-3 Y | 036 C-3 Q | 060 A-3 Y

i) Play the block (recognize...?) then move to block 003, and continue:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
>000 G-3 T | 024 C-3 Q | 056 C-3 Q
>012 A-3 Y | 028 E-3 E | 060 D-3 W
>016 G-3 T | 032 D-3 W |
>020 E-3 E | 052 A#2 J |

j) Play the block then copy block 002 track 3 to block 004 track 3 (use
Shift-<up>/<down> and Track menu -> Copy / Paste), and make the
following changes to the end of block 004 track 3:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
>052 A#2 J | 056 C-3 Q | 060 D-3 W

k) Finally, play the block then move to block 005 and continue:

Line Note Keypress | Line Note Keypress | Line Note Keypress
-----------------------+------------------------+-----------------------
>000 E-3 E | 020 D-3 W | 032 C-3 Q
>012 F-3 R | 024 C-3 Q |
>016 E-3 E | 028 D-3 W |

l) Play the block through, then switch space mode off and stop

==> OK. Suppose that you wanted to change the instrument that one of the
lead line’s notes is played with from 11 to 0E. You would do this by
moving the cursor to the instrument digit and pressing the E key.

m) Do that now: move to any note on track 3, then move the cursor across to
the instrument number (using <right>) and press E

n) To change the instrument number to 1F, move back to the instrument
number and press Shift-F

o) To change the instrument number back to 11, move to it and press
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Shift-Alt-1

p) Now move back to the note part (the <left> key)

==> Out of all that come the following rules for changing an instrument
number: just press the second digit’s key for instruments 01 - 0V, hold
Shift and press the key for 1A - 1V, and hold Shift and Alt and press
the key for 10 - 19.

The Transpose window part 1: changing occurrences of an instrument number

==> Let’s change the panflute instrument to a trumpet. To do this, we’ll:

(1) Flush (remove) instrument 11
(2) Load a trumpet into instrument 04
(3) Use the Transpose window to change all instrument 11 numbers to

instrument 04 numbers

There are four different gadgets or menu items in OctaMED that flush the
current instrument! We’ll use the one in the Instrument Load Window.

a) Open the Load Instrument Window (upper screen, top row), and click Flush

==> Notice the instrument name + size (upper screen, top row) disappear.

b) Now select instrument 04 by pressing Shift-Alt-<left> twice and then
using Shift-<right>, then load Trumpet-Mellow-1.AI in the Brass+Woodwind
directory before closing the window

==> The .AI at the end of this sample means that it comes from a sample
library called Audio Imaging. Phone (U.K.) 0706-356263 for details.

c) Play and stop the current block

==> The lead line has disappeared because the notes are still played
with instrument 11. So we’ll change all the instrument 11 notes in
the song to instrument 04.

d) Open the Transpose window (Edit menu), then set the source instrument
to 11 by selecting instrument 11 and clicking Source (bottom middle)

e) Set the destination instrument to 04 by selecting instrument 04 and
clicking Destination (below Source)

==> In our case it would have been easier to set the destination
instrument first, but we didn’t for clarity’s sake...

f) Now to change the instruments, click Change (bottom left)

==> If we’d clicked Swap, all occurrences of instrument 11 would be
changed to 04 and vice-versa. If we’d used Delete, all notes played
with the source instrument (11) would be deleted.

The area affected by the Change / Swap / Delete is selected using
the left-hand radio button . We left it set to Song.
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g) Close the window, then play through the block

Let’s quickly create a playing sequence for this song.

h) Open the Block List and the Playing Sequence (upper screen, fourth row,
B and Sq gadgets)

i) To add blocks 001 - 006 to the playing sequence: in the Block List,
click on block 001 then click App To Seq (bottom left), and repeat for
blocks 002 - 006

j) Close both windows then play the whole song through, and stop the song

1.83 Hold and decay

a) Move to block 003, then open the Instrument Parameters window (upper
screen, middle of second row) and find the Hold and Decay numeric boxes
(about half-way down on the left)

==> Currently both values are 0 (zero), which means that both Hold and
Decay are switched off.

Let’s start with Hold. The hold value is the number of ticks that the
current instrument should play for. For example, if Hold was set to 5,
the note would play for 5 ticks then stop.

Let’s try setting this trumpet instrument’s Hold value to 4.

b) Click on the 0 in the Hold numeric box, then press Del, 4 and Return
before closing the window

c) Play and stop the block

==> The notes are really short, aren’t they? They’re only 4 ticks long.
If you remember from Tutorial 7, the secondary tempo sets the number
of ticks per line. Our secondary tempo is set to 6, so the trumpet
notes are even less than a line long.

==> So what happens if you’d like to use longer notes? You enter keep-
holding symbols (-|-) after the notes, using the Return key. Let’s try
this out.

d) Move to line 001 of track 3, then repeatedly press Return until you
reach the next note (it should be an A-3 on line 012)

e) Now move down to line 033, and enter another eight keep-holding symbols

f) Play and stop the block

==> Clever, or what? In fact, on the last keep-holding symbol of each
set, the usual hold value is used (i.e. here the note stops after 4
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ticks). You can also enter keep-holding symbols by clearing the note
and entering only the instrument number.

==> Now to Decay. If the decay value is above zero, the instrument fades
away after holding. A decay value of 1 produces the slowest fade, 127
the quickest, but values above 10 aren’t really noticeable. (The hold
value range is also 1 - 127).

g) To set the decay value to 2: open Instrument Parameters (upper screen,
second row), click on the 0 in the Decay numeric box, then press Del, 2
and Return before closing the window

h) Now play and stop the block, and notice the volume fade after each hold

i) Finally, set the Hold and Decay for this instrument to 24 and 1
respectively (you’ll have to open Instrument Parameters first! Close the
window when you’ve finished)

j) Why not play the song through? Go on, treat yourself!

1.84 Player command 19

Time for a suitably silly ending to our song, which will involve our much-
loved Goats For Bed (echo) sample (edited in Tutorial 5).

a) Move to block 006, then to remove all notes from line 016 onwards, move
to line 016 of track 0 and press Shift-Ctrl-K

b) Now to make the guitar chord properly fade away to nothing, mark a range
over lines 011 - 015 of tracks 0 - 2 and select Edit menu -> Copy Range,
then move to line 016 of track 0 and select Edit menu -> Paste Range

c) Add an extra 0601 command for luck on line 021 of track 2, then play and
stop the block

d) Now select instrument 05, and, using the Instrument Load Window, load
Goats For Bed (echo) from the OctaMED_Tutorials:Samples directory

e) Switch back to octaves 1+2 (F1 key), then enter this instrument at pitch
C-3 (I key) on line 025 of track 2 and line 036 of track 3

==> OK. Player command 19 allows you to set a point on the sample’s
waveform where the sample should start playing (instead of starting at
the beginning).

Our Goats For Bed (echo) sample sounds like this: Goats for bed...
bed... bed... bed... Using player command 19, we’ll make the sample
start at the first word bed.

==> So how do we do this? Well, the player command level is the byte number
where the sample should start - 256. So grab a calculator, and let’s
party... (?!)
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f) Open the Sample Editor (upper screen, second row), then click on the
waveform at the start of the first word bed (the fourth waveform part)

==> The Range Start numeric box should show something between 10500
and 11500. The correct value is in fact 10989, so we’ll use this.

==> 10989 - 256 = 42.93, which is nearer 43 than 42 so we’ll use
value 43. 43 decimal = $2B hex

g) So close the window, and add player command 192B to the note on line 036

h) To assign command 192B to the Right Alt programmable key:
move the cursor to the 192B command, open the Programmable Keys window
(Settings menu), click the Numeric cycle gadget to change it to Right
Alt, then click Note (middle left) and close the window

i) Now, keeping Right Alt held down, enter more Goats For Bed (echo) notes
on these lines and tracks:

Line Track Note Keypress | Line Track Note Keypress
------------------------------+------------------------------
>034 0 G-3 ] | 051 3 A-2 Y [ with Right
>042 1 G-2 T | 053 0 D-3 O Alt held
>046 2 E-2 E | down! ]

j) Insert an 0FFE command anywhere on line 063 by using the F10 key and
shift-clicking STOP, then play the block through

Hmm... different...

k) Play the final song right through. Isn’t it great?... Oh well. ;^)

1.85 Song compression: sfcd

a) Select Project menu -> Save, then change the song name to Song2-Tut8

b) Turn Create Icons and Save Instruments off if necessary, then click the
Compression cycle gadget twice to reveal SFCD Compression

==> You could have also shift-clicked the cycle gadget to reveal SFCD
Compression. Shift-clicking a cycle gadget cycles through its
options backwards instead of forwards.

SFCD (Stephan Fuhrmann Compact Density) compression is an alternative to
PowerPacker compression. Developed especially for song compression, it
usually produces slightly smaller files than PowerPacker compression (but
PowerPacker is quicker, so it’s swings and roundabouts...).

c) Click Save (you’ll have to wait a few seconds for the song to compress).
By the way, crunching means the same as compressing if you’re a bit
confused by the title bar message!
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============================> HALF-WAY MARK! <===========================

[ To stop and restart: just switch your Amiga off and on respectively! ]

That’s us finished with our second song. We’ll now return to our first song
(created in Tutorial 4) to look at more of OctaMED’s features.

The Play After Loading setting and song sections

a) To turn play after loading on, pick Settings menu -> Play After Loading

==> Now a song starts playing as soon as it is loaded from disk (no need to
click Play Song). This is especially useful if you’d like to listen to
many songs one after the other (e.g. on the OctaMED_Songs disk).

b) Load Song1-Tut4 from your tutorial disk... listen to the song play right
through

c) Now click, in this order, the B, Sc and Sq buttons on the second row of
the upper screen. You should recognize all windows except Section List

==> We’ll now examine a feature called song sections. At the moment, our
song contains a single playing sequence. The song sections function,
however, allows you to create many different playing sequences (called
sections).

The Section List is another type of playing sequence. Instead of
linking together blocks, however, it links together sections. So the
sections (multiple playing sequences) can be played in any order and
any number of times.

==> We’ll replace our present playing sequence with the following sections
and section list:

Section number | Blocks contained in the section
----------------+---------------------------------

(1) | 000 001 002
(2) | 003 004
(3) | 005 006 007 008 009 010 011

----------------+---------------------------------
Section List: 001 002 002 003

--------------------------------------------------

The song will in fact play the blocks in exactly the same order as they
currently are played, but song sections allow you to break up a single
playing sequence into smaller manageable pieces. (Remember: section is
just another name for playing sequence).

d) Firstly in the Playing Sequence window, clear the current playing
sequence by clicking Clear (near the bottom right). Answer Clear in the
requester

==> Now, only block 000 is left in this section. The 1 in the Sec
numeric box (bottom left) shows that section number one is currently
displayed.
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We’ll add blocks 001 and 002 to this section (see the table above

e) Bring the Block List window "to the front" by clicking its depth gadget
(far top right), then append blocks 001 and 002 to the playing sequence
(drag scroll bar, click on block 001, App To Seq, click 002, App To Seq)

f) To name this section number 1, activate the Name text box (bottom of
the Playing Sequence window), then type Introduction and press Return

g) To add a new section, click New Sec (bottom left), and notice the total
number of sections box (immediately to the left of Exit) change from 001
to 002

h) Select this new section number 2 by clicking > (bottom of window)

==> The new section already contains a block 000, which means that this
entry will have to be changed before any more blocks can be added.

i) Click on block 000 in the Playing Sequence window, then click on the 0
in the block numeric box (middle left of window), and press Del, 3 and
Return to change the current entry to block 003

j) Back in the Block List, append block 004 to the playing sequence.
(Why 004? See section number 2 in the table previous )

k) Name this section Theme (Name text box in Playing Sequence), then add
and select another new section (New Sec, > button)

l) Click on block 000 in the Playing Sequence, then click on 0 in the block
numeric box (middle left), and press Del, 5 and Return to change to 005

m) Now name this section Variation, then append blocks 006 - 011 (in order)
to the playing sequence (Block List)

Now let’s create the section list.
The Section List window is a simpler version of the Playing

Sequence window, with only three named buttons (Insert, Append and Delete).
So creating a lengthy section list can be fairly tedious... but luckily,
our list is only four sections long!

n) Close the Block List, then in the Section List window click Insert three
times to take the total number of entries to 4

==> The numbers above the Append and Delete buttons are (from left to
right): current entry number, total number of entries, total number
of sections. Remember that, because sections can be repeated, the
total numbers of entries and sections may be different (as here).

o) By clicking on entries in the section list and using the > button,
change the list to 001 002 002 003. (To get you started, click on
entry 002 then click the > button once)

p) Now drag the Playing Sequence window down to the very bottom of the
screen, and in the upper screen click Play Song. Watch what happens to
each of the white bars in the two windows
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==> Don’t close the windows just yet: we’ll need them for the next part.

This is rather a trivial example of the section list since the sections are
short. With longer songs, however, the ability to break up a playing
sequence into smaller parts can be invaluable.

(By the way, shift-clicking an entry in the Section List selects that
section in the Playing Sequence. Can be quite useful...)

1.86 Timing a part of a song

a) Find the timer (upper screen, third row, beside STOP)

==> You may have already noticed the timer in action. It counts the number
of minutes and seconds since Play Song or Play Block was last clicked
(Cont Song, Cont Block and STOP don’t reset the timer).

Let’s time part of a song. We’ll time from section list entry 003 playing
sequence entry 002 to section list 004 playing sequence 009. (Confused? You
won’t be...)

b) Click Play Song, and when the section list reaches entry 003 and the
playing sequence reaches entry 002, stop the song

c) Close the Playing Sequence, and make a note somewhere of the current
Tracker editor line number

d) Now to reset the timer, click the R button on the timer’s right

e) Reopen the Playing Sequence window (upper screen, second row), then
click Cont Song, and when the section list reaches entry 004 and the
playing sequence reaches entry 006, stop the song

==> The timer now shows the length of time between those two points in
the song. Now here’s the clever bit. Clicking on the timer sets the
section list entry, playing sequence entry, and current block and
line to their values when the R gadget was last clicked. We last
clicked the R gadget in step d above...

f) So click on the timer, and notice that these values have changed:
section list entry = 003, playing sequence entry = 002, current
block = 004, current line = whatever it was in step c above
(you’ll have to close the Playing Sequence to see this one)

This function can be very useful if you ever need to play the song from a
particular point many times. Click the R gadget at the required point in
the song, then click on the timer to move back to that point and click
Cont Song.

g) Close the Section List window (and the Playing Sequence if necessary)
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1.87 Setting sample parameters

==> Remember we set default pitches and transpose + finetune values in
Tutorials 3+4 for certain instruments in this song? Well, it’s possible
to store these instrument settings (or parameters) in the sample list,
so that they are automatically set whenever the instruments are loaded.

a) Open the Instrument Parameters window, then make a note of the names and
default pitches of instruments 01, 02, 03 and 06 (bottom of window)

b) Close the window and open the Sample List Editor (Display menu), then
select the Bass Drum sample from the Bass_Drums directory

==> The contents of the six numeric boxes and pitch box are this
sample’s parameters (settings). All should be zero except the
default volume which is usually 64 (full volume). You can change the
numeric boxes by activating and typing as usual...

c) But to change the default pitch to C-2 (see your notes for instrument 01
made in step a above), hold down the left mouse button on the pitch box
(bottom left) and press the Q key. Release the mouse button

d) In the same way, change the following instruments’ default pitches:

Directory name | Sample name | Default pitch | Keypress
------------------+-----------------+---------------+----------
Drums+Percussion | Snare Drum.u20 | C-3 | I
Cymbals+Hi-Hats | Hi-Hat Closed 2 | D-3 | O
Cymbals+Hi-Hats | Hi-Hat Open 1 | E-3 | P

==> The chorus instruments (08, 09 and 0A) have Repeat, RepLen, Transpose
and Finetune values. Let’s add these to the sample list, but not by
typing the values into the numeric boxes (although we could)...

e) Select the Strings+Choirs directory, then select instrument 08:
Chorus (major) (Shift-<right>) and click Add (middle left)

f) Now select Chorus (major) in the instrument list, and notice the new
values of RepLen, Transpose and Finetune

==> Usually, the Add button adds the current instrument to the sample
list together with its parameters. However, if the instrument
already exists in the directory (as this Chorus (major) sample did),
the old sample list parameters are replaced with the new ones.

g) Using Shift-<right> and Add, add sample 09 and 0A’s parameters to the
sample list (same directory). Select each sample in the instrument
list to confirm the new parameters

h) Now to save the sample list, click Save List (far right) and click OK in
the file requester that appears.

i) Close the Sample List Editor window
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1.88 Hexadecimal volumes

==> That’s right! If you’re obsessed with thinking like a computer, and you
wouldn’t recognize sense if it beat you unconscious, you can even
sacrifice the gift of one, just one, player command that uses a decimal
command level and use hexadecimal volumes with command 0C!! ;-)

Actually, using hexadecimal volumes can be handy if you often set the
volume to a quarter, half or three-quarters of full volume:
quarter = $10 hex, half = $20, and three-quarters = $30. Quite neat?

a) To set hexadecimal volume mode: open the Song Options window (Song menu
-> Set Options), and click on the Decimal Volumes cycle gadget to change
it to Hex Volumes

==> So we’re now in hex volume mode. But wait! The 0C commands in this
song still use decimal command levels! Easy, thanks to a cunning
function that converts decimal volumes to hex and vice-versa...

b) Drag the window to the very top of the screen, then shrink it (right
mouse button) and move to block 006 line 032

c) Unshrink the window, then click Convert (roughly top right). Watching
what happens to the 0C commands in track 1, click Dec->Hex in the
requester

d) Close the window, then play the block. Totally oblivious to what’s just
happened, the 0C commands act perfectly normally

The Transpose window part 2: changing occurrences of a note

==> Up till now, our snare drum instrument (02) has always had a pitch
of C-3. Using the Transpose window, let’s change all C-3 notes
played with instrument 02 to D#3.

a) Select instrument 02, then to move to the nearest note played with this
instrument, move to an empty note (--- 00000) and press Alt-Ctrl-<right>

==> It’s not necessary to move to a note played with the instrument
you’d like to change, but it’s quite a cool keyboard shortcut?...

b) Open the Transpose window (Edit menu), find the Source and Destination
pitch boxes (far top right), then set these pitch boxes to C-3 and D#3
respectively (using the I and 0 (zero) keys)

c) We want the note change to affect the whole song and the current
instrument (02), so leave the left-hand radio button set to Song and set
the right-hand radio button to Current

d) Click the Change button (top right, NOT bottom left!), and notice the
snare drum instruments in track 0 all change to D#2

==> If we’d clicked Swap instead of Change, C-3s would become D#3s and
D#3s would become C-3s.



PREFACE 116 / 175

e) Close the window then play the block... notice any difference?... (To be
honest, I can’t really!)

1.89 BITS AND BOBS

==> If you have a 68000 processor , you may notice that
OctaMED runs a bit slowly if no windows are open. This is due to the
equalizers, in particular the oscilloscopes
It would therefore be handy to turn these off...

a) And you can! Select Settings menu -> Equalizers -> Oscilloscope

b) With the song playing, try clicking Freeze Display (lower screen)

==> Freeze Display removes the Tracker editor and turns off both sets of
equalizers, freeing some more processor time. If you switch the
Auto-Freeze Screen setting on (Settings menu), OctaMED will freeze
the display every time you click the screen depth gadget (far right
of title bar). This is useful for multi-tasking.

c) To make these permanent settings (i.e. OctaMED will switch the
oscilloscopes off and turn Auto-Freeze Screen on (if it’s on at the
moment!) every time it starts up), select Settings menu -> Save Settings
(insert your boot disk if requested)

==> Various settings are saved to a file called S:OctaMEDPro.config when
you select Save Settings. If you’d like to store more than one settings
file, you can use Save Settings As to save the settings under a
different name, then use Load Settings to load them back into memory.

We’ll now examine a different method of setting the tempo.

d) Turn Freeze Display off (lower screen), then to switch to BPM timing,
click on the SPD cycle gadget (upper screen, middle of third row)

==> BPM (Beats Per Minute) timing allows you to set the tempo in a more
musical way than the perhaps confusing primary / secondary tempo
method. The primary tempo slider becomes the number of beats per
minute, and the secondary tempo slider the number of lines per beat.

For example, with a primary tempo value of 60 (60 beats per minute = 1
beat per second) and a secondary tempo value of 8, eight lines are
played in one second.

e) Start the song playing, and try out different values of the primary and
secondary tempo sliders

==> While we’re on the tempo subject, it’s possible to create a song that
uses all of the processor time (try filling a block with notes and
player command 0FF3, and setting the tempos to 240 and 01...), so that
you can’t move the mouse to click the STOP button! If this happens (and
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it shouldn’t happen accidentally!!), hold down both mouse buttons for
about five or six seconds to stop the playing. This feature is
poetically named panic stop!

f) Switch back to SPD mode (upper screen, third row), and stop the playing

Time for some fiddling with a few controls while the song is playing...

g) Start the song playing, then open the Relative Track Volumes window by
selecting Song menu -> Set Volumes

==> This window full of sliders is used to set each track’s volume and an
overall (master) volume. The "relative" part in the window’s title bar
refers to the relativity between the track and master volumes. For
example, setting both master and a track volume to half (32) will
produce an actual track volume of a quarter (16).

h) Go on, have a fiddle with sliders 0 - 3 and Master!

i) When you’ve had enough, slide everything back up to 64 then close the
window (still keeping the song playing)

j) Now open the Song Options window (Song menu), and try playing with the
Audio Filter Active and Play Transpose gadgets

==>(1) Audio Filter Active turns the Amiga’s internal audio filter on/off.
When on, the Amiga’s power light brightens a little, and the sound
becomes more muffled. It’s usually best to keep the filter off, but
it may help in 5 - 8-channel mode (see Tutorial 6).

(2) Play Transpose transposes the whole song by the number of halfsteps
indicated by the slider, without affecting the actual note names.

k) When you’ve finished, set Play Transpose to zero and switch the audio
filter off (aren’t I a killjoy?), then close the window + stop the song

1.90 And finally...

a) Open the Set Annotation window (Song menu)

==> Just one more tutorialized feature to go! This long, thin window allows
you to type in a message that can be a maximum of 80 keypresses long.
The message is displayed on the title bar when the song is re-loaded,
and could be a copyright message, the composer’s name, any special
instructions, in fact anything you like!

b) Type in your message to the world, then press Return to close the window

c) To save the song: open Save Options (Project menu), change the song name
to Song1-Tut8, turn Create Icons and Save Instruments off if necessary,
select SFCD Compression , and click Save
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==> Checklist 8 - can you: <==

(1) Use Shift-Alt-<left>/<right> to move 16 samples forward / backwards ?
(2) Change any type of instrument number (01 - 0V, 10 - 19, 1A - 1V) ?
(3) Transpose: change all occurrences of an instrument number or note ?
(4) Set instrument hold and decay, and enter keep-holding symbols ?
(5) Use player command 19 ?
(6) Use, and convert, hex volumes with player command 0C ?
(7) Switch Play After Loading on and off ?
(8) Create song sections + a section list, and clear the current section ?

(9) Time part of a song, and set and move back to a song position ?
(10) Set sample list instrument parameters (by typing or using Add) ?
(11) Turn equalizers off and use Freeze Display and Auto-Freeze Screen ?
(12) Use BPM timing and stop the song in a panic ?!
(13) Fiddle with track/master volumes, audio filter and Play Transpose ?
(14) Set an annotation message ?
(15) Save the current settings ?

CONGRATULATIONS! You’ve now completed all eight tutorials in the OctaMED V5
Companion. You should now be a proficient OctaMED user, ready to start
creating your own songs with the minimum of difficulty.

And remember: when you have created a song that you like, don’t keep it to
yourself, spread it! And why not send it into the MED Users Group for
review and inclusion in the Pick & Mix library (address given in the
Please Read Me Now file on OctaMED V5 disk 1).
Or if you have a modem then why not upload it to the OctaMED User BBS
Phone +44 (0)1703 703446
Above all, have loads of fun with the premier Amiga budget music package.

As I’ve said earlier, a reference section and set of appendices now follow.
Due to time restrictions, I’ve haven’t been able to include every single
OctaMED feature in this tutorial, but if you find a gadget or menu item
that you’re not sure how to operate, just press the Help key whilst the
program is runnung for a complete on-line reference document!

Enjoy. ED Wiles.

Reference - MIDI

1.91 Reference - MIDI

MIDI FEATURES

OctaMED can output notes and some player commands to external MIDI devices,
by way of a MIDI interface which you should connect to your Amiga’s serial
port.

Note: please refer to your MIDI device’s manual if you come across terms in
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this section that you aren’t sure of.

MIDI Instrument Parameters

==> A MIDI instrument in OctaMED is not strictly an instrument, but simply
a few settings which result in the notes played with that instrument
being sent through a MIDI interface; therefore, MIDI instruments aren’t
loaded into memory like other sounds.

MIDI instruments can also use the full 10½-octave range. Use the octaves
cycle gadget (upper screen) or the F1 - F5 keys to select these. F1 and F5
switch between three different octaves if you press them repeatedly.

Before using a MIDI instrument, you need to change some settings in the
Instrument Parameters window to the required values.

==) MIDICh sets the MIDI channel for the instrument (1 - 16). For example,
setting it to 5 means this instrument’s notes are sent through MIDI
channel 5.

Preset sets the instrument’s preset number (maximum = 128 or 2800).
When set to zero, OctaMED uses your keyboard’s default preset
for the instrument’s MIDI channel (see MIDI Ch above). But by giving
this slider a non-zero value, you may use more than one preset on the
same MIDI channel: OctaMED sends a program change message whenever a
note is played.

* (If you want to send a preset change command without playing a note,
use the C00 command with any note played by the instrument with the
new preset).

Suppress NoteOff suppresses Note Off messages for the current
instrument. Some devices may have some instruments (e.g. one-shot drum
sounds) which actually ignore the Note Off messages. So when this check
box is selected, Note Offs aren’t sent for the current instrument,
reducing unnecessary output (which is slightly faster).

Extended Preset: When off, the maximum value of the Preset slider
is 128, but when on the maximum is increased to 2800. However, this
can only be used on MIDI devices which support the exact method of
sending the preset:

* Presets 1 - 100 are sent in the normal manner.

* Presets above 100 are sent by first sending the "hundreds" part
and then the 0-99 part. For example, the number 1156 is sent as 11
followed by 56.

Consult your manual to see if this is the way supported by your
device.

In order to hear a MIDI instrument, you must also set its default volume to
above zero.

Note: a MIDI instrument’s name doesn’t really have any use. It’s good
practice, however, to type preset names into the Name gadget. In this way
you can easily recognize the instruments, and if you give the song to
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someone else who has different MIDI equipment, he/she can easily change the
preset numbers to use the correct presets on his/her MIDI device.

The MIDI menu

This menu contains more MIDI-specific functions and settings.

==) MIDI Active activates MIDI when selected. If the serial port is being
used by another program, however, you must quit the other program
before you can use MIDI. When this option is on, an M appears in the
display box to the right of Cont Block in the upper screen.

Input Active, when selected, allows the entering of notes into the song
using the MIDI device. Edit mode and MIDI Active must be on. An I
appears in the upper screen display box when this function is active.

Input Channel opens the Input Channel window. The slider’s value is the
MIDI input channel number through which notes will be received when
Input Active is on . If it is zero, OctaMED will accept
input from all MIDI channels.

Ext Sync and Send Sync: Synchronization (or sync for short) involves
OctaMED sending information which allows MIDI devices to keep in time
with OctaMED.

* When Send Sync is activated, this information is sent when you click
either Play Song or STOP (note that it isn’t sent with Cont Song,
Play Block or Cont Block).

When Ext Sync is activated, OctaMED can be synchronized externally,
meaning that an external MIDI device sends the sync information
instead of OctaMED. As well as (of course) MIDI Active, Input Active
must be selected for Ext Sync to work.

Send Active Sensing: After MIDI Active has been selected, OctaMED
periodically sends active sensing ($FE) messages when this is turned
on. These messages tell OctaMED whether all required MIDI leads are
properly connected.

Send Out Input, when activated, replays input MIDI notes. Useful for
owners of a separate sound module and keyboard.

Read Key-Up’s, when switched on, records key-up events into the Tracker
editor (as 0FFF player commands).

Read Volume: If you have a touch-sensitive keyboard, the volume will be
entered as a set volume player command (0C) when notes are input.

Reset Pitch/Presets resets pitchbenders , modulation wheels and presets
on all channels. (OctaMED sends preset change messages for all MIDI
channels).

Send MIDI Reset sends a MIDI Reset message ($FF).

Send Local Control sends a local control on / off message. When using a
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keyboard synthesizer, the local control (when on) routes the keyboard
directly to the internal synthesizer. In a multi-timbral setup, switch
local control off; otherwise, it’s usually best to keep it on.

Note Killing selects the method for turning off all notes (by clicking
STOP or pressing the space bar).

* $Bx 7B 00 sends MIDI All Notes Off messages for each MIDI channel,
whereas Note Off Msgs sends standard MIDI Note Off messages for each
track.

The former is recommended if your MIDI device supports it, because it
stops all notes, not just those triggered by OctaMED.

The MIDI Message Editor

==> With this window (opened using the Display menu) you can capture, send,
and store MIDI data, and edit MIDI messages in hexadecimal.

The message editor is especially suitable for, but not limited to,
capturing System Exclusive (SysEx) messages. These are very versatile
messages which can (for example) be used to set and alter the parameters of
sounds on machines supporting this facility. You can edit sounds using your
synthesizer, then transfer either the original sound or the edited sound
into your Amiga and save it. Later on, OctaMED can send the sound back to
the synthesizer for playing.

The gadgets to the right of Msg (middle left) are: current message number,
previous message, next message, and total number of messages in
the buffer. Other gadgets are as follows:

==) New Msg adds a new message to the end of the list. Use this gadget to
create a new message after starting OctaMED up.

New Here inserts a new message at the current point in the list.
Usually New Msg is preferred to this button.

Del Msg deletes the current message.

Clear Msg clears the current message (sets all bytes to zero).

Msg Size: Newly-created messages are eight bytes long, but to capture
(for example) SysEx messages, a much larger buffer is required. So use
this numeric box to change the message size. The arrow gadgets decrease
and increase the size by one, and the maximum size is 1048560 bytes.

Name allows you to name the message: it’s usually hard to recognize a
message just by looking at it! :-)

Save Msg opens a file requester to save the current message. Note that
MIDI messages are automatically saved with OctaMED songs, but you may
wish to save them as separate files that you can load into other songs.

Load Msg opens a file requester for loading a message. A requester
appears wondering whether the new message should replace the current
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one or create a new message for itself.

Capture Msg: To capture data from your MIDI device, set up an empty
message as large as or larger than the incoming data, click Capture
Msg, then start your device sending data. Clicking it again stops
capturing (although with SysEx messages there is an easier way to stop
capturing, see Auto-Terminate Capture below).

* MIDI Active and Input Active in the MIDI menu are automatically
selected when Capture Msg is pressed.

Send Msg sends out the current MIDI message. Player command 10 also
does this.

Auto-Terminate Capture causes OctaMED to stop capturing when an End
SysEx byte ($F7) is received. OctaMED will also remove all unused bytes
at the end of the buffer: you shouldn’t leave any unused (zero) bytes
after the actual MIDI data. These zeros are MIDI data too, which will
be sent, and this is likely to cause problems. So this gadget is
usually kept switched on.

* If this gadget is off, however, OctaMED will capture all incoming
bytes until either the Capture Msg gadget is re-clicked or the end of
the buffer is reached.

The display box to the right of Auto-Terminate Capture shows Recording...
when a MIDI message is being captured.

You may also edit the hex data. Make sure Edit is on (upper screen), then
simply use the cursor keys to move around the data and the numeric
keys (0-9, A-F) to modify the hex data. Use the Del key to delete a byte,
and Shift-Del to insert a new one.

The Input Map Editor

With this window you may re-assign all the input keys on your keyboard.
It is opened using the Display menu.

==> Each key can be assigned to:

(1) enter any note/command you wish (similar to Programmable Keys)
(2) perform an action (such as moving the cursor up or down)

This also works with the normal Amiga keyboard: a MIDI keyboard is not
required, but the feature is much more useful when used with one.

The two columns of numbers in the list are the entry numbers in hex and
decimal. The other gadgets included in this window are as follows:

==) Map Active allows you to use the input map when checked (ticked).

Create New Map: By default there is no input map, so click this to
create a new one.

* Now, an entry such as C-1xxxxxx is displayed for each note, which
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means that the C-1 key will just enter C-1 with the current
instrument number, and leave the command numbers untouched.

You may edit an entry in the same way as in the Programmable Keys
window . Select an entry by clicking on it, hold down
the left mouse button, move to the number you wish to change and
press a key on the keyboard to change it.

Delete This Map removes the map after a confirmation requester.

Select Function opens the Functions window. Select an editing function
for the currently selected key by clicking on an entry in the list.

Reset Selected changes the selected key back to its original function.

Load Map opens a file requester to load a new input map from disk. A
requester should appear if the current input map has been changed since
last saving.

Save Map opens a file requester, to save the input map to disk.

Other MIDI-related notes

(1) MIDI instruments can use all 64 possible tracks (use the Block
Properties window). You may also mix Amiga samples and MIDI instruments
on the first four tracks.

(2) Arrow (< >) buttons in the upper screen (far bottom right) and the
Relative Track Volumes window show the previous / next set of tracks
when clicked. If you shift-click them, they show the first / last set of
tracks in the current block.

(3) For MIDI use (especially for synchronization), you should only adjust
the primary tempo (leave the secondary tempo set to 6).

==> See Kevan Craft’s MIDI tutorial on accessory disk 3 for further details

One thing this version does not do is to save in MIDI format, however,
V6 does!!, plus a host of other new features, including Arexx,
this new version will go on sale in approx Jan/Feb 1995

So you should contact your supplier after this date as they might just
be selling it.

1.92 Reference - SYNTHETIC SOUND EDITOR

THE SYNTHETIC SOUND EDITOR

Synthetic sounds (or synthsounds) are made from simple waveforms, which can
be linked together and have their volume and pitch altered by using a
simple programming language. This window contains the functions to
construct these sounds.
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The main advantage of synthsounds is that they take up far less memory than
normal samples. However, this doesn’t mean that synthsounds are a poor
substitute, especially if you enjoy the sounds produced by analogue
synthesizers and the good old Commodore 64! Synthsounds are particularly
useful when composing in certain styles of music, Acid House and Rave being
notable examples. They also have a 5-octave range, compared to the 3-octave
range of ordinary samples.

If you don’t have an appropriate synthsound for your purposes, the first
step is to design a waveform with the tools found in the Synthetic Sound
Editor. Next, you write a simple program that instructs OctaMED how to use
the waveform you’ve designed. Finally, use the synthsound in your song as
you would any other instrument.

Waveform editing

To set up the Synthetic Sound Editor:

a) Click Edit SynthS (upper screen, second row) or use the Display menu
b) In the window that appears, select Project menu -> New Synthsound
c) Switch edit mode off (Esc key, since the check box will be hidden)

==> There are two waveform displays. The left-hand waveform is the actual
current instrument, and you may play it from the keyboard. The right-
hand waveform is for temporary editing, and it doubles as a copy
buffer. Either of the waveforms can be activated by clicking on them,
and the current waveform appears to "go into" the screen. Initially the
right waveform is active.

The gadgets between the displays are mostly used for transferring waveforms
and mixing waveforms between displays:

==) Copy copies one waveform to the other (in the arrow direction).

Exchange exchanges both waveforms.

Mix mixes the left waveform to the right waveform.

Add is like Mix, but it doesn’t produce any average between the
waveforms. If a waveform exceeds the upper limit, the editor cuts the
waveform’s peaks (producing distortion.

UNDO reverses the effects of the last editing operation.

Range All selects the entire current waveform as the range for editing
operations.

Drawing a freehand waveform

One way to create a waveform is to draw it from scratch. Do this by
dragging the left mouse button along a waveform display.

There are four drawing modes, selectable by clicking the two Draw Mode
cycle gadgets.
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==) Pixel draws in pixels (default).

Line is used for drawing straight lines.

Mix mixes the drawn lines or pixels with the existing data.

Direct draws without mixing (default).

(The upper cycle gadget also selects Range, with which you can select a
part of the waveform: see below).

The Preset and Project menus

Instead of drawing freehand (which can be inaccurate), some often-needed
basic waveforms are available from the Presets menu. Selecting a waveform
inserts it into the active waveform display. Also in this menu is Clear
Wave, which clears the active display.

The following items are included in the Project menu:

==) New Synthsound clears the whole synthsound (take care...). Also forces
the current instrument to be a synthsound (if it’s e.g. a sample).

Exit Synth Editor closes the window.

Multiple waveforms

You can construct a synthsound from up to 64 different waveforms. Gadgets
for moving between, adding and deleting these waveforms are as follows:

+--+-------+-+-+
Waveform: |0 |$00/000|<|>| (below the left waveform

+--+-------+-+-+ display)

==) From left to right: current waveform number in decimal and hex, total
number of waveforms, move to next waveform (Alt-<right>), move to
previous waveform (Alt-<left>). Shift-clicking an arrow gadget moves to
the first or last waveform.

New Waveform adds a new waveform after the last waveform.

New Here inserts a new waveform at the current waveform position.

Delete Last deletes the last waveform.

Delete Current deletes the current waveform.

Waveform length

Each synthetic waveform can be any even length between 2 and 128 bytes. The
shorter the waveform, the higher the pitch (the pitch also depends on the
waveform itself). Usually, to make the pitches harmonically compatible with
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other instruments, you should use length 2, 4, 8, 16, 32, 64 or 128. The
length can be changed by using the Length slider.

*** If you’d like to examine some example synthsounds, then load the
Barney-SynthSong song from the OctaMED_Songs disk, and open the
Synthetic Sound Editor. To *save* all 46 synthsounds in the song to
your tutorial disk, open the Sample List Editor, select the
OctaMED_Tutorials:Samples directory, and click Save All Insts (bottom).

* this cannot be done, of course, if you are using the CDROM version *

Range operations

Some basic editing operations exist that act on the current range. Mark a
range by cycling the upper Draw Mode cycle gadget to Range, and then
dragging the left mouse button over a waveform display (as in the Sample
Editor). To range the whole waveform, click Range All (middle of window).
Use the Range and End numeric boxes at the lower-right of the window to
make small corrections to the range area.

A range of one byte in length is displayed as a single vertical white line.
This is the cursor; some editing operations make use of it. It may be set
either by clicking on a waveform display (with Range cycled), or by using
the Cursor gadgets (bottom right): from left to right, they move the cursor
to the start, middle and end of the waveform.

The range gadgets are as follows:

==) Cut (only works on left waveform) moves the range contents to the right
waveform, and clears the range.

Copy (only works on left waveform) copies range to right waveform.

Paste copies the right waveform to the cursor position on the left
waveform.

Clear clears the range.

Double "doubles" the range, making the pitch one octave higher.

Reverse turns the range backwards.

<< and >> shift the ranged data to the left or right.

The Waveform menu

==) Change Volume opens the Synthsound Volume window, which allows you to
change the volume of a range. The numeric box contains the percentage
of volume change required. For example, 50 would halve the volume,
and 200 would double the volume. Press Return while the box is active
to perform the volume change.

Stretch opens the Synthsound Stretch window, which allows you to
stretch a section of the waveform from the cursor position to one end
of the waveform. For example:
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a) Select a sine wave (Presets menu)
b) Move the cursor to the middle (>|< button, bottom right)
c) Now open the Synthsound Stretch window, then type in the amount

to stretch by (e.g. 32) and press Return.

Positive numbers stretch to the right, negative numbers to the left.

Start and Do Transformation change one waveform to another smoothly, by
generating the intervening waveforms. For example:

a) Create 9 new waveforms by clicking New Waveform nine times
b) Move to waveform 0 (arrow gadgets), and select a pulse wave

(Presets menu)
c) Select Waveform menu -> Start Transformation
d) Now move to waveform 9, and select a sine waveform
e) Select Waveform menu -> Do Transformation
f) Move to waveforms 1 - 8 in turn, and notice the smooth

transition between the pulse and sine waves

The Synthetic Sound Programming Language

Note: Please read this section carefully before experimenting, because you
can crash your Amiga with improper use of the synthsound programming
language (as with any other language).

The synthsound programming language is used for controling the volume,
pitch, and order of waveforms in a synthsound. It consists of simple
commands, of which most have a command value.

Programming uses two sequences of commands and numbers: the volume
sequence, and the waveform sequence. They are displayed in a small area
below the right waveform display.

Sequences: Waveform Volume
| |

+----------------+-+ +--------+--------+
| 000 00 40 00 | | | Insert | Delete |
| 001 01 END END | | +--------+--------+
| 002 02 | | | Transition |
| 003 03 | | +-----------------+
| 004 04 (etc.) | |
+----------------+-+

| |
Line numbers: Decimal Hexadecimal

Notes:

(1) Both sequences are a maximum of 127 entries long
(2) To scroll around the sequences, use <up> and <down> or the scroll

bar, or use the F6 - F10 keys as in the Tracker editor
(3) Before editing either sequence, switch edit mode on
(4) To enter commands, move the cursor to the leftmost position of

either list (using <left> and <right>), and press the command’s key
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Inserting a command that requires a value also
inserts a new 00 value

(5) To change command values, position the cursor over the number to be
changed and type in the new value

==) The Insert gadget (or the Return key) inserts a sequence entry.
The Delete gadget (or the Del key) deletes the current sequence entry.
JMP commands are renumbered when entries are inserted or deleted.

The Transition gadget creates transitions. For example, consider this
short waveform sequence:

> 00 00
line numbers => 01 0F <= waveform sequence

> 02 END

If you position the cursor at line 01, making sure that edit mode is
on, clicking Transition creates all the numbers between 00
and 0F (01, 02, 03, 04 ... up to 0E). This saves a lot of typing!

=========> ALL COMMAND VALUES IN THE SEQUENCES ARE HEXADECIMAL <=========

*** I repeat: all values are hexadecimal. Remember this and you’ll be fine!

If you’d rather your computer didn’t crash, read on...

Make sure all loops (repeated sections of program) contain at least one of
the following commands:

WAI, set volume, set waveform (the latter two commands have no keyword)

otherwise the computer would do nothing but execute sequences, and crash.

Execution speed

You can adjust the speed at which each sequence’s entries are handled by
using the Speed gadgets (bottom middle of window).

+-+-+-+
Volume |3|<|>| <= Use the arrow gadgets to adjust the speed of each

--+-+-+ sequence.
Wave |3|<|>| <= The speeds can be $1 - $F in hex (1 - 15 decimal)

+-+-+-+

During program execution you can change either speed using the SPD command
The speed values are in fact the number of ticks between
the execution of each sequence entry.
For example, a speed of 4 executes entries every fourth tick.

Jump-triggering commands

(1) Player command 0E in songs causes a jump to another position in the
waveform sequence. For example, if you wanted to decrease the pitch
after a certain point, you could create this sequence and track part:
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Waveform sequence Part of a track (in the Tracker editor)

> 00 00 <= Set waveform 00 C-2 30000
> 01 HLT <= STOP --- 00000
> 02 CHD <= Jump point --- 00000
> 03 01 --- 00E02 <= Jump to position 02
> 04 END --- 00000 (pitch starts to slide)

Using command JVS, player command 0E can affect the volume sequence too.

(2) When Hold and Decay is used with synthsounds, the decay
value causes a jump to another position in the volume sequence. In this
way, you can handle decay in any way you wish. For example:

Volume sequence

> 00 40 <= Set volume $40 (full) [ The decay for this synthsound
> 01 HLT <= STOP should be 2. Decay values are
> 02 CHD <= Decay point saved and loaded with
> 03 03 synthsounds. ]
> 04 END

Using the JWS command, Decay can also affect the waveform sequence.

Note that volume-changing player commands (05, 06, 0C, 0D, 1A and 1B) don’t
work with synthsounds. The set volume synthsound command acts like player
command 0C, and the CHU and CHD commands like player command 0D.

Hybrid sounds

Hybrid sounds are normal samples that use the same programming language as
synthsounds. All synthsound commands can be used with hybrid sounds, except
the set waveform command: since there’s only a single waveform, it neither
works nor is necessary. You can add extra synthetic waveforms for use with
the EN1, EN2 and VWF commands if you wish.

To create a hybrid sound: load a sample, select Instr menu -> Type, click
Hybrid and close the window, then create a synthsound program using the
Synthetic Sound Editor. (You can also open the Instrument Type window by
clicking the Type gadget: upper screen, top right).

And finally...

Don’t worry if you don’t completely understand synthsounds at first glance!
The language used in this section has been necessarily technical, but read
it through again... :)

Anyway, you don’t need to learn any of this information to use synthsounds,
only to design them; and you don’t need to learn half of this information
to still design great-sounding synthsounds!
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1.93 Reference. NOTATION EDITOR

THE NOTATION EDITOR

==> The notation editor, opened using the Display menu, offers an
alternative to the normal Tracker editor. It can display notes and
rests in standard musical notation, which is both useful for those who
read music and for printing songs to be played on a musical instrument.

Note, however, that although notes can be entered using the notation
editor, player commands may only be entered using the Tracker editor.

One Tracker editor line is displayed in the notation editor as a sixteenth
note, so a quarter note would be four lines long in the Tracker editor. The
notation editor displays and prints one measure at a time.

The notation editor consists of the notation itself on the main screen, and
a Notation Control window which contains various editing options. This
window may be closed using its close gadget, then reopened using the
Display menu.

Note that when the main screen is active, the mouse pointer is displayed as
the current note instead of the default pointer symbol. The pointer’s
hotspot (the pixel used to "point" the pointer) is in the note’s circle,
not at the top of the note’s stick. So for example, to click on the Play
Block gadget in the upper screen, position the note’s circle (not the top
of the note’s stick) over the gadget and press the left mouse button.

Selecting displayed tracks

The editor quickly becomes cluttered if all tracks are displayed at once.
For this reason, you can select exactly which tracks should be displayed.
This is achieved with the three rows of small square track gadgets:

==) Shown simply select which tracks are to be shown.

Ghost show the tracks in a ghosted (semi-visible) form.

Clicking a Select track gadget clears all Shown tracks except the track
clicked, and ghosts the tracks that were previously shown.

The two large arrow buttons to the right of the track gadgets operate like
the track arrow gadgets on the upper screen: clicking them show the
previous/next fourteen tracks, and shift-clicking them show the first/last
fourteen tracks in the current block. (They only really apply to blocks
containing over fourteen tracks).

Presets

You can choose five different combinations of selected and ghosted tracks,
and select them using the Preset cycle gadget immediately to the left of
the track gadgets. The default is preset number 1.
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Usually it’s convenient to put different components of the song on the same
tracks throughout the song. For example, drums and percussion could be on
tracks 0 and 1, the bass line on track 2, the chords on tracks 3 - 5 and so
on. Using the preset function you can quickly display different parts of
the song. For example:

Preset 1 All tracks
Preset 2 Only the chords (tracks 3 - 5)
Preset 3 Only the bass line (track 2)
Preset 4 The chords and the bass line (tracks 2 - 5)
Preset 5 Only the melody line (e.g. track 6)

Signatures

The time signature is set to 3/4 or 4/4 by using the Time Signature menu
item. 3/4 is three quarter notes per measure, 4/4 is four quarter notes per
measure.

You may set the key signature of the song using the Key Signature window,
opened using the appropriate menu item. It contains a slider setting the
number of accidentals - sharps or flats - required (0 - 6), and a radio
button selecting whether the accidentals should be sharps (default) or
flats.

A reminder of the number of accidentals used in different keys:

Number of | Sharps | Flats
accidentals | Major key | Minor key | Major key | Minor key

-------------+-----------+-----------+-----------+-----------
> 0 | C | A | C | A
> 1 | G | E | F | D
> 2 | D | B | Bb | G
> 3 | A | F# | Eb | C
> 4 | E | C# | Ab | F
> 5 | B | G# | Db | Bb
> 6 | F# | D# | Gb | Eb

Instrument settings

Two options relating to the current instrument can be found in the Instr.
Notation window, opened using the Current Instrument menu item.

The Transpose slider is the display transposition value (-24 to 24) for the
current instrument. This can be used, for example, to shift the main melody
one octave up to separate it from the bass line on the display (its actual
pitch is not affected). Usually you’ll want to use steps of one octave
(i.e. -24, -12, 12, 24), but any value can be chosen. Note that the editor
can display just over four octaves (C-1 to D#4), whereas OctaMED
supports 10½ octaves.

If the Hide Instrument check box is selected, the current instrument won’t
be displayed in the notation editor (although its notes will still be
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played). For example, if a chord’s notes extend into the drum track, you
can hide the drum instrument(s), showing only the chords.

Also relating to instruments, if the Show Instrument Numbers menu item is
selected, instrument numbers will be displayed above the notes on the
selected track.

Entering notes

After making sure edit mode is on (upper screen), you can enter notes
either using the keyboard or the mouse. Firstly, you need to select which
track the note should be entered to, using the Select track gadgets. Make
sure the track you select exists in the current block, or you’ll get a
warning message: for example, don’t select track 6 in a 4-track block.

(1) Using the keyboard: enter notes in the usual way, noting that the
cursor is the large blue block.

(2) Using the mouse:

a) To select the length, click on one of the diagrams of notes or rests
at the very left of the Notation Control window. The length of the
note in multiples of sixteenth notes is shown in the Length display
box (this also corresponds to the number of Tracker editor lines).

b) Position the mouse pointer (which now resembles the chosen note)
over the point on the stave where you wish to place the note, then
press the left mouse button. If you hold down the mouse button and
move the mouse up and down, you can hear the note corresponding to
its position on the stave, and this note is shown in the Note box.

The cycle gadget below the two display boxes sets which entering mode
you require when using the mouse to edit. Replace (the default) replaces
the notes - a bit like the overwrite option found in wordprocessors.
Insert inserts the notes, pushing the following notes right. Delete
deletes the notes you click on, moving the following notes to the left.

Save Options window: the Save Notation Data check box

When the Save Notation Data check box (Save Options window) is selected,
additional information used in the notation editor is saved with songs:

(1) The Shown, Ghost and Select track gadgets’ status
(2) The time and key signature
(3) Both the settings in the Instr. Notation window

1.94 Reference - SAMPLE EDITOR

THE SAMPLE EDITOR: Functions we haven’t yet met
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Creating a new sample (sampling)

==> To do this, you must have bought a sampler. These are cartridges that
plug into your Amiga’s parallel port. Ideally, you should have had some
experience with sampling using the program that came with your sampler
before you try sampling in OctaMED.

==) Monitor opens a window that displays the real-time input waveform from
a sampler. The purpose of Monitor is to make sure the sound is at a
volume level that will not cause distortion in the sampling process
(see below).

* The rest of the program is disabled during monitoring, i.e. no other
functions can be selected. Closing the window stops monitoring.

Digitize starts sampling (also called digitizing). The screen blanks,
and multitasking is disabled. The sampling stops when the sample buffer
(Buffsize) is full, but it can be interrupted with the right mouse
button.

* Clicking Digitize when Buffsize is zero sets Buffsize to 131072 bytes
(or if not enough memory, to the largest size possible). (131072 is
the maximum length of a sample).

Finding loops

==) The Loop check box is a duplicate of the Loop On gadget in the
Instrument Parameters window. Selecting this gadget activates the loop.

Loop Point: There are three different methods for moving loop pointers:

a) Typing in the Repeat and/or RepLen value in the Instrument
Parameters window

b) Dragging the loop pointers’ small triangles across the waveform

c) Using the Loop Point gadgets

< and > move a loop pointer two bytes to the left or right.

<0 and 0> move a loop pointer to the left or right until a zero is
found. For a decent-sounding loop, it ideally needs to start and end at
the same value, which can often be zero (i.e. no volume). So these
gadgets are useful in finding good loop points.

The cycle gadget selects whether the < > <0 0> buttons act on the loop
start (default) or loop end pointer.

Bear in mind that zooming in allows far more accurate loop positioning.
Also, good loops are often found by looping any repeating waveform shapes
in the sample (called envelopes). I used this concept when finding the
Guitar 4ths and Guitar 5ths loops.
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Other gadgets and menu items not yet met

==) Freehand allows you to edit the waveform with the mouse. The maximum
display size is 628 bytes, but you may zoom closer if you wish. In
freehand mode, the Pixel display mode is automatically selected (see
later).

Edit menu:

Invert inverts the range (turns it upside-down). This can be useful
when trying to find a smooth loop or a smooth join between two
waveforms (Freehand also helps this).

Copy to Synth Editor transfers the current range to the synthetic sound
editor, allowing you to create a less memory-consuming
instrument.

* The synth editor can only handle waveforms of 128 bytes maximum, so
if the range is longer than that, only the first 128 bytes marked are
copied. The range is copied to the right-hand waveform display. If
you want the new synthetic instrument to replace the sample in
memory, you need to make the current instrument synthetic.

Settings menu:

==) Display: Line selects the normal line display mode, but when Pixel is
turned on, the sample is displayed as pixels (dots) instead of lines.

* Pixel Density opens a window with which you can choose the density
of the pixels in Pixel mode. The slider value is the number of
pixels displayed in every horizontal pixel position.

Sampler Voice Monitor, when selected, allows you to hear the sound you
are sampling during digitizing. Turning this off may marginally enhance
the digitizing quality on machines with a 68000 processor.

The remaining sections document the effects windows we haven’t yet met.
Note that all effects aside from Change Pitch, Mix and Create Chord affect
the current range. So if you wish these effects to apply to the whole
sample, use the Range Display button.

The Change Volume window

We’ve examined this one to death, but just one important feature to go...

As we learnt in Tutorial 5 , if the volume is increased too
much, the normal waveform limits are exceeded and distortion (or clipping)
occurs. If the Don’t Clip check box is switched on, however, the waveform
limits won’t be exceeded. (The volume is changed to the maximum possible
without introducing distortion).
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The Change Pitch window

==> This window lets you change the pitch of (or retune) the sample. The
sample’s size will also change: it will decrease if the pitch is made
higher, and increase if the pitch is lowered.

For example, if you’d like to retune the current sample to play the note
G-2 when you press the C-2 key (usually Q):

(1) Set the source note to C-2 by holding the left mouse button on the
Source pitch box and pressing the C-2 key

(2) Set the destination note to G-2 in the same way

(3) Click Change Pitch. The sample is retuned, and its size in this case
will decrease by roughly two-thirds.

==) Octave Up / Down retunes the sample one octave up / down, halving /
doubling the sample’s size. The Period gadgets are changed to the
values the operation represents.

Cancel Finetune retunes the sample so that the Finetune value in the
Instrument Parameters window no longer applies. So if the finetune
value was -4, the sample would be retuned 4 steps down and the
instrument’s finetune would be set to zero.

Anti-Alias, when on, does some anti-aliasing when retuning. This means
that noise is reduced, and is the default.

The Mix window

==> With this window you may combine two samples. The sample placed in the
copy buffer (using the >Buffer gadget in the sample editor) will be
mixed with the current sample.

The two sliders control the volumes of the two waveforms to be mixed.
To understand them fully, you need to bear in mind that mixing is achieved
by adding the two samples together. So if the samples were both mixed
at 100 % volume, the resulting mixed sample would be 200 % (double) volume.

For this reason, the default for each sample is 50 %, giving a 100 %
(normal volume) mixed sample. (For those that are interested, this is why
samples should be halved in 5 - 8-channel mode: the samples are added at
half their normal volume to produce a full volume sample).

==) Alter the volume of the sample in the copy buffer using the Dest.
Level slider, and that of the current sample using the Source Level
slider. Click Mix to mix the two samples.

The sample in the copy buffer is mixed at the point marked by a range in
the current sample. If the range is more than one byte in length, only the
area selected by the range is affected; otherwise, the whole of the sample
starting at Range Start is affected.

The Noise window
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The fairly unique feature in the window allows you to add noise to the
current range. It may seem useless at first glance, but with it you can
easily create effects such as wind and sea sounds, and it can be a source
of more complex instruments when used together with other effects. So it’s
possible to create good-sounding instruments even without using a sampler!

==) The slider sets the noise strength (1 - 128), which is really the
volume of the produced noise. Click Noise to create the noise.

1.95 Reference - MULTI MODS

MULTI-MODULES AND REAL-TIME EDITING

Multi-modules

==> Multi-modules are projects containing more than one song. Each song
shares the same set of instruments. This allows you, for example, to
compose different songs for each level of a game, without having to
load or keep the same instrument in memory more than once.

Multi-modules are also very useful when editing just one song, as you can
treat one song in the multi-module as "workspace", much like Deluxe Paint’s
spare screen option. You may design and compose in one song, then cut and
paste to another.

Adding and deleting songs

+--+-------+-+-+
|Sg| 01/01 |<|>| (upper screen, far left
+--+-------+-+-+ of fourth row)

==) Sg opens the Song Selector window (see below).

The two numbers represent the current song and the total number of
songs in the multi-module.

< selects the previous song. If shift-clicked, it deletes the last
song in memory after displaying a requester.

> selects the next song. If the current song is the last song, it adds
a new song after displaying a requester. You can avoid this requester
by shift-clicking the > button to add a new song.

Shift-clicking < and > is the same as selecting Delete Last and Add New
respectively from the Song menu.

The Song Selector Window

==> This window allows you to add and delete songs in a multi-module, and
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to choose the current song. Open it using the Sg gadget (see above) or
by selecting Song menu -> Select.

The window displays a list of all songs in the multi-module. Select a song
by clicking on it; the song’s name appears in the display box immediately
below the list. (Giving each song of a multi-module a name is almost a
necessity; use the Song Options window to do this).

The buttons in the Song Selector window are as follows:

==) Add New adds a new song to the end of the list.

Add Here adds a new song at the currently selected position.

Delete deletes the selected song.

Select makes the selected song the current song, and closes the window.

Instrument remapping

OctaMED can automatically remap instruments while loading. This feature can
save you a lot of work. If you have one or more songs already in memory,
and you load an additional song, a Remap instruments? requester will
appear.

==> If you click No: all previous instruments in the entire multi-module
will be lost and the instruments of the new song will be loaded. This
could be used, for example, to use the new, different instruments with
the other songs in the module.

But if you click Yes:

(1) The new song’s instruments will be loaded into empty places, so
that instruments already in memory are preserved

(2) The new song’s instrument numbers will be redirected (remapped)
so that they point to the new instrument positions.

By clicking Yes, several sets of instruments used in several songs can be
contributed to one large overall set of instruments. This is the option
you’ll most often (if not always) choose.

==> In the Save Options window: the right-hand cycle gadget selects whether
to save the whole multi-module (default) or only the current song.

REAL-TIME EDITING

==> Real-time editing is entering notes into the Tracker editor while the
block is playing. For example, if you have a rhythm track already in a
block, you could use real-time editing to quickly add a melody. When
you’ve finished, you can stop the block and correct any mistakes you’ve
made.
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The following two gadgets on the upper screen’s third row aid real-time
editing:

==) D (far left): An abbreviation of Delay, clicking this small button
starts playing the block when you next enter a note. Edit mode must be
on to use this.

NRM cycle gadget (far right): When this gadget shows 2/3 or 1/2, it
slows the tempo down to two-thirds or half of its normal speed
respectively. This makes note entering easier and more accurate.

1.96 Reference - OTHER MENUS

SOME MENU ITEMS NOT YET COVERED

Project menu

==) Save Timer opens the Save Timer window. This provides an option similar
to the automatic save function of many wordprocessors: you can
automatically open the Save Options window every xxx minutes.

* The numeric box contains the time in minutes between subsequent
openings of the Save Options window. A value of zero disables this
function.

Delete Files allows you to delete one or more files from disk (after
confirmation). WARNING: THE FILES WILL BE PERMANENTLY ERASED FROM DISK!

Last Message displays the last message (error or information) that
appeared on the screen’s title bar.

Quit OctaMED quits the program. Will display a confirmation requester
if the project has been changed since last saving.

Block menu

==) New -> Insert / Append Def: inserts / appends a default block. The
default block’s size is 64 lines of 4 or 8 tracks (8 if 5 - 8-channel
mode is on).

Insert Line inserts a new line at the cursor position, increasing the
block length by one line.

Delete Line deletes the line at the cursor position, reducing the block
length by one line.

Instr menu

==) Load Instrument(s): Just to say that OctaMED can load both raw (pure
binary) samples and IFF 8SVX 1 - 7-octave samples. In addition, OctaMED
V4 introduced the loading of delta-compressed samples. These samples’
lengths are exactly halved, with the drawback of a slight loss of sound
quality. Currently OctaMED can’t actually create delta-compressed
samples, but some sample editor programs such as Audiomaster can.
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Automatic Flush: When selected, a requester to flush unused instruments
will appear on pressing the Clear Current gadget in the New Project
window (opened using Project menu -> New).

The following two items affect instrument names when loading songs or
instruments.

==) Add Path adds the full path of the instrument when loaded. (The path is
the disk and directory name, for example: Samples1:Bass/ ). This is
useful when saving songs without instruments which include instruments
not in your sample list. When the song is reloaded, the instruments
will be loaded using the new full path names.

Remove Path: Usually songs made with Trackers have instrument names
which include the full path. This option removes the paths of the
instruments, so that they can be loaded using the sample list instead
of directly from the appropriate disk.

Both Add and Remove Path may be active at once. In this case, the original
path is removed, the instrument is loaded using the sample list, and the
path name from the sample list is added.

Note that the maximum length of an instrument name is 40 characters, so
characters at the end of the name may be lost if the path is very long.

Edit menu

==) Paste To Selected Tracks: As Paste Range, but inserts consecutive
tracks in the copy buffer to consecutive selected tracks in the block.

* For example, imagine the copy buffer contains 3 tracks, the cursor is
on track 2, and tracks 2, 5 and 8 are selected. Choosing Paste to
Selected Tracks pastes the copy buffer to tracks 2, 5 and 8 (instead
of 2, 3 and 4 as with normal Paste).

* Tracks in the block are selected by setting the cycle gadget on the
bottom row of the upper screen to Select .

Discard Copy Buffer flushes the copy buffer and frees the memory it
occupied.

1.97 Reference - WINDOWS

Print Options window

*** Open using the Project menu

==> This window allows printing of the song and various song information.
You can print the song as text (the format of the Tracker editor) or as
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graphics (as in the notation editor.

==) Output File consists of a text box and a GetFile gadget to the left of
the text box. With these you may redirect output to a file instead of a
printer. You can only redirect the header and text output, not
graphics.

Start / End Block set the starting and ending block of the printout.
You may type in any valid block numbers.

All Blocks sets the boxes to the first and last block of the song.

Current Block sets the boxes to the current block number.

Print Header selects whether to print the header before the song
contents. The header consists of a list of instruments and their
parameters, the default tempo, play transpose, track volumes and the
playing sequence(s). It is printed as ordinary text.

Form Feed sends a form feed after printing each block.

Print prints using the specified options.

The remaining cycle gadget selects whether to print as graphics
(default), text, or not to print the blocks at all (i.e. only the
header, if Print Header is checked).

Any Preferences-compatible printer should work in graphics mode, and
the printout’s appearance can be changed using the Printer program in
the Prefs drawer of disk 1. In text mode, highlighted lines are printed
in bold text.

Sample List Editor

*** Open using the Display menu

==) Remove removes the instrument selected in the sample list (i.e.
click on an instrument name and press Remove).

Del Ins is like Remove, but also deletes the instrument from disk (so
be careful!).

In the Sample List Editor’s menu:

==) Load List allows you to load a sample list under any name. The new list
is added to the list already in memory.

Stats displays statistics about the sample list (all should be clear).

Since MIDI instruments are not actually instruments but a few settings, you
may wish to create a "dummy" directory for MIDI instruments.

Highlight Options window

*** Open using the Block menu
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==) Clear clears all the highlighted lines in the block.

Offset sets the first line to be highlighted. For example,
an offset of 2 begins highlighting on line 002.

Spacing allows you to use a highlight spacing not included in the small
buttons at the top of the window. For example, entering 12 highlights
every twelfth line.

You’ll notice that the 1, 2, 3, 4, 6 and 8 gadgets are all underlined,
meaning that they have a Left Alt shortcut. These shortcuts,
however, for some reason only work with the numeric keypad keys (not
the keys on the main keyboard).

Note that when editing, the Tab key highlights the current line. Also note
that highlighting an already highlighted line removes the highlighting.

Expand/Shrink Block window

*** Open using the Block menu

==> This window is used for expanding or shrinking the current block.

==) Expand creates empty lines between each note, and Shrink removes lines.
The Factor numeric box contains the amount of expansion or shrink.

For example, if Factor were 3, pressing Expand would insert two new lines
between each line (thus trebling the block length), and pressing Shrink
would remove every second and third line (thus thirding the block length).

Factor may be 1 - 99, but the expanded block length must not exceed 3200
lines (the maximum block length), and the shrink factor must be divisible
by the number of lines in the block. A message appears if either of these
rules are infringed.

Expansion is useful, for example, if you would like to include some quick
rhythms in a block but realize that the block plays too slowly for the
rhythms. (However, fast rhythms may also be created using
commands 0FF1, 0FF2, 0FF3, and 1F - , so try these before expanding).

The only real use of shrink is to reverse the effect of a previous
expansion.

Instrument Type window

*** Open using the Instr menu or click Type (upper screen, top right)

==> This window chooses which type the current instrument should be.
The gadgets you probably won’t be sure about are:

==) ExtSample: ExtSamples are like normal Amiga samples, except two lower
octaves are added to the octave range (octaves 1 and 2). The octaves
used with normal samples are moved up two places to make way for the
new octaves (i.e. octave 1 becomes octave 3, octave 2 becomes octave 4
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etc.).

* However, because of an undesirable feature in the Amiga’s hardware,
especially under faster processors, ExtSamples should be used with
care. After playing a note with an ExtSample using one of the new
octaves, the following note will often not be correctly triggered.
The solution is to use the 0FFF command before the following note is
played. For example:

C-1 20000 <= ExtSample
--- 00000
--- 00FFF <= use 0FFF before the next note
C-2 10000 <= this instrument doesn’t need to be an ExtSample for

the bug to occur

* However, in paired channels in 5 - 8-channel mode, this problem
doesn’t appear at all!

Note: more experimentative users may discover that octaves 8 and 9 of a
normal sample also appear to play two lower octaves. These octaves should,
however, NEVER be used in songs (apart from with MIDI): believe it or
not, it is in fact a complete coincidence that they work! ExtSamples are
the only "legal" way of using the two lower octaves. In any case, octaves 8
and 9 are also one finetune step sharp. :-)

==) The Octaves slider shows the number of octaves that the current sample
consists of (1 - 7). Changing the slider’s value often messes up the
sample, so it’s best not to. :^)

Note Echo window

*** Open using the Edit menu

==> With this window, you may produce echoes automatically with the 0C
player command . The volume halves with each echo. For
example:

C-1 10000 (the initial note)
--- 00000
C-1 10C32 (half volume. Decimal volumes are used in this example)
--- 00000
C-1 10C16 (quarter volume) etc.

Echoed notes will only be placed in empty note positions throughout the
marked range. The range may cover more than one track.

==) Distance is the distance in lines between echoes. For example, a value
of 4 means echo every fourth line.

Minimum Volume is the minimum volume of an echo. Echoes with a smaller
volume than this won’t be generated.

Do Echo creates the echo. (Shift-clicking it also closes the window).
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The Mouse Options window

*** Open using the Settings menu

==> This window contains three cycle gadgets, used to select the function
of each mouse button when clicked in the Tracker editor. (Ignore the
Middle Mouse Button gadget if you own a two-button mouse!).

The available functions are as follows:

==) No Operation: The mousebutton has no effect.

Track On/Off: The mouse button switches the clicked track on or off.

Select Track: Switches the clicked select track on or off

Position Cursor: Sets the cursor position under the mouse pointer.

Select Range: Marks a range. Due to conflicts with the menu system, the
right mouse button can’t be used to select a range as it has done in
previous versions of (Octa)MED.

Note that if the Right Mouse Button cycle gadget is set to anything other
than No Operation, the menu shortcuts (Right Amiga + key) can’t be used
when the mouse pointer is over the tracker editor. (They instead act as if
the right mouse button has been pressed: OctaMED has no control over this!)

The Keyboard Options window

*** Open using the Settings menu

==) Destructive Spacing: When selected, any notes that lie between the
lines used for entering spaced notes will be deleted when a note is
entered.

Auto-Round Spacing, when on, restricts cursor movements to lines
divisible by the spacing value. For example, with a spacing value of 2,
you can only move the cursor to lines 000, 002, 004 etc. Note that this
only applies to movement using the cursor keys.

Chord Reset: When on, after entering a chord the cursor
returns to the initial track.

Space = DEL: Instead of the Del key, you may prefer to enter blank
notes (---) using the space bar. This check box allows this.

Protracker Shortcuts changes the keyboard layout so that the most
common Protracker keyboard options are recognized. This is
helpful for those who have become used to the Protracker
keyboard layout. The following options are recognized:

Right Shift Turn editing on + play the block (record)
Right Alt Continue Song
Right Amiga Play Block
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Left Alt-<left>/<right> Previous / next block
Shift-<left>/<right> Increase / decrease playseq position
Space bar Stop playing / toggle editing
Tab Next track
Shift-Tab Previous track
Shift-F3 - F5 Cut / copy / paste track
Alt-F3 - F5 Cut / copy / paste block

Advance with sound plays the notes in the block when you press the
<up> or <down> keys. Useful for non-real time editing.

The Programmable Keys window

*** Open using the Settings menu

==) Clear clears the current definition, i.e. sets it to --- 00000
for a normal progkey and to xxxxx0000 for Right Alt.

The Pick buttons copy either the note under the cursor, the current
range, or the copy buffer to the current definition. If a range is
picked, the definition box shows =Range=.

Save/Load Keys allow you to save and load a set of progkey definitions.
The default name is S:OctaMEDPro.defkeys (OctaMED attempts to load a
file of this name on startup), but definitions can be saved under any
filename.

The Palette window

*** Open using the Settings menu

==> This window’s used to change the screen’s colors.

a) Select a color by clicking on it (the chosen color appears in the box at
the top left of the window)

b) Use the Red, Green and Blue sliders to alter the intensity of red,
green and blue light in the selected color.

==) Palette Type sets the sliders’ range. With the default 8-Bit selected,
the range is 0 - 255, allowing compatibility with the AGA chip set
currently present in the A1200 and A4000 computers. With 4-Bit
selected, the range is 0 - 15, more suitable for use with older Amigas.

* Note that either setting can be used with either chip set; but with
an inappropriate setting, AGA computers could only select 1 in
every 4096 available colors, and with other computers the color
would only change once every 16 slider values (which, I can tell
you, is more than a little uncomfortable!).
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1.98 Player commands

Player commands

Four points of note:

(1) Both the command type and the command level are in HEXADECIMAL.

(2) Please note the following abbreviations:

Level 1 = 1st command level digit Level 2 = 2nd command level digit

(3) When entering commands, you can set the first command digit to 1 by
holding down an Alt key. For example, to enter command 19, position the
cursor over the second command digit and press Alt-9.

(4) In the list that follows, you’ll notice that some commands are indicated
as being Protracker compatible. When loading and saving Protracker
modules, OctaMED makes any necessary command conversions automatically.

Player commands can be split into two groups: normal commands, and MIDI
commands.

Command 00: ARPEGGIO

This command changes the pitch of the note quickly (once every tick:

It’s usually used to create special effects. If you’ve ever
listened to Commodore 64 music, you must have heard arpeggios!

The pitch is changed between three different pitches (1 to 3) during each
note. Level 1 contains the number of halfsteps between pitch 1 and pitch 2,
level 2 the number of halfsteps between pitch 1 and pitch 3.

For example, to create a C major arpeggio:

Pitch 1: C-2 (for example)
Pitch 2: E-2 = 4 halfsteps higher than pitch 1
Pitch 3: G-2 = 7 halfsteps higher than pitch 1

This produces: C-2 10047
--- 00047
--- 00047 and so on... Note that the command level with a

blank note continues the arpeggio.

As with most commands, experimentation often produces the best results. For
instance, this effect can sound pretty bad with some instruments but pretty
good with others. If the command level was 37, the arpeggio would be minor.

Commands 01 and 02: SLIDE PITCH UP and DOWN

These two commands slide the pitch of the current track up or down. They
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actually work by changing the period of the note the amount of the command
level every tick. Sounds rather technical? Dead right! It’s best to leave
the donkey work to the automatic slide creator.

Command 03: PORTAMENTO

Again a slide command, and again it’s best to use Edit menu -> Pitch Slide
-> Type 1. The difference between this and commands 01 and 02 is that the
latter replay the note they slide to: command 03 doesn’t replay the note.

The command level is the slide speed. Here’s an example:

C-2 50000 <= Note C is played
E-2 50305 <= This note isn’t played! Instead, the slide target note is
--- 00300 set to E-2 with a slide speed of 5
--- 00300 <= When the level is 00, the previous speed is used (5 here)

This example would slide from C-2 to E-2, but the slide stops exactly when
a pitch of E-2 is reached (with commands 01 and 02 you can slide beyond the
note).

Command 04: VIBRATO

Level 1 = speed, level 2 = depth. Hopefully you remember this one.

Command 05: SLIDE PITCH AND FADE (Protracker-compatible)

This command combines commands 0300 and 0Dxx. The slide continues at the
last speed entered with command 03, and the command level = the fade speed.

C-1 10000
D-3 10303 <= Slide pitch at speed 3
--- 00300 <= Continue sliding
--- 00502 <= Continue sliding + fade at speed 2 (see command 0D later)

Command 06: VIBRATO AND FADE (Protracker-compatible)

Combines commands 0400 and 0Dxx. Again, the vibrato continues at the
previous settings, and the command level is the fade speed.

Command 07: TREMOLO (Protracker-compatible)

This command is a kind of volume vibrato. Level 1 is the tremolo speed
(the higher the value, the greater the speed), and level 2 is the depth.
The depth must be quite high before the effect is detectable (try A - F).

Command 08: HOLD AND DECAY

Sets the hold and decay values for the note Level 1 is the
decay value, level 2 is the hold value.
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Command 09: SECONDARY TEMPO

This command sets the secondary tempo (the number of ticks per note:
The command level must be $01 - $20 ($ means hexadecimal).

Command 0A: VOLUME SLIDE

This is exactly the same as command 0D, for Sound/Noise/Protracker
compatibility. However, please use command 0D instead of this.

Command 0B: PLAYING SEQUENCE POSITION JUMP

This command allows you to create songs that have an introduction, which is
only played once, and a main part, which is repeated over and over again.
The command level is the entry jumped to in the playing sequence. You must,
however, remember that level 00 is the first entry, and 01 the second, so
e.g. 03 will be the fourth.

--- 00B03 <= Jump to playing sequence entry 004

Note that when more than one playing sequence is defined (i.e. sections),
the specified entry in the CURRENT playing sequence is jumped to. At
present, no command exists to jump to an entry in the section list.

Command 0C: SET VOLUME

Without doubt the most commonly-used player command. It overrides the
default volume of the instrument. For example, A-3 40C32 is
played with volume 32.

There are 65 volume levels (0 - 64): 0 = silent, 64 = maximum. You may
enter the level in either decimal or hex, depending on the state of the
cycle gadget in the Song Options window.

It’s also possible to change the volume of an already played note:

A-3 40000
--- 00000
--- 00C10 <= Change volume to 10

In addition, with this command you may actually set the default instrument
volume. The value MUST be in HEX!, and is between 80 and C0: 80 = level $0,
C0 = level $40 (hex). In other words, add 80 to the normal volume in hex.

Command 0D: VOLUME SLIDE

You can increase or decrease volume smoothly with this command. Level 1
increases the volume, level 2 decreases the volume. If both level digits
have a value greater than zero, level 2 is ignored.
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C-2 30C32 <= Sets volume to 32
--- 00D01 <= Decreases volume slightly
--- 00D01 <= Decreases volume a little more
--- 00D20 <= Increases volume back up to 32

Command 0E: SYNTH JUMP

Only applies to synthetic or hybrid instruments. It is used to trigger a
jump in the waveform sequence. The command level is the line number you
wish to jump to.

C-4 40000 <= Starts playing the synthetic or hybrid sound
--- 00000
--- 00E05 <= Jumps to waveform line number 5

Command 0F: PRIMARY TEMPO / MISCELLANEOUS

Command 0F has many different actions depending on the command level.

* Level 00: causes an immediate jump to the next entry in the playing
sequence (or to the beginning of the block if you are using Play Block).
It’s actually better to make the block shorter, as it takes less memory,
so this function mainly exists for Tracker compatibility.

* Levels 01 - F0: changes the primary tempo. Levels 01 - 0A
really exist for Tracker compatibility, but you should use command 09
instead as it’s directly compatible (but make sure primary tempo = 33).

Commands 0FF1 - 0FFF are reserved for special functions, most of which are
currently in use: 0FF1 makes a single note play twice.

Useful for creating fast rhythms.
It’s identical to command 1F03.
With a secondary tempo of 6:

C-3 20FF1 is the same as C-3 20000
C-3 20000 with double tempo (i.e. 3)

>0FF2 delays the start of a note by half a line (as long as the secondary
tempo is 6). It’s identical to command 1F30.

>0FF3 works like 0FF1 except the note is played three times! It’s identical
to command 1F02.

>0FF4 delays the note one-third of a line.

>0FF5 delays the note two-thirds of a line. Commands 0FF4 and 0FF5 can be
used, for example, to create triplets:

C-2 10000 Here, the three notes will be evenly spaced throughout
D-2 10FF4 the four lines (they’ll have a length of one-and-a-third
E-2 10FF5 lines each)
--- 00000
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The two commands only work accurately when the secondary tempo is
divisable by 3 (3, 6, 9 etc.).

>0FF8 turns the low-pass filter off.

>0FF9 turns the low-pass filter on. Commands 0FF8 and 0FF9 work like the
Audio Filter Active check box in the Song Options window.

>0FFA (MIDI only) sends the MIDI hold pedal on command.

>0FFB (MIDI only) sends the MIDI hold pedal off command.

>0FFD (doesn’t work with MIDI) causes the pitch of the previous note to be
set to the new note, but it’s not replayed.

C-1 20000 <= Play note
--- 00000
C-2 20FFD <= Don’t replay the note, just set the pitch to C-2

This is especially useful in playing long samples or samples with a
loop set (such as strings and choirs), as the undesirable "click" that
you can sometimes hear when playing a new note is eliminated.

>0FFE stops the song playing. (When used in 5 - 8-channel mode, the song’s
notes are also stopped). Can be entered by shift-clicking STOP.

>0FFF stops the note on the current track. Is almost like 0C00 with Amiga
samples, but while 0C00 sets the note’s volume to zero, 0FFF turns the
note off completely (there is a subtle difference :-).

Commands 11 and 12: SLIDE PITCH UP and DOWN ONCE (Protrack. cmds E1 / E2)

Whereas commands 01 and 02 change the pitch on every tick, these commands
only change the pitch on the first tick of each line (greater accuracy).

Command 14: PROTRACKER-STYLE VIBRATO

As command 04, except command 14’s depth levels produce exactly half the
depth as command 04. Protracker pioneered this more accurate command.

Command 15: SET FINETUNE

Overrides the instrument’s default finetune value.

Since these are hex numbers, negative numbers must be entered as follows:

-1 => FF -3 => FD -5 => FB -7 => F9
-2 => FE -4 => FC -6 => FA -8 => F8

C#3 21503 <= Finetune +3
D-2 315F8 <= Finetune -8
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Command 16: LOOP (Equivalent to Protracker command E6)

This interesting command enables you to set up a loop within a block.

>004 C-3 11600 <= Command level = 00: mark loop beginning
>005 D#2 10000
>006 --- 11603 <= Command level = 03: repeat this section three times

When the loop has finished, the block continues. You can’t nest loops!

Command 18: CUT NOTE (Equivalent to Protracker command E8)

Almost like hold (command 08), except it sets the volume to zero instead of
actually switching the note off. (Much the same as the difference between
commands 0C00 and 0FFF). The command level must be less than the secondary
tempo for the command to function.

Command 19: SAMPLE START OFFSET (Protracker command 9)

When playing a sample, this command sets the starting byte in steps of 256
bytes (= $100 in hex). Useful for speech samples.

C-2 11904 <= Play the sample starting at byte $400 = 1024

Commands 1A and 1B: SLIDE VOLUME UP / DOWN ONCE (Protracker EA / EB)

Whereas command 0D changes the volume on every tick, these commands
only change the volume on the first tick of each line (for greater
accuracy).

Command 1D: JUMP TO NEXT PLAYING SEQUENCE ENTRY (Protracker command D)

But doesn’t command 0F00 jump to the next entry? Quite right. But with
this command you can specify the line number of the first line to be
played. The line number is (as usual) given in hex.

--- 01D0A <= Jump to next playseq entry, and start at line 010 (skip
000 - 009)

Command 1E: REPLAY LINE (Protracker command EE)

Replays the commands (not the notes) in the current line the specified
number of times.

Command 1F: NOTE DELAY AND RETRIGGER (Protracker commands EC and ED)

Gives you accurate control over note playing. You can delay the note any
number of ticks, and initiate fast retrigger. Level 1 = note delay value,
level 2 = retrigger value.
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C-2 11F20 <= Delay 2 ticks || C-2 11F02 <= Retrig every second tick
||

=> pulse 0 --- || => pulse 0 C-2
> 1 --- || 1 ---
> 2 C-2 || 2 C-2
> 3 --- etc. || 3 ---

|| 4 C-2 etc.

Command 0FF1 is equivalent to 1F03, 0FF2 to 1F30, and 0FF3 to 1F02.

==========> MIDI COMMANDS <==========

This section is a bit like an "erratum" for MIDI, in that it describes the
changes to the above command descriptions required for MIDI use.

Commands 0B, 0F, 16, 1D, 1E, and 1F all work identically with MIDI to Amiga
instruments. Commands 15, 18, 19, 1A, and 1B have no effect with MIDI.

If you are unfamiliar with any of the MIDI terms used in this section,
please consult your MIDI device’s manual.

Commands 05 and 00: CONTROLLER NUMBER and CONTROLLER VALUE

These two commands allow you to change any MIDI controller
(command $Bx nn vv, where nn = controller number, vv = value).

Firstly, set the controller number you wish to change with command 05.
Then, select the value with command 00. Subsequent uses of command 00 will
affect the controller previously set with command 05. Remember that each
MIDI channel has its own controller number.

If you need to use a controller value of $00, you can’t use 00 as a command
level because command 0000 means do nothing. Instead, use level 80.
Acceptable controller numbers are $00 - $7F, and values $01 - $80.

Assuming instrument 03 is set to MIDI channel 1:

C-2 30000
--- 00507 <= Controller $07 = volume (according to the MIDI standard)
D-2 3007F <= Sets max. volume ($7F). Command $B0 07 7F is sent
--- 00000
F-3 30001 <= Low volume ($01)
--- 0055C <= Sets controller $5C (tremolo depth)...
G-4 30080 <= ...to 0 (note: level $80 = value $00)

Commands 01 and 02: PITCHBENDER UP / DOWN

These commands "turn" the pitchbender 8 x command level steps up or down on
every tick. Sounds a bit technical? Indeed, but unfortunately automatic
slide making cannot be used. Because the ranges of pitchbenders differ with
various MIDI instruments, you must find the right value by experimenting.
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The pitchbender isn’t automatically reset when a new note is played. To
reset it, issue the command again with a level of 00.

C-2 101FF <= Turns the pitchbender up very quickly...
--- 00000
--- 00100 <= ...then resets the pitchbender

Commands 03 and 13: SET PITCHBENDER

With these commands you may set the pitchbender to an exact value, instead
of sliding as with commands 01 and 02. The command level is the pitchbender
value, expressed as a signed hexadecimal
digit $00 = center position, $80 (-7F) = smallest value,
and $7F = largest value

The two commands are identical, except that command 13 can be used when
there’s a note next to the command: command 03 cannot.

C-2 31380 <= Sets pitchbender to maximum value: use cmd 13 beside notes
--- 0037F <= Sets pitchbender to minimum value
--- 00300 <= Resets pitchbender

Command 04: MODULATION WHEEL

Affects the current MIDI channel’s modulation wheel. (Modulation is usually
vibrato). The command level can be $00 - $7F: $00 = no modulation,
$7F = maximum. Values $80 - $FF don’t currently function.

Command 08: SET HOLD ONLY

Just to underline that decay can’t be used with MIDI instruments. (This is
because with MIDI, the volume of an already played note can’t be altered).

Command 0A: POLYPHONIC AFTERTOUCH

Changes the polyphonic aftertouch of the most recent note. (Aftertouch is
squeezing a key down harder than when it was initially pressed). The value
should be $00 - $7F.

Command 0C: SET VOLUME

Again, just to underline that the volume of a note can’t be changed after
it has been played (as it can with Amiga samples). The normal Amiga sample
volume range of 0 - 64 is converted to the MIDI range of 0 - 127.

Command 0D: CHANNEL PRESSURE

Sends a channel pressure (channel aftertouch) message using the most
recently used channel. The argument should be $00 - $7F.



PREFACE 153 / 175

Command 0E: PAN CONTROL

Controls the stereo location of the note. The command level can be 00 - 7F.

left mid right
| | |

Level: 00 3F 7F

Command 10: SEND MIDI MESSAGE

Sends a MIDI message, created using the MIDI message editor. The command
level is the message number. Note that with this command the first message
is number 0, so you need to subtract one to convert the message number from
the message editor for use with this command.

C-2 11000 <= Sends the first message, then plays note C-2 (messages are
always sent before notes)

MIDI timing pulses are sent immediately even if a message is being sent.

Command 1C: CHANGE MIDI PRESET

Changes the current instrument’s MIDI preset number. As with all commands
which modify the song parameters, you should be very careful when using
this command in multi-modules:

That’s all the commands OctaMED currently has. The main point, I feel, is
that you must experiment with each command until you are happy with each
of them. After you’ve tried them all out, you can push aside the ones
you’re not so keen on and concentrate on perfecting the ones you do like.

* The author would like to thank Richard Bannister (the MED Users Group co-
ordinator) for permission to borrow some ideas from the OctaMED Commands
series run in MUG’s disk magazine, Total Irrelevance. Thanks a lot!

1.99 Commands Quick reference

Player commands - Quick reference

Type(s) | Name | Command level (lvl = level)
---------+-----------------------------+------------------------------
| 00 | Arpeggio | Lvl 1: 1st pitch, lvl 2: 2nd
|01 / 02 | Slide pitch up / down | Pitch slide speed
| 03 | Portamento | Pitch slide speed
| 04 | Vibrato | Lvl 1: speed, lvl 2: depth
| 05 | Slide pitch and fade | Fade speed
| 06 | Vibrato and fade | Fade speed
| 07 | Tremolo | Lvl 1: speed, lvl 2: depth
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| 08 | Hold and decay | Lvl 1: decay, lvl 2: hold
| 09 | Secondary tempo | Tempo value
| 0A | Volume slide | Volume slide speed
| 0B | Playseq position jump | Position to jump to - 1
| 0C | Set volume | (Default) volume level
| 0D | Volume slide | Volume slide speed
| 0E | Synth jump | Waveform seq. line number
| 0F | Primary tempo / Miscell. | Various
|11 / 12 | Slide pitch up / down once | Pitch slide speed
| 14 | Protracker-style vibrato | Lvl 1: speed, lvl 2: depth
| 15 | Set finetune | Finetune value (signed hex)
| 16 | Loop | Number of times (00 = start)
| 18 | Cut note | Number of ticks
| 19 | Sample start offset | Starting byte - 256
|1A / 1B | Slide volume up / down once | Volume slide speed
| 1D | Jump to next playseq entry | Starting line number
| 1E | Replay line | Number of times
| 1F | Note delay and retrigger | Lvl 1: delay, lvl 2: retrig.
---------+-----------------------------+------------------------------

M I D I C O M M A N D S
---------+-----------------------------+------------------------------
|05 / 00 | Controller number / value | Controller number / value
|01 / 02 | Pitchbender up / down | Pitchbend speed
| 03 | Set pitchbender | Pitchbend value (signed hex)
| 04 | Modulation wheel | Modulation level ($00 - $7F)
| 08 | Set hold only | Lvl 1: unused, lvl 2: hold
| 0A | Polyphonic aftertouch | Aftertouch level ($00 - $7F)
| 0D | Channel pressure | Pressure level ($00 - $7F)
| 0E | Pan control | Pan value ($00 - $7F)
| 10 | Send MIDI message | Message number - 1
| 1C | Change MIDI preset | New preset number

1.100 Keyboard shortcuts

IMPORTANT NOTE FOR USERS OF NON-U.S. AND NON-BRITISH KEYBOARDS

The keyboard layout used in this tutorial corresponds to the standard U.S.
keymap (and, by coincidence, to the British keymap). Users of other
keyboards, therefore, have slight changes to make to the keys given:

A = Q on a French keyboard (and vice-versa)
Z = W on a French keyboard, and Y on a Swiss or German keyboard (and v-v)

Key(s) Position is immediately... | Key(s) Position is immediately...
-----------------------------------+------------------------------------

| ~ Below Esc | [ and ] Right of P
| \ Left of Backspace | < and > Right of M (except French:
| = As + (see below) | right of ,)
| / Left of Right Shift | , and . Same as < and > above
| - and + Right of 0 (zero) |

* Note that these changes DON’T apply to menu or gadget shortcuts. For
example, to open the Input Map Editor window using a French keyboard,
hold down the Right Amiga key and press the normal A key (immediately to
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the right of Tab).

Sorry about this inconvenience...

Menu item and gadget shortcuts

Note that the following gadget shortcuts can also be thought of as
menu item shortcuts (with the main screen active):

Shortcut Opens which window | Shortcut Opens which window
----------------------------------+--------------------------------------
Left Alt-B Block List | Left Alt-I Instrument Parameters
Left Alt-C Section List | Left Alt-Q Playing Sequence
Left Alt-E Sample Editor | Left Alt-T Instrument Type
Left Alt-G Song Selector | Left Alt-Y Synthetic Sound Editor

Editing shortcuts

These shortcuts are used in editing with the Tracker editor.
Note: *NEW* means that this shortcut is new to OctaMED version 5. (Thanks
to Nico FrangÀois for the idea!)

Esc Edit mode on/off

*NEW* Shift-Esc Chord mode on/off
~ Space mode on/off

Del Delete note or command digit under cursor
Shift-Del Delete note and command digits
Alt-Del Delete only command digits

*NEW* Left Amiga-Del Delete chord. When L-Amiga is held down, every time
you press Del the note under the cursor is deleted and the cursor
moves to the next selected track. When L-Amiga is released, the
cursor advances (as defined in the Keyboard Options window).

Return or A Insert hold symbol (-|-)
Shift-Return Insert hold symbols to all tracks of the previous

chord

*NEW* F Insert / play note at default pitch

Backspace Delete note and move following notes up
Shift-Backsp Insert empty note slot
Alt-Backspace Delete current track
Alt-Shift-Bksp Insert new track

Shift- 0 - 9 Enter programmable key 0 - 9 (Note: with Caps Lock
on, progkeys may be entered without holding the Shift key)

Shift-Ctrl-0-9 Pick note under cursor as programmable key 0 - 9

Tab Highlight current line

*NEW* Ctrl-O Create volume slide (using command C)

*NEW* Shift-Ctrl-O Create generic slide (using any command)
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*NEW* Ctrl-T Create type 1 slide (using command 3)

*NEW* Shift-Ctrl-T Create type 2 slide (using commands 1 and 2)

*NEW* Shift-Alt-X Cut block

*NEW* Shift-Alt-C Copy block

*NEW* Shift-Alt-V Paste block

*NEW* Ctrl-Z Erase range
Ctrl-X Cut range
Ctrl-C Copy range
Ctrl-V Paste range

*NEW* Shift-Ctrl-V Paste to selected tracks

*NEW* Ctrl-B Range current track

*NEW* Shift-Ctrl-B Range current block

*NEW* Ctrl-J Join block with next

*NEW* Shift-Ctrl-J Split block at cursor

*NEW* Ctrl- < Swap note under cursor with following note, taking
account of the current spacing value

*NEW* Ctrl- > Swap notes on adjacent tracks

*NEW* Ctrl-K Kill notes to end of track

*NEW* Shift-Ctrl-K Kill notes to end of block

*NEW* Alt-Ctrl-K Kill notes to end of block and actually remove the
deleted part of the block. In other words, the
current line becomes the last line of the block.

Cursor movement shortcuts

These shortcuts allow cursor movement in the Tracker editor. The cursor
keys move the cursor one place up/down/left/right.

Alt-<left> Cursor to previous track
Alt-<right> Cursor to next track

Ctrl-<left> Previous screenful of tracks
Ctrl-<right> Next screenful of tracks

*NEW* Shift-Ctrl-<left> Cursor to track 0

*NEW* Shift-Ctrl-<right> Cursor to last track

Shift-<up> Previous block
Shift-<down> Next block
Left Alt-<up> First block (Can’t use R.Alt to avoid accidental
Left Alt-<down> Last block jump when using Alt-<left>/<right>)

*NEW* Ctrl-NM( Previous song (NM = numeric keypad)

*NEW* Ctrl-NM) Next song / Add song

*NEW* Shift-Ctrl-NM( Delete last song

*NEW* Shift-Ctrl-NM) Add song with no confirmation requester

F6 Cursor to first line of block
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F7 Cursor to second quarter of block
F8 Cursor to middle of block
F9 Cursor to last quarter of block
F10 Cursor to last line of block

*NEW* Alt-Ctrl-<left> Go to where sample previously appeared in the
song. The sample number is taken from either the
number under the cursor, or (if that is
--- 00000) from the current instrument number.

*NEW* Alt-Ctrl-<right> Go to where sample next appears in the song

Other shortcuts

Shift-Alt-Space Play song Remember that you may also use
Shift-Space Continue song the Left Alt shortcuts
Amiga-Space Play block underlined in the playing
Alt-Space Continue block buttons (upper screen, top left)
Space bar Stop playing
Ctrl-Space bar Reset MIDI presets / pitchbenders / mod. wheels

Shift-<left> Previous sample
Shift-<right> Next sample
Alt-Shift-<left> 16 samples backward
Alt-Shift-<right> 16 samples forward

*NEW* Shift-Ctrl- < Previous free sample slot

*NEW* Shift-Ctrl- > Next free sample slot

F1 - F5 Select octaves 1+2 - 5+6 in normal mode,
3+4/2+3/1+2 - 7+8/8+9/9+A in MIDI mode (pressing F1 and F5
repeatedly cycles through several octaves)

*NEW* Ctrl- - (minus) Decrease primary tempo

*NEW* Ctrl- + (plus) Increase primary tempo

*NEW* Shift-Ctrl- - Decrease secondary tempo

*NEW* Shift-Ctrl- + Increase secondary tempo

*NEW* Ctrl-I Insert new block

*NEW* Shift-Ctrl-I Insert new default block

*NEW* Ctrl-N Append new block

*NEW* Shift-Ctrl-N Append new default block

*NEW* Ctrl-D Delete current block

*NEW* Shift-Ctrl-D Delete last block

*NEW* Ctrl-S Save IFF instrument

*NEW* Shift-Ctrl-S Save raw instrument

*NEW* Ctrl-G Flush current instrument

*NEW* Shift-Ctrl-G Flush all unused instruments

Ctrl-A Automatic Advance Down (Keyboard Options) on/off
Ctrl-F Display free memory

*NEW* Alt-~ Set spacing value to length of current range - 1.
For example, marking a range from 000 - 002 sets spacing to 2.
(It’s logical to subtract 1 since with a spacing of 2, the cursor
skips from line 000 to 002 which is 3 lines long).
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The following shortcuts apply to the numeric keypad, and all affect the
playing sequence (note: playseq = playing sequence).

Shortcut Effect | Shortcut Effect
------------------------------------------+------------------------------
Ctrl-4 Decrease current playseq entry | Ctrl-8 Scroll playseq up
Ctrl-6 Increase current playseq entry | Ctrl-2 Scroll playseq down
Ctrl-5 Insert current block to playseq | Ctrl-7 Top of playseq
Ctrl-0 Duplicate current playseq entry | Ctrl-1 Bottom of playseq
Ctrl-. Delete current playseq entry |

Note that with the Caps Lock on, the above playseq shortcuts can be used
without holding down the Ctrl key.

* In numeric/text boxes: Ctrl-U = delete to start, Ctrl-K = delete to end,
Amiga-Q = restore contents, Shift-<left>/<right> = cursor to start / end

1.101 Hexadecimal values

Hexadecimal values

Introduction

Hexadecimal (or "hex" for short) is basically just a different way of
representing numbers. It is more convenient for the computer because of the
way it works, and allows the user to specify a greater range of numbers
using the same amount of digits.

Hex values are used in the player commands, synth editor, the secondary
tempo, and the MIDI message editor. So they’re quite important in OctaMED
(and also in general computing).

==> In the usual decimal system, a digit can be ten different
values: 0, 1, 2, 3, 4, 5, 6, 7, 8 or 9.

In the hex system, however, a digit may have sixteen
values: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E or F.
The decimal numbers 10 - 15 are represented by the letters A to F:

Decimal 10 = A
> 11 = B
> 12 = C
> 13 = D
> 14 = E
> 15 = F

With two digits in a number, the decimal system can represent 10 x 10 = 100
different values. The hex system, however, can represent 16 x 16 = 256
values: well over twice the amount of the decimal system. (The lowest hex
number is 00 = zero, and the highest is FF = 255 decimal).

Converting between the two systems
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So although it feels strange to work in at first, it has its advantages. In
a two digit hex number (e.g. 8A), the first digit represents multiples
of 16. So, to convert a two-digit hex number to decimal:

Decimal number = (Hex digit 1) x 16 + (hex digit 2)

And to convert decimal to hex, divide the decimal number by 16. The
quotient is hex digit 1, the remainder is hex digit 2.

For example:

Hex 8A -> decimal:

Hex digit 1 = 8, hex digit 2 = A (10).

Decimal number = (8 x 16) + 10 = 106.

Decimal 200 -> hex:

> 200 devided by 16 = 12 remainder 8.

Hex digit 1 = C (12), hex digit 2 = 8.

So hex number = C8.

Hex numbers are sometimes distinguished from decimal numbers by preceding
hex with a $ sign. For example: $C8, $FF.

Signed hexadecimal

There is a further complication! Luckily in OctaMED you’ll only need to use
this in two player commands: MIDI commands 03+13 (set pitchbender) and
command 15 (set finetune).

The sign of a number denotes whether the number is positive or negative:
that is, the + and - signs.

In hexadecimal, however, there are no - signs. So, negative numbers are
represented by positive numbers (it will become clearer!).

==> In signed hex, the numbers $00 - $7F are positive as usual: they
represent the decimal numbers 0 - 127. However, the numbers $80 - $FF
represent the decimal values -1 to -128:

Decimal -1 = $FF
-2 = $FE
-3 = $FD
-4 = $FC etc.

-16 = $F0
-17 = $EF
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-18 = $EE etc.

-126 = $82
-127 = $81
-128 = $80

So to convert negative decimal numbers to signed hex numbers, first add 256
to the number, then convert to hex as above. For example:

Decimal -67 -> signed hex:

-67 + 256 = 189.

> 189 devided by 16 = 11 remainder 13.

Hex digit 1 = 11 (B), hex digit 2 = 13 (C)

So signed hex number = $BC.

Hex numbers will crop up in many areas of computing, so if you’ve never
worked with them before, it’s a good idea to get used to them!

1.102 Synthetic Language Commands

The Synthetic Sound Programming Language Commands

In this appendix, Keypress: refers to the keypress needed to enter each
command.

Commands that can be used in either sequence

(1) Command: END Keypress: n/a Name: End sequence

This command marks the end of each sequence, and always exists. You can’t
insert other commands below the END command. Press the Return key while
the cursor is on this command to create a new position at the end of the
sequence.

(2) Command: HLT Keypress: H Name: Halt

HLT has the same effect as the END command, but it can be inserted anywhere
in either sequence (not just at the end). For example:

> 03 HLT
> 04 04 <= other instructions (could be accessed with the JMP

command, for example: see next command)

(3) Command: JMP Keypress: J Name: Jump

The JMP command jumps to another position in the sequence in which it
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resides. Used to skip sections or to create repeated sections. For example:

> 05 JMP
> 06 0A <= Jump forward to line 0A

(4) Command: WAI Keypress: W Name: Wait

Pauses for a specified number of ticks. Can be $01 - $7F. (For a memory
refresh on ticks.

> 03 WAI
> 04 10 <= Wait for 16 ticks ($10 = 16 decimal)

(5) Command: SPD Keypress: S Name: Set execution speed

Sets the execution speed of the appropriate sequence.

> 0A SPD
> 0B 01 <= speed 1 (quickest)

Volume sequence commands

(1) Command: n/a Keypress: n/a Name: Set volume

This is the default command (no command name is required: only a value).
It sets the volume of the synthsound, and is like player command 0C
It should be 00 - 40 in hex as usual. Note that the relative track
volumes (Song menu) cannot be used with synthsounds.

> 00 20 <= Volume set to $20 (half volume)
> 01 10 <= Volume set to $10 (quarter volume)

(2) Command: CHD Keypress: D Name: Set volume change down speed
(3) Command: CHU Keypress: U Name: Set volume change up speed

These two commands set the speed at which the volume changes on each tick.
The volume starts changing directly after the command. To stop the volume
slide, issue the command again with the speed set to 00.

> 00 CHD <= Decrease the volume...
> 01 05 <= ...at speed 5

... 0A CHD
> 0B 00 <= Stop the volume slide (speed = 0)

(4) Command: JWS Keypress: Shift-J Name: Jump waveform sequence

Causes a jump in the waveform sequence. This can, for example, trigger a
pitch change at the end of the volume sequence. It’s identical to using the
JMP command in the waveform sequence.

> 04 JWS
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> 05 0F <= Jump to line 0F in the waveform sequence

(5) Command: EN1 Keypress: E Name: Once-only volume shape
(6) Command: EN2 Keypress: Shift-E Name: Repeating volume shape

These commands allow you to set the synthsound’s volume shape. You draw the
volume shape on the left-hand waveform display, then use the EN1 or EN2
command to set it. So if you’ve drawn the volume shape in waveform 01, use
the following:

> 10 EN1 <= (Or EN2)
> 11 01 <= Set volume shape to waveform 01

The further down a point on the volume shape is, the louder the volume.
Consider this volume shape:

+------------+ <== no volume (0)
| \ / |

Left-hand | \ / |
waveform -> | \ / |
display | \ / |

| \/ |
+------------+ <== full volume (64)

In this example, the volume will gradually increase to maximum, then fade
away to nothing. You can change the volume shape’s speed using the SPD
command . The volume is actually set to full (64) before the
volume shape begins (so if the shape starts at no volume, you may hear a
small "click"). The volume shape waveform must always be 128 bytes long.

The difference between EN1 and EN2 is that EN1 only plays once (then
stops), whereas EN2 repeats continuously. (The "EN" is an abbreviation of
envelope, which you must admit is a peculiar name for a volume shape... :).

Waveform (and pitch) sequence commands

(1) Command: n/a Keypress: n/a Name: Set waveform

This is the default command (no command name is required: only a value). It
is used to indicate the waveform number (starting from 00). One of these
commands (and a set volume command in the volume sequence) must always
exist for the synthsound to be heard. Don’t use waveform numbers that are
higher than the actual number of the last waveform.

> 00 00 <= waveform 00
> 01 01 <= waveform 01

(2) Command: CHD Keypress: D Name: Set pitch change down speed
(3) Command: CHU Keypress: U Name: Set pitch change up speed

These two commands set the pitch sliding speed. The pitch starts changing
directly after the command. To stop the pitch slide, issue the command
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again with the speed set to 00.

> 00 CHD <= Slide pitch downwards...
> 01 03 <= ...at speed 3

(4) Command: JVS Keypress: Shift-J Name: Jump volume sequence

Causes a jump in the volume sequence, to trigger volume changes after
particular waveform instructions. It’s identical to using the JMP command
in the volume sequence.

> 09 JVS
> 0A 00 <= Start the volume sequence from the beginning

(5) Command: RES Keypress: R Name: Reset pitch

Resets the pitch of the note to its original pitch (after a pitch slide).

(6) Command: ARP Keypress: A Name: Start arpeggio definition
(7) Command: ARE Keypress: E Name: End arpeggio definition

With these commands you can produce an arpeggio, much like player
command 00 except that you can define more than three pitches.
The arpeggio begins directly after the ARE command (every ARP command
must have a corresponding ARE command).

For example, to produce a "dominant 7th" chord (e.g. C-2, E-2, G-2, A#2):

> 03 ARP <= Start arpeggio definition
> 04 00 <= Pitch 1
> 05 04 <= Pitch 2 (C-2 -> E-2 = 4 halfsteps)
> 06 07 <= Pitch 3 (C-2 -> G-2 = 7 halfsteps)
> 07 0A <= Pitch 4 (C-2 -> A#2 = 10 halfsteps)
> 08 ARE <= End arpeggio definition

(8) Command: VBS Keypress: Shift-V Name: Set vibrato speed
(9) Command: VBD Keypress: V Name: Set vibrato depth

These commands are used to produce vibrato, much like player command 04
Both the speed and the depth can be $01 - $7F. You need to
set both speed and depth before vibrato can occur, and a value of 00 with
either command turns vibrato off.

> 02 VBD
> 03 04 <= Depth set to 4
> 04 VBS
> 05 30 <= Speed set to 30

(10) Command: VWF Keypress: Shift-W Name: Set vibrato waveform
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Sets the vibrato shape. It should always be 32 bytes long. Same idea as the
volume shape commands , but this time the further down a
point on the vibrato shape is, the higher the pitch. Note that the shape is
actually played backwards, so use the Range All and Reverse buttons to
reverse it. By default, a sine wave vibrato shape is used.

> 00 VBD
> 01 06
> 02 VBS
> 03 40
> 04 VWF
> 05 04 <= Now uses waveform number 04 as vibrato shape

The author would like to thank Michael Richmond for permission to borrow
ideas from his No Sampler: Part 3 tutorial featured in Total Irrelevance
issue 4. Thanks Mike!

1.103 The settings file

The settings file

The settings file is saved by choosing Settings menu -> Save Settings.
The following options are saved (values in brackets are default):

(1) Save Options window: || 2) Mouse Options window:
||

* Save Secondary Data (ON) || * Left Button (SELECT RANGE)

* Create Icons (ON) || * Middle Button (NO OPERATION)

* Save Notation Data (OFF) || * Right Button (NO OPERATION)

(3) The Save Timer value (0) || 4) Follow gadget in Playing Sequence (OFF)

(5) Sample Editor: [ 6) Auto-Terminate Capture in MIDI message ed. (ON) ]

* Line display (ON) || * Sampler Voice Monitor (OFF)

* Pixel display (OFF) || * Pitch period (428)

* Pixel Density (2) || * Don’t Clip (Change Volume) (OFF)

(7) Keyboard Options window:

* Advance Line (DOWN) || * Chord Reset (ON)

* Advance Track (DON’T ADVANCE) || * Space = DEL (OFF)

* Advance Cursor (DON’T ADVANCE) || * Protracker Shortcuts (OFF)

* Keypad Mode (TRACKS ON/OFF) || * Advance with sound (OFF)

* Keypad Mapping (ALTERNATIVE) || * Destructive Spacing (ON)

* Space Value (2) || * Auto-round Spacing (ON)

(8) Palette window: [ 9) Note killing options in the MIDI menu ]

* The color scheme (WORKBENCH COLORS) || * Palette Type (8-Bit)

(10) Settings menu: || 11) Instr menu:
||
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* Display Max Tracks (16) || * Automatic Flush (OFF)

* Equalizers (both ON) || * Add Path (OFF)

* H -> B (ON) || * Remove Path (OFF)

* Auto-Freeze Screen (OFF) ||

In addition, OctaMED will save the current window positions (both shrunk
and unshrunk) if you have moved them from their usual places.

1.104 8-channel limitations

8-channel mode limitations

The 5 - 8-channel mode works by mixing two samples in real time and then
outputting them through one sound channel. This takes up a lot of the
processor’s time, and the mixing process reduces the sound quality (causing
distortion). You can reduce the distortion using High Quality Mode or, as a
last resort!, using the audio filter (both selectable in the Song Options
window).

The processor load that 5 - 8-channel playing causes, and some technical
reasons set some limitations to playing in these modes:

(1) Different playing speed selection. Use the secondary tempo as usual,
but use primary tempo values 1 - 10.

(2) Synthetic and hybrid sounds can’t be used

(3) All equalizers are disabled

(4) All MIDI features are disabled

(5) Instrument default volume and Decay values are ignored, as are the
relative track volumes (Song menu)

(6) Limited sample loop length, only in a minimum of 200-byte steps (when
the primary tempo is 1). Every time the primary tempo is increased by
one, the loop length byte-steps increases by 20. So with a primary
tempo of the maximum 10, the length is set in 400-byte steps.

In addition to this, samples should be halved. This means that each
sample’s volume should be half of its normal volume, so that they can be
mixed with the minimum of distortion. The halving is done automatically
when changing channel mode (answer Halve in the requester).

The sound channels that play these mixed samples are called paired
channels. In eight-channel mode all channels are paired, but in five-
channel mode only one channel is paired, allowing better quality samples on
tracks 1 - 3. You may use non-halved samples on non-paired channels, but
attempting to use non-halved samples on paired channels when two notes are
played simultaneously usually creates awful noise.

The channel configuration in each of the channel modes is as follows:
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( P: paired, N: non-paired, (L): left speaker, (R): right, -: unused )

Channels 0 1 2 3 4 5 6 7
+-------+-------+-------+-------+-------+-------+-------+-------+-------+
| 4 | N (R) | N (L) | N (L) | N (R) | - | - | - | - |
| 5 | P (R) | N (L) | N (L) | N (R) | P (R) | - | - | - |
| 6 | P (R) | P (L) | N (L) | N (R) | P (R) | P (L) | - | - |
| 7 | P (R) | P (L) | P (L) | N (R) | P (R) | P (L) | P (L) | - |
| 8 | P (R) | P (L) | P (L) | P (R) | P (R) | P (L) | P (L) | P (R) |
+-------+-------+-------+-------+-------+-------+-------+-------+-------+

Note that 5 - 8-channel mode does not mean how many tracks there are. You
must also select 5 - 8 tracks in the Block Properties window.

For best results, you shouldn’t use more channels than you need. If, for
example, your song doesn’t use more than six tracks at once, you should
select 6-channel mode instead of 7 or 8-channel mode. This gives you
two non-paired (i.e. high quality) tracks to play with.

If you load additional samples while in 5 - 8-channel mode, OctaMED usually
halves them automatically. However, if you’d like to load non-halved
samples for use on non-paired channels, you can override automatic halving.
To do so, hold down the Shift key when:

(a) clicking on a sample name in the Load Instrument Window
(b) clicking Load Inst in the Sample List Editor window
(c) selecting Load Instrument(s) from the Instr menu (or Shift-Amiga-I)
(d) clicking the Getfile gadget on the upper screen’s top row

Volume limitations

Because there are only 4 sound channels and 4 volume registers, paired
channels must each share a volume register: tracks 0 and 4, 1 and 5, 2
and 6, and 3 and 7. This means that all volume-changing player commands
(05, 06, 0C, 0D, 1A and 1B) affect two tracks. For example:

Track: 0 1 2 3 4
000 C-1 30000 E-1 30000 G-1 30000 --- 00000 A#2 50C20

The 0C20 command on track 4 affects both tracks 4 and 0. Instrument default
volume is ignored for this reason (it could cause a bit of havoc ;-).

1.105 The numeric keypad

The numeric keypad settings

In OctaMED, there are four different ways in which the numeric keypad can
be used: two modes, and two mappings. Which way you require is set using
the two cycle gadgets in the Keyboard Options window.
The following diagrams show the track or instrument number each keypad key
affects in each of the modes and mappings. (Thanks for the idea, Larry!)

The keypad | Normal mapping
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|
+---+---+---+---+ | +---+---+---+---+ +---+---+---+---+
| ( | ) | / | * | | | 0 | 1 | 2 | 3 | | 01| 02| 03| 04|
+---+---+---+---+ | +---+---+---+---+ +---+---+---+---+
| 7 | 8 | 9 | - | | | 4 | 5 | 6 | 7 | | 05| 06| 07| 08|
+---+---+---+---+ | +---+---+---+---+ +---+---+---+---+
| 4 | 5 | 6 | + | | | 8 | 9 | A | B | | 09| 0A| 0B| 0C|
+---+---+---+---+ | +---+---+---+---+ +---+---+---+---+
| 1 | 2 | 3 | E | | | C | D | E | | | 0D| 0E| 0F| |
+---+---+---+ n + | +---+---+---+ | +---+---+---+ |
| 0 | . | t | | | | F | | | | 0G| |
+---+---+---+---+ | +-------+---+---+ +-------+---+---+

-----------------------+
Mode: Tracks On/Off Select Instruments

Default setting
||
|| Alternative mapping
\/ Abbreviations

+---+---+---+---+ +---+---+---+---+
| A | B | C | D | |VUp|VDn|Lst|Ner| VUp: default volume up 1 step
+---+---+---+---+ +---+---+---+---+ VDn: default volume down 1 step
| 7 | 8 | 9 | | | 7 | 8 | 9 |Prv| Lst: last used instrument
+---+---+---+---+ +---+---+---+---+ Ner: instr. nearest edit cursor
| 4 | 5 | 6 | | | 4 | 5 | 6 |Nxt| Prv: previous instrument
+---+---+---+---+ +---+---+---+---+ Nxt: next instrument
| 1 | 2 | 3 | S | | 1 | 2 | 3 | A | Swt: switch 1st instr. digit
+---+---+---+ e | +---+---+---+ t | (e.g. 05 -> 15, 15 -> 05)
| 0 |Clr| t | | 10 |Swt| V | AtV: press Enter then key A - V
+-------+---+---+ +-------+---+---+ to select that instrument

Tracks On/Off Select Instruments

1.106 Song file formats

Song file formats

In the Save Options window, the File Format radio button selects which song
file format to use when saving. Options are:

==) MMD2 (OctaMED V5): This format is new to V5, and supports multiple
playing sequences (sections) and 1 - 64 tracks. If the song requires
either of these features, this gadget is selected when the Save Options
window is opened.

MMD1 (OctaMED V3-V5): This is the V3 - V5 format, so is (of course)
compatible with these versions. If MMD2 format is not required, this
gadget is selected on opening the Save Options window.

MMD0 (MED & OctaMED): The pre-OctaMED V3 format, introduced in MED
V2.10. Files saved in this format lack the following:

(1) 2-digit player command types (the first digit is always zero)
(2) Notes above D-6 (replaced by a keep-holding symbol (-|-))
(3) Block names
(4) Line highlighting
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Tracker Module: Sound/Noise/Protracker format, used to export modules
to other tracker programs. However, since OctaMED supports many
functions that trackers do not, some information may be lost, and some
of this information appears in a requester before saving. (See below
for full details of the lost information).

With MMD1 and MMD0 songs, song sections are converted into one long playing
sequence, by ordering the sections in the arrangement defined by the
section list. Songs requiring MMD2 format can be saved almost perfectly
under MMD1 (only song sections aren’t saved, as described above). MMD0
modules are always saved with instruments (even if Save Instruments is
switched off).

Even options new to V5 (Loop On check box, ExtSamples, default pitch,
extended MIDI preset, 1 - 64 tracks) are properly saved under MMD1 and
MMD0. (Although 1 - 64 tracks are correctly saved, however, pre-V5 versions
of OctaMED will probably crash if such modules are loaded).

The further down the File Format button you go, the simpler the format
becomes, and therefore the smaller the file produced. So for example, if
you don’t require notes above D-6, block names, line highlighting, song
sections or two-digit commands to be saved, you should choose the MMD0
format, since it produces a smaller file than either MMD1 or MMD2.

Tracker Module format

There is a substantial amount of information lost if you choose to save in
Tracker Module format. This information is:

** Synthetic, hybrid and MIDI instruments

** Multi-octave samples (including ExtSamples)

** Some block contents (no lines above 64, no tracks above 4, no notes
above B-3)

** Player commands 08, 0E and 10

** Instruments above 0V

* All instrument parameters apart from Repeat and RepLen (Loop On,
Transpose, Finetune, ** Hold and Decay, default volume, MIDI
parameters)

* Multi-modules (only the current song will be saved)

* 5 - 8 channels

* Song sections (converted to one long playing sequence as described
earlier)

* MIDI messages, the state of the MIDI Active menu item

* Relative track volumes

* Block names

* Line highlighting

* Annotation text

* Notation Editor data

* Decimal / Hex Volumes (converted to hex volumes)

(The information which is given in the requester brought up when trying to
save a Tracker module is marked above with a **).

Note that the resulting file is a 31-instrument module, incompatible with
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Tracker programs only supporting very old 15-instrument modules.

Protracker commands ( for those that are still out of date ) ;-)

Many player commands are converted when saving Tracker modules and loading
Protracker modules. They are:

OctaMED comm. | Protr. command | OctaMED comm. | PT comm.
---------------+----------------+---------------+------------------------

> 0D | A | 18 | EC
> 0FF8 | E11 | 19 | 9
> 0FF9 | E12 | 1A | EA
> 11 | E1 | 1B | EB
> 12 | E2 | 1C | C
> 13 | 3 | 1D | D
> 14 | 4 | 1E | EE
> 15 | E5 | 1F | Level 1 ED, level 2 E9
> 16 | E6 | | (loading only ED)

When loading, commands E3 and E4 are ignored. When saving, commands 08, 0E
and 10 are ignored.

1.107 WELCOME

To those upgrading from version 4

Welcome to another new version of OctaMED! Firstly: as I’m sure you’ll
know, this version and all subsequent versions will require Kickstart and
Workbench 2.x or higher. This is because OctaMED now heavily depends
on the new features in Release 2 of the operating system, and many parts of
the program have been entirely rewritten to take advantage of them. As 2.04
upgrade packages have been available for more than 1 years, it’s a
reasonable assumption that every truly serious Amiga user has the package
available to them. (Please note that the OctaMED disks contain WB 2.1).
However, OctaMEDPlayer is still compatible with Kickstart 1.3 to allow
your songs to be heard by as wide an audience as possible.

==> So you’ve bought a copy of V5.0, and even perhaps Kickstart 2.04 or
higher specially to use this program, and you’re probably wondering
what has changed.

Well, as soon as you loaded OctaMED, you’ll have noticed a huge change: the
user interface has been completely redesigned. This not only gives the
program a much more "friendly" appearance, but it enables more features to
be added to the program more easily. While in OctaMED V4, gadgets had to be
shrunk to make way for new functions, in future versions a window simply
needs to be enlarged.

Where the V4 features can be found
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Here is a list of which windows the V4 panels’ features have been moved to:

Status bar: Upper screen

Lower status: Free memory : Lower screen
Block name : Block Properties window, Block List win
Song name : Song Options window

Files: Load song : Project menu -> Open
Save song : Save Options window
Del file : Project menu
Load/Save instr: Instr menu
Load/Save msg : MIDI Message Editor
Load/Save map : Input Map Editor

Play: Playing seq : Playing Sequence window
Chan mode, Vol,

Filter, STS : Song Options window
Equalizers

(note: no E1): Settings menu
All others Upper screen

Instr: Type : Type window
Name : Upper screen (use to reload instruments)
All others : Instrument Parameters window

Block: Trks, Lines : Block Properties window
Highlighting : Highlight Options window
Del Buff : Edit menu
All others : Block menu, Track menu

Edit: Prog keys : Programmable Keys window
Track on/off : Upper screen
All others
(no Octaves) : Keyboard Options window

Misc: Clear gadgets : New Project window
Quit : Project menu
Palette : Palette Window
PTKey : Keyboard Options window
Add / Rem Paths: Instr menu
Mouse2 : Mouse Options window
All others
(no Dep2/LdGfx): Settings menu

Vol: Track Volumes window

MIDI: Chan/preset,
supp. noteoff: Instrument Parameters window

Message editor : MIDI Message Editor
Input map ed : Input Map Editor
All others : MIDI menu

Trans: Play transpose : Song Options window
Annotation text: Song menu
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All others : Transpose window

Range: Chord RST : Keyboard Options window
Select tracks : Upper screen
All others

(no Range) : Edit menu

Synth: Synthetic Sound Editor (note: menu attached to window)

SmpEd: Sample Editor (note: menu attached to window)

Note: SAVE IFF has been "moved" to Instr menu -> Save Instrument

SList: Sample List Editor

Notation Ed: Display menu -> Notation Editor (menu attached to window)

New features in V5.0

(1) Maximum sizes increased:

* 64 tracks in a block (you’re also not limited to multiples of 4)

* 1000 blocks in a song

* 999 entries in a playing sequence

* MIDI Preset range (1 - 2800), only works with some devices

* 1048560 bytes in a MIDI message (should be enough for most use!)

(2) New list windows:

* Song Selector displays all songs

* Block List displays all blocks

(3) New save options:

* A new file format (MMD2), saves song sections

* Song compression, using PowerPacker or SFCD compression. SFCD is
a packing format used in Stephan Fuhrmann’s PowerPlayer module
player program, and it usually crunches modules slightly more
tightly than PowerPacker. It requires lh.library for use, which
is distributed with OctaMED under agreement with the copyright
owners. (PowerPlayer can be found on Fish disk 769)

* Song size calculation

* Save Timer emulates "auto-save" option of many wordprocessors

(4) Sample editor options:

* Change volume: fade in/out, halve, double, don’t clip (prevents
distortion)

* Anti-alias when changing pitch can be turned off

* Cancel finetune (removes finetune value from a sample)

* Set volumes of source and destination when mixing

* Set density of pixels in pixel display mode

* Invert: turns the range upside-down

* Chop: deletes the whole sample except the range
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* Remove Unused Space: deletes space (of zero volume) from either
side of the sample

* Create Chord: creates chords of 2 - 4 notes from a sample

* Play Buffer Contents: plays the copy buffer at the current pitch

* Sample Voice Monitor: optionally turns off hearing the input
signal while digitizing (may enhance quality on slower machines)

* Clicking Digitize when Buffsize = 0 automatically creates a
buffer (of 131072 bytes or the largest available if no memory)

(5) New editing functions:

* Generic Slide creates a slide with any type of player command
(use as Volume Slide except with a different player command)

* Flush all unused instruments

* Highlighting: starting offset and custom spacing options

* Insert / delete tracks throughout the song

* Automatically cancels range after an operation. Also, you now
cancel a range by simply clicking the mouse button on the editor

(6) More settings:

* Display max tracks: maximum tracks on-screen at once (4, 8, 16)

* Left, middle and right mouse button can be configured to turn
normal/select tracks on/off, set cursor position, or mark range

* Spacing options: destructive, auto-round (Keyboard Options)

* Play After Loading: automatically starts playing directly after
loading a song, useful for listening to other people’s songs

* Auto-Freeze Screen: automatically turns screen updating off when
the OctaMED screen is not the frontmost

* AGA-compatible palette

* Turn automatic flushing of unused instruments on/off when
clearing the current song of a multi-module

(7) Sample list editor options:

* Instrument Load Window allows easy loading of samples in list

* Stores tuning / MIDI / default volume values and default pitch
as well as loop

* Add directories anywhere in list (not just to end)

(8) Playing sequence:

* Can create multiple playing sequences (sections), and choose the
order in which these sections are played in the Section List

* Now also displays block names

* Clear playing sequence button

* Follow gadget automatically updates the list so that the
current position is as close to the middle as possible

(9) New instrument type: ExtSamples (an extra two lower octaves)

(10) Many new keyboard shortcuts, including some new editing functions

(11) Smaller functions:
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* Arrow gadgets select the previous / next set of tracks to allow
all 64 tracks to be used, in the upper screen, Track Volumes
window and Notation Control window. Shift-clicking the gadgets
select the first / last set of tracks used in the current block

* A Project menu option to display the last title bar message

* Can also change an instrument into a synthetic sound by choosing
Project menu/New Synthsound in the synth editor

* Synthsound programming editing: the cursor no longer moves down
beyond END; and inserting any command except HLT and RES (which
don’t take parameters) also inserts a new 00 value

* Shift-clicking (clicking with Shift held) the waveform arrow
gadgets in the synth editor selects the first / last waveform

* Shift-clicking one of the track gadgets in the upper screen
solos the track (clears all tracks except the one selected)

* Shift-clicking Cont Song continues song from top line of block

* Shift-clicking Space turns spacing on and opens Keyboard Options
(with a view to editing the spacing options)

* A gadget to quickly select the current block for printing

* Can close then reopen the notation editor’s options window using
Display menu -> Notation Control Window

(12) Other new features:

* Fully localizable under Workbench 2.1 (the required 2.1 files
are included with OctaMED), or later. (WB 2.04 users can now use
the Locale program which is in Prefs on Disk 2).

* You can set a default pitch (note) for each instrument, which
will be played and entered at that pitch when the F key is
pressed. Very useful for untuned instruments such as percussion

* Can load more than one instrument at a time: instruments are
loaded into consecutive slots, starting at the current slot

* Clicking the timer reset gadget (R) stores the current song
position, which can be recalled by clicking the timer itself

* The High Quality switch now doesn’t decrease the tempo

* Supports multiple settings and programmable keys files (on
startup, OctaMED attempts to load S:OctaMEDPro.config and
S:OctaMEDPro.defkeys)

* Complete on-line help provided by pressing the Help key

(13) Of course, numerous bug and quirk fixes, including commands 19 and FF3,
commands FFD and FFF in 5 - 8-channel mode, the effect of changing the
block size on line highlighting and block names, intelligent sample
halving (won’t request to halve samples if they are already halved) and
many other small fixes.

One bug of note: the "intelligent" sample loader added way back in
MED 2.10 (July 1990) is finally REALLY intelligent!! :^) (It can
calculate the number of grains of sand on Planet Earth within 3.8
seconds, work out who will be Wimbledon champion in the year 2064,
design the world’s first pear-shaped Cadillac, and even eat a whole
plum without spilling a single drop of juice :’D ). Seriously, it
promises never to request a sample disk more than once while loading
songs saved without their instruments.

In addition, the old octamed.config file can’t be loaded by V5.0. This is
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because the format of the config file has once again changed, but hopefully
for the last time (since the file is now a plain text file). You need to
recreate your old preferences using V5.0, then save the settings using the
Settings menu. Note that the programmable keys definitions
are now saved in a separate file called OctaMEDPro.defkeys .

Features removed in V5.0

You’ll notice that some features from V4 are missing in V5.0:

a) The DEP2 gadget in the MISC panel has been removed. This is because the
OctaMED screen now always has 2 bitplanes (4 colors).

b) The LOADGFX gadget in the MISC panel is missing, as there are now no
extra graphics files to load...

c) There was, unfortunately, no space using the new interface for the E1
set of equalizers.

d) The set of Octaves gadgets in the EDIT panel and the Range dimensions
in the RANGE panel were thought to be no longer necessary, but they may
return in a future version.

e) The color palette is no longer loaded or saved with songs. Loading in
particular would have certainly caused problems with songs created with
earlier versions of OctaMED: imagine what the new interface would look
like with the old black - white - dark gray - light gray palette!

f) The old status bar action of clicking a digit with either mouse button
to increase / decrease the digit no longer exists (it is a "non-
standard" function, and clicking with the right mouse button would
interfere with the new menu system).

For those who have become used to this operation, here are some
relevant keyboard shortcuts:

Decrease / increase playseq position: Ctrl - 8 / 2 (numeric keypad)
Decrease / increase block number: Shift - <up> / <down>
Decrease / increase instrument number: Shift - <left> / <right>
Decrease / increase song number: Ctrl - ( / ) (numeric keypad)

g) The Left Alt programmable keys definition has unfortunately had to be
removed, since Left Alt is now the gadget shortcut qualifier.

h) The instrument default volume’s hex display has been (temporarily?)
removed.

Keyboard shortcuts

Almost all shortcuts involving Right Amiga have been either removed or
changed from version 4, since Right Amiga is now used as a menu shortcut
qualifier only. (The only exceptions are Amiga-X/C/V, which remain as
in V4: cut/copy/paste track). The changes are:
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Amiga-L (Load Song) Now Amiga-O
Amiga-P (Play Song) Now Left Alt-P (with main screen active)
Amiga-T (Slide type 1) Now Ctrl-T
Shift-Amiga-T (Slide type 2) Now Shift-Ctrl-T
Amiga-O (Volume slide) Now Ctrl-O

Shift-Amiga-X/C/V has been changed to Shift-Alt-X/C/V for compatibility
with the new interface (holding Shift and choosing Cut, Copy or Paste from
the Track menu would have affected the block instead!). Aside from X/C/V,
all other Amiga shortcuts have been removed.

Ctrl-F1-F10 and Alt-keypad shortcuts have also been removed.

A final word

So although there are many new features, you should become used to the new
interface fairly quickly. May I suggest that you work through the tutorials
as if you were new to the program, and skim past any pieces of basic
information that you’re already familiar with. In this way, you’ll probably
get to know the new interface in the minimum of time.

Remember that any menu item with the suffix ... opens a window, and also
that there is a menu bar attached to the Sample, SynthSound and Sample List
Editors, and the Notation Control window! Finally note that the right mouse
button can no longer be used to select a range in the Tracker, Sample and
SynthSound editors: the left mouse button now usually does this.

We hope you V5 useful, if you like it, then seriously consider obtaining
the new OctaMED SoundStudio, it really is well worth buying!
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